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2  Chapter 1 – Welcome

Welcome to the Spire CXP50 Color Server 
User Guide

Welcome to your Spire CXP50 Color Server 1.0 for Xerox DocuColor 5000 
Digital Press User Guide. 

The powerful and comprehensive Spire CXP50 color server provides high 
throughput and print predictability for digital workflows. In combination 
with the Xerox DocuColor 5000 digital press, the Spire CXP50 color server 
effectively addresses the growth of on-demand printing needs and delivers 
the best output quality available. To enhance the benefits of your Spire 
CXP50 color server, you can add the Spire CXP50 color server Professional 
Kit, which is activated by a dongle.

This user guide will help you operate the Spire CXP50 color server. It can 
also be used as a reference guide for questions or procedures. Study this 
user guide to take full advantage of the many unique and advanced features 
of the Spire CXP50 color server.

This user guide is for Spire CXP50 color server operators and system 
administrators. This guide explains how you can quickly and easily print 
from the Spire CXP50 color server or from a client workstation. Step-by-
step procedures are included for new and occasional Spire CXP50 color 
server users. Detailed information is provided for users who require in-
depth knowledge of the Spire CXP50 color server. 

Overview of Spire CXP50 Color Server
The Spire CXP50 color server is an on-demand prepress system that uses 
Creo Spire advanced prepress technologies, to drive a Xerox DocuColor 
5000 digital press. 

As an optimal digital color solution for printers, the Spire CXP50 color 
server enables you to print from Windows, Macintosh, and UNIX client 
workstations. The Spire CXP50 color server processes image files in page-
description language (PDL) formats—for example, PostScript, PDF, and 
Variable Information—using RIP (Raster Image Processor) technology. 
The system converts image files into a suitable RTP (Ready-To-Print) 
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format for direct, high-quality digital printing. The Spire CXP50 color 
server also streamlines the printing process by allowing printing with 
preset workflows.

In combination with the Xerox DocuColor 5000 digital press, the Spire 
CXP50 color server enables you to efficiently print flyers, brochures, 
pamphlets, dummy catalogs, short-run trials, and print-on-demand 
publications. When installed as a fast, network printer with the Spire 
CXP50 color server, the Xerox DocuColor 5000 digital press prints up to 50 
full-color A4 (210mm x 297mm) or Letter (8.5 inches x 11inches) pages 
per minute.

The Spire CXP50 color server combines RIP functionalities, automation, 
control tools and special hardware development capabilities with PC 
architecture.

Figure 1: Spire CXP50 Color Server for Xerox DocuColor 5000 Digital Press

WARNING:  A shielded ethernet cable must be used from the Token Ring board 
to the Token Ring Hub to maintain compliance with Council Directive 89/336/
EEC.
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Hardware and Software Components
The Spire CXP50 color server is a dedicated Creo platform running in a 
Windows XP environment. 

The Spire CXP50 color server includes:

• Creo hardware, including the interface board

• Software, including:

Creo software

Windows XP Professional Operating System

Adobe Acrobat version 6.0

Supported Formats
The Spire CXP50 color server supports the following file formats:

• PostScript (composite or pre-separated files)

• PDF

• EPS

• Creo VPS (Variable Print Specification)

• VIPP (Variable Data Intelligent PostScript Params)

• PPML (Personalized Print Markup Language)

• GAP (Graphic Art Port) files (file formats from various prepress 
systems, for example Brisque job and TIFF / IT)

• Creo CT & LW

• JPG, TIFF

• Pre-separated formats
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Workflow
The Spire CXP50 color server receives and processes files from the 
following client workstations: 

• Macintosh – running Mac OS 9.x or later and Mac OS X (10.1 and 
later)

• Windows – running Windows ME, 2000, and XP

• UNIX Workstations and Servers

The Spire CXP50 color server basic workflow is as follows:
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Turning On the Spire CXP50 Color Server
1. Turn on the monitor.

2. Press the power button on the front panel of the Spire CXP50 color 
server.

The power indicator on the front panel lights up. The Windows 
operating system starts, and the Spire CXP50 color server splash screen 
appears.

 

Notes:

• If the Spire CXP50 color server workspace is already turned on, 
open the workspace from the Start menu.

• By default, the Auto Log On check box is selected in the Settings 
window. This option enables you to open the workspace without 
having to go through the logon process each time. If you want to 
designate different access levels for each user, you need to set 
security settings in the Settings window. For more information 
about designating access levels, see “Security” on page 181. 
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The Workspace
After you turn on the Spire CXP50 color server, the workspace 
automatically appears.

Table 1 describes the Spire CXP50 color server workspace.

1

2

3

4

5

6

7

8

Table 1: Spire CXP50 Color Server workspace

Item Name Description

1 Menu Bar Consists of the Job, Selection, Tools, Control, View, and Help menus. 
Click a menu name to open the corresponding menu.

2 Status Panel Contains the logo Pane, Processing status area, Printing status area, 
server icon, and printer icon.

For more information on the server and printer icons, see “The Server 
and Printer Monitors” on page 11.

3 Toolbar Consists of shortcut buttons for the Import window, Resource Center, 
Message Viewer, and Calibration window.
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Customizing the Workspace View

The View menu enables you to customize the workspace. From this menu, 
you can open and close the workspace windows. The menu also provides 
the following view options:

• Spire Classic View: Displays the status panel, toolbar, Storage window, 
Queues window, Thumbnail window, and Job Alert window

4 Queues Consists of the Process Queue, which lists the files to be processed. After 
a file has been processed successfully, it moves either to the Print Queue 
(the upper area) or to the Storage window.

For more information on queues, see “The Job Queues” on page 13.

5 Job Alert Displays the last detailed error that is related to a selected job.

For more information on the Job Alert window, see “The Job Alert 
Window” on page 201.

6 Thumbnail Displays a thumbnail view of a specific page in an RTP job that has 
finished processing.

7 Storage The Storage window contains files that:

• were successfully printed

• were held, were aborted, or failed during processing or printing

• were sent directly from the client workstation to the Storage window 
or were imported to the Storage window.

8 Paper Stocks Displays information about the paper in each tray and also shows 
whether the trays are ready for printing.

NOTE: This window is only included in Classic Plus view. For more 
information, see “Customizing the Workspace View” on page 10.

Table 1: Spire CXP50 Color Server workspace

Item Name Description
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• Spire Classic Plus View: Displays the status panel, toolbar, Paper Stocks 
window, Storage window, Queues window, Thumbnail window, and 
Job Alert window

• Queues View: Displays only the Print Queue and Process Queue

• Refresh View: Reverts to the factory default view for the view that is 
currently displayed

The Server and Printer Monitors
The server and printer icons are on the right end of the status panel and 
indicate (through animation) whether processing and printing are taking 
place. If a finishing device is connected to the printer, the finishing device 
also appears in the printer icon. You can click the printer or server icon to 
display status information. You also view messages regarding the printer 
operation mode and status next to the printer icon. 

Tip:  By default, the windows in the workspace are all docked—that is, attached 
to the workspace. You can detach, or undock, a window from the workspace by 
right-clicking the window’s title bar and selecting Undock Window.

Message indicator

Server icon Printer icon
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The DFE Monitor 
Click the server icon to open the DFE Monitor window. 

The DFE Monitor window displays the following information:

The Printer Monitor
Click the printer icon to open the Printer Monitor window.

The Printer Monitor window displays the following information:

Table 2: Description of DFE Monitor window

This tab Shows you

Disk Usage How much space is available on the user disk and 
printer disk

Network Information about the network

Virtual Printers Lists the virtual printers that you have defined

Table 3: Description of Printer Monitor window

This tab Shows you

Paper Stock Information about the paper in each tray and also 
shows whether the trays are ready for printing

Finisher Information about finishing devices that are connected 
to the Xerox DocuColor 5000 digital press

Toner Whether there is enough toner

Consumables Status of other refillables
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The Job Queues
After entering the Spire CXP50 color server, a job resides either in the 
Queues window or in the Storage window, depending on the job flow. 

The Queues window consists of two areas, the Process Queue and Print 
Queue.

• The Process Queue lists the job that is currently being processed and 
the jobs that are waiting to be processed. 

• The Print Queue lists the currently printing job and the jobs that were 
processed successfully and are waiting to be printed. The Print Queue 
also lists frozen jobs (jobs for which the specified option is not 
available—for example, paper stock or finisher).

Each queue holds jobs in the order in which they enter it (unless a rush job 
“interrupts” the submission order). 

At any time, you can view information regarding the number and status of 
the jobs in the queues. You can also change the order of the jobs and 
suspend or resume the queue.

After you start the Spire CXP50 color server, the Queues window is 
displayed. 

For more information about managing jobs, see “Managing Job Queues” on 
page 32.
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Each queue holds jobs in the order in which they enter it. The top job in the 
queue is currently running, while all others are waiting to run. 

If necessary, you can change the order of the jobs that are waiting in the 
queues. You can also view and edit job parameters.

The Queues Window
The process queue lists the files to be processed. 

Once a file has been processed successfully, it moves to the print queue to 
be printed, or to the Storage window (depending on the current job flow 
or virtual printer).

Note:  If there are very short jobs in the print queue, several jobs may be running 
at the same time. The jobs marked as running are listed first and printed in the 
order they are listed.

For more information about operations on the jobs residing in the Queue 
Manager, see “Aborting a Running Job” on page 34.
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The Queues window lists information about the jobs that are being 
processed. Status indicators indicate the status of each job. Table 4 
describes the status indicators used in both the process queue and print 
queue.

Table 4: Process Queue and Print Queue status indicators

This 
Status 
Indicator

Indicates This:

The job is running.

The job is frozen and held in the print queue. If a job is 
frozen, it indicates that the specified option is not 
available—for example, paper stock or finisher

The job is waiting.

The job is a rush job.

The rush job is frozen.

The rush job is waiting.

For more information about rush jobs, see “Running a Rush Job” on page 37.
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Right-click the column heading row to select the columns that you want to 
view. 

Table 5: Process Queue and Print Queue column descriptions

This Column Indicates This Information:

Status The status of each job.

Job Type File format of the PDL job—for example, PS (.ps), 
PDF(.pdf), VPS(.vps)

Title Name of the file to be printed. If you submit a file 
whose name already exists in the Spire CXP50 color 
server, a number is automatically added to the file 
name—for example, if you submit a file called 
lobster and this file name already exists, the newer 
file is renamed lobster1.

Sender User name of the system from which this file 
originated

Submitted Date and time this job was first submitted to the 
Spire CXP50 color server

Pages Number of pages to be processed in a PDF job. For 
other PDL jobs, the number of pages is indicated 
only if the DTP software in which they were created 
supports this feature.

Sets Number of copies to be printed

Paper Set/
Stock Name

Paper set name or stock name

Paper Size Paper size

Weight Paper weight

Type Paper type

Coating Paper coating

File Size File size of the job

Account Account name taken from the Job Info parameter
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Status Information

The Queues window status areas contain the following:

• The suspend and resume buttons (for more information see 
“Suspending and Resuming Queues” on page 33)

• The queue name.

• The number of jobs in the queue—for example, 2.

If a job is currently being processed or printed, the name of the job and a 
process indicator are displayed in the Processing status area.

 

Job Info Job information taken from the Job Info parameter

Imposition Type of imposition used

Page 
Exception

Whether or not the job has page exceptions

Server Name of the server being used

Virtual Printer 
Names

Name of virtual printer being used

Table 5: Process Queue and Print Queue column descriptions

This Column Indicates This Information:

Note: For PDF jobs, the Processing status area indicates the total number of 
pages. For other PDL jobs, the number of pages is indicated only if the DTP 
software in which they were created supports this feature.
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The Storage Window
The Storage window is displayed by default. If you close the Storage 
window, you can reopen it by selecting Storage from the View menu.

The Storage window is the main repository for jobs. It can contain:

• Printed (completed) jobs

• Jobs that you manually moved to the Storage window or that you 
aborted during processing or printing

• Jobs that failed during processing or printing

• Retrieved jobs

• Jobs that were imported directly to the Storage window from the client 
workstation (by selecting the Spool & Store option for the job flow)

In the Storage window, you can see the number of jobs that are in storage 
and their status.

Each job in the Storage window is assigned a status as shown in Table 6:

Table 6: Storage window status buttons

Icon Status Indicates This

Completed The job has finished printing.

Held You moved the job from the Queues window 
to the Storage window; or the current job 
flow or virtual printer moved the job to the 
Storage window automatically.

Failed The job failed during processing or printing.

Aborted You aborted the job in the Queues window 
while the job was running.
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By default, the Storage window shows all the jobs, whatever their status. All 
the status buttons are selected—that is, they appear pushed in. If you click 
a status button now—for example, the Completed Jobs button—the 
button is released and the list hides all the completed jobs:

If you click the Completed Jobs button again, the button is pushed in and 
the list shows the completed jobs.

In the Storage window you can perform the following actions:

• Submit a job. See “Importing and Printing a Job” on page 28.

• Run a rush job before other jobs. See “Running a Rush Job” on 
page 37.

• Archive a job. See “Archiving and Retrieving a Job” on page 39.

• Export a job as a PDF file. See “Export as PDF2Go” on page 91.

• Export an RTP job as an InSite job. See “Export as Creo Synapse InSite 
Job” on page 111.

Note:  When all the status buttons are in the released position (not selected), the 
Storage window shows no jobs.

Note:  This feature is available only for the Spire CXP50 color server with the 
Professional Kit.
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• View and edit the parameters of a job. See “Viewing and Editing Job 
Parameters” on page 36.

• Preview and edit a job, using PitStop Edit for unprocessed jobs, or the 
Job Preview & Editor window for processed jobs. See “Editing a Job” 
on page 43.

• View a job’s history in the Job History window. See “Viewing a Job’s 
History” on page 42.

• View the job ticket report for a job. See “Job Ticket Report” on page 42.

• View the preflight report for a job. See “Preflight Report” on page 107.

• Delete a job. See “Deleting a Job” on page 37.

• Revert processed jobs to their original format.

• Duplicate a job. See “Duplicating a Job” on page 38.

• Use the PDF analyzer to detect problems in imported PDF files that 
may affect processing. See “Analyzing a PDF Job” on page 103.

Note:  Editing unprocessed jobs using PitStop Edit is available only for the 
Spire CXP50 color server with the Professional Kit.

Note:  You can only view a preflight report for a job if you enable the 
Preflight parameter before processing the job. For more information, see 
“Preflight Check” on page 105. 
This feature is available only for the Spire CXP50 color server with the 
Professional Kit.

Note:  This feature is available only for the Spire CXP50 color server with the 
Professional Kit.
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The Settings Window

You can set all system preferences in the Settings window.  

To open the Settings window:

From the Tools menu, select Settings. 

The window is divided into two areas: 

• Administration: Contains system administration settings.

• Preferences: Contains system preferences.  

Note:  If you log on to the Spire CXP50 color server as a guest, the Settings 
window is unavailable.

Note:  All users can view the Administration and Preferences settings, but 
only an administrator can configure these settings.

For more information about setting system preferences, see “Setting Up and 
Configuring the Spire CXP50 Color Server” on page 170.
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The Resource Center

The Resource Center enables you to add, remove, and manage external 
resources for the Spire CXP50 color server.

To open the Resource Center:

From the toolbar, click Resource Center .

The Resource Center provides access to the following resources:

• Virtual Printers, see “Managing Virtual Printers” on page 53

• Fonts, see “Managing Fonts” on page 97

• Imposition Templates, see “Imposition Templates” on page 82 

• Cached VI Elements, see “Managing VI Elements” on page 164 

• Paper Sets, see “Managing Paper Sets” on page 57 

• Profile Manager, see “Profile Manager” on page 137
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The Job Parameters Window
The Spire CXP50 color server enables you to edit PDL files and change the 
job settings—for example, paper size, imposition, and color settings—in 
the Job Parameters window.

To open the Job Parameters window:

Double-click a job in the Storage or Queues window.

The Job Parameters window title bar displays the following information:

• The name of the job

• The name of the virtual printer

• The time of submission
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Each tab has a set of related parameters and values that you can select.

Table 7: Description of tabs in the Jobs Parameters window

This tab Enables you to

Print Settings Set print related job parameters—for example, 
Print range and Print method. See “The Print 
Settings Tab” on page 214.

Paper Stock Set job parameters related to paper stock—for 
example, Paper size and Paper set name. See “The 
Paper Stock Tab” on page 219.

Print Quality Set job parameters related to print quality—for 
example, Trapping and Image quality—and 
improve the quality of printed jobs. See “The 
Print Quality Tab” on page 221.

Color Apply last minute color corrections, or set the 
output job to align with other output devices. See 
“The Color Tab” on page 225.

Imposition Set job parameters related to positioning, folding, 
trimming, and binding of pages—for example, 
Margins and Template. See “The Imposition Tab” 
on page 231. 

Services Set job parameters that will assist your job 
workflow—for example, APR path and Preflight. 
See “The Services Tab” on page 238.

Finishing Select from various options to finalize your 
printed document—for example, define settings 
for the front and back cover. See “The Finishing 
Tab” on page 245.

Exceptions Define paper sets to include exceptions in a job, 
and add inserts or interleaves. See “The 
Exceptions Tab” on page 249.
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The Help Menu
The Help menu provides information about the version of software that is 
installed on your Spire CXP50 color server and enables you to access the 
online help, which is based on this user guide.

To open the About window:

From the Help menu, select About.

The About window displays the following information:

• Spire CXP50 color server software version number

• Date the version was installed

• Any updates that were installed on top of the version 

To open the online help:

From the Help menu, select Topics.
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Turning Off the Spire CXP50 Color Server
1. In the Spire CXP50 color server workspace, from the Job menu, select 

Exit.

The following message appears:

2. Click Yes.

The Spire CXP50 color server workspace closes, and you return to the 
Windows desktop.

3. Verify that the Spire icon has disappeared from your taskbar.

4. From the Windows desktop, select Start > Shut Down > Shut down > 
OK. 

When the Windows shut down is complete, the Spire CXP50 color 
server shuts down.

Note:  If there are jobs that are being processed or printed, a different 
message is displayed. Running jobs are aborted.

Taskbar without Spire iconTaskbar with Spire icon
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Importing and Printing a Job
The basic workflow for printing a job in the Spire CXP50 color server 
consists of three main stages:

1. Importing the job.

2. Processing the file.

3. Printing the job.

After the job is printed, it is stored in the Storage window and can be 
resubmitted for printing, see “Reprinting a Job” on page 31.

Importing a Job
Use the importing feature to submit jobs in the following situations:

• When a page-description language (PDL) file is created on a client 
workstation that is not connected to the Spire CXP50 color server

• When a PDL file is located on an external medium, such as a CD-ROM

• When the desired file resides locally on the Spire CXP50 color server

To import a job to the Spire CXP50 color server:

1. From the Job menu select Import Job. 

The Import window appears. 
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2. To access the desired files, click the up one level button , or 
double-click on the file folders to go down the file tree.

3. In the upper list in the Import window, select the desired file(s) and 

click the add button .

The file(s) appears in the lower list.

4. Select a printer from the Virtual Printer list. 

Note:  Use SHIFT or CTRL to select several files or CTRL+A to select all the files. 

Note:  To remove a file, select the desired file in the lower list in the Import 

Job window and click the remove button .
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5. Click Import.

All files currently listed on the lower list are sent to the Spire CXP50 
color server to be processed and printed as defined in the selected 
virtual printer.

To check the status of imported jobs:

1. Click the server icon arrow.

The Importing/Retrieving window appears.

The Importing/Retrieving window indicates the name of the file being 
imported, its location and the job size. It also indicates the percentage 
of the job already transferred, both numerically and graphically.

2. Select one of the following options:

• Click Skip This Job to stop importing the current file and import 
the next job in the import queue.

• Click Abort All Jobs to stop importing all the files.

• Click Close to close the Importing/Retrieving window.



Reprinting a Job 31

Processing 
After a job enters the Spire CXP50 color server, it goes into the process 
queue or the Storage window, depending on the job flow. Once the job is 
in the process queue, the job begins processing.

Printing a Job
Once your job has been successfully processed, it becomes ready to print 
(RTP). Depending on the designated job flow, the job either moves to the 
print queue or to the Storage window. 

If your job is moved to the Storage window, submit the job for 
printing.

The job is moved to the print queue.

The print queue lists the job that is currently printing, and all the jobs that 
were processed successfully and are waiting to be printed. 

Once the job is printed it moves to the Storage window.

Reprinting a Job

Submitting an RTP Job Requiring no Changes
Select the job in the Storage window and from the Job menu select 
Submit.

The job(s) are placed in the print queue.

For more information on the Queues window, see “Managing Job Queues” on 
page 32.

For more information, see “Managing the Storage Window” on page 38.

For more information on the Queues window, see “Managing Job Queues” on 
page 32.

Note:  Use SHIFT or CTRL to select several jobs.
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Submitting a Job that Requires Re-RIPing
1. Double-click the job to open the Job Parameters window. 

2. Change the desired parameter and click Submit.

The Spire CXP50 color server automatically determines if your job 
needs to be re-RIPed and places it in the appropriate queue.

Managing Job Queues

Batching Jobs
The job-batching workflow combines jobs with similar attributes into a 
single batch to enable the printer to print the jobs continuously without 
pausing. This feature saves printing time, especially for a large number of 
small jobs. Jobs that use paper of the same size and weight are suitable for 
batching. 

When a job enters the print queue, the Spire CXP50 color server checks 
whether the job is suitable for batching with the previous one: 

• A job that can be batched appears with the running  status 
indicator. The printer prints both jobs without pausing between them. 

• A job that cannot be batched with the previous one waits in the queue 

and appears with the waiting  status indicator. It is printed only 
when the printer finishes the previous job. 

The following types of jobs cannot be combined into one batch:

• Collated jobs and uncollated jobs

• Jobs that use different output trays

• Jobs with different staple positions

Note:  The Spire CXP50 color server batches suitable jobs only if they are 
consecutive in the queue. Two jobs are not batched if a job that is not suitable 
comes between them in the queue.

Note:  The job batching option is active by default.
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To deactivate job batching:

In the Settings window, select Preferences > Print Queue Manager > 
Disable Job Batching. 

Changing the Order of Jobs in the Queues 
You can rearrange the jobs in a queue to change the order in which they 
will be processed or printed. For example, this feature is useful when you 
have an urgent job that takes priority.

To move a job up in the queue:

Right-click the job and select one of the following options:

Promote: to move the job up one step

Promote to top: to move the job to the top of the queue

To move a job down in the queue:

Right-click the job and select one of the following options:

Demote: to move the job down one step

Demote to bottom: to move the job to the bottom of the queue.

Suspending and Resuming Queues
If necessary, you can stop a queue temporarily and then later continue its 
operation afterwards. To do this, use the suspend and resume buttons.

For more information about job batching, see “Print Queue Manager” on 
page 192.

Note:  You can only move one job at a time.

Note:  The job is placed below the Running job.
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To suspend a queue:

Click the suspend button .

The button turns red (suspend mode), and the processing/printing 
stops after the current job has finished running.

To resume a queue:

Click the resume button .

The button turns green (resume mode), and the top job in the queue 
starts processing/printing.

Aborting a Running Job

To stop processing or printing a running job:

Right-click the running job in the Queues window, and from the 
menu, select Abort.

The job moves from the queue to the Storage window, and the Job 
Alert window is updated.

The Aborted status  is assigned to the job, and the next job in the 
queue starts running.
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To return a job to the process or print queue:

Right-click the job in the Storage window and select Submit.

Moving a Job to the Storage Window
To the postpone processing or printing of one or more jobs, use the Move 
to storage option.

To move a job to storage:

1. Select the job in the Queues window.

Note:  To return a job to the proper queue, right-click the job(s) in the Storage 
window and select Submit.

Note:  If the job is running, this option is not available.
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2. Right-click the job, and select Move to storage.

The job moves from the queue to the Storage window, and appears 
with the held job indicator . 

To return a held job from the Storage window to its original queue:

Right-click the job, and from menu select Submit.

The job moves from the Storage window to the queue.

Viewing and Editing Job Parameters 

In the Queues or Storage window, double-click the job whose 
parameters you want to view.

The Job Parameters window appears. 

Notes:

• In the Queues window, you can edit the parameters of jobs that have 
not begun to run. If you want to edit the parameters of a running job, 
you must first suspend the queue (click the suspend button).

• If you edit the parameters in of a job in the print queue and the 
changes require re-RIPing of the job, it automatically moves to the 
process queue.

For more information on the Job Parameters window, see “Setting Parameters in 
the Job Parameters Window” on page 214.
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Running a Rush Job
When you have an urgent job, you can run it before other jobs. If you 
submit a job for processing while another job is being processed, the latter 
job pauses temporarily but retains its running status. When the rush job 
finishes processing and moved to the print queue, the processing of the 
paused job continues.

If you submit a rush job for printing while another job is being printed, the 
latter job pauses temporarily after the current page (both sides) or set is 
printed but retains its running status. When the rush job finishes printing, 
the printing of the paused job continues.

To submit a rush job:

In the Queues or Storage window, right-click the job, and select Run 
Immediately.

The job appears with the rush status indicator  at the top of the 
appropriate queue and runs immediately.

Deleting a Job
Deleting a job from the process queue, print queue, or Storage window, 
permanently removes the job from the Spire CXP50 color server. 
Thereafter, to print the job, you must resubmit it to the Spire CXP50 color 
server for processing. To temporarily remove a job from a queue, use the 
Move to storage option (see “Moving a Job to the Storage Window” on 
page 35).

Note:  Only one job can be processed or printed at a time. Therefore, if you select 
several jobs (one after the other) as rush jobs, they will be processed/printed in 
the order of their selection.

Note:  You can only perform this action if the job is waiting in the queue. If the 
job is active, this option is not available.
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To delete a job:

1. Right-click the desired job in the queue or Storage window, and select 
Delete.

The following message appears.

2. Click Yes.

The selected job(s) is deleted.

Managing the Storage Window

Submitting a Job

To submit a job in the Storage window:

In the Storage window, right-click the job, and select Submit.

RTP jobs are submitted to the print queue; all other jobs are submitted 
to the process queue.

Duplicating a Job

To duplicate a job:

1. In the Storage window, right-click the job and select Duplicate. 

A warning message appears.

Note:  You can only perform this action if the job is waiting in the queue. If the 
job is running, this option is not available.

Note:  You can delete more than one job at a time: select the jobs, and from 
the Job menu, select Delete.
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2. Click Yes to continue. 

The selected file is duplicated and is given the name of the original job 
followed by the suffix _dup. 

Discarding RTP Information
The RTP information can be discarded if desired. Under some 
circumstances, it is necessary to discard RTP data—for example, when you 
want to re-RIP a file, archive a job without the RTP information, or edit 
tabs.

To discard RTP information from a job:

In the Storage window, right-click the relevant job and select Revert to 
source.

The RTP data is discarded and the file returns to its original format—
for example, PostScript.

Archiving and Retrieving a Job
To keep enough disk space free, we recommend that you back up jobs and 
their related files to an external server and then delete them from the 
Storage window.

This backup process is called archiving. You can retrieve archived jobs and 
related files later for further use.

You can set a default archiving path that will automatically be displayed in 
the Open dialog box when you select Archive from the Job menu. Set this 
path in the Settings window under Preferences > General Defaults.

If a job includes VI elements, you need to archive or retrieve the VI 
elements before archiving or retrieving the job. For more information on 
archiving or retrieving VI elements, see “Managing VI Elements” on 
page 164.

Note:  Duplicating an RTP job creates a PDL version of the job.

For more information on editing tabs, refer to the Tabs Printing guides.
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To archive a job on an external server:

1. In the Storage window, right-click the job you want to archive and 
select Archive.

The Open dialog box appears.

2. Locate the desired folder, and then click Archive.

A cabinet file (a compressed file) that contains all the files related to the 
archived job is created at the selected location. 

3. In the Job Alert window, verify that archiving has been completed.

4. Delete the job from the Storage window.

To retrieve an archived job:

1. From the Job menu, select Retrieve from Archive.

The Open dialog box appears.

Notes:

• The archived job retains its current status (that is, completed, failed, 
held, or aborted) and is archived with the information in its Job 
Parameters and Job History windows. 

• When retrieved, the archived job retains the original job name, not the 
name assigned when archived.
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2. Locate the archived job under its archive name, select the related 
cabinet file, and click Open. 

The selected job appears at the top of the list in the Storage window. It 
is assigned the status indicator (completed, held, failed, or aborted) 
that is had before archival. 

3. In the Job Alert window, verify that the file has been successfully 
retrieved.

Notes:

• You can retrieve more than one job at a time.

• The files related to the job (for example, PDL) are also retrieved.

• The job is retrieved with the information in its Job Parameters and Job 
History windows.

• The cabinet file is not deleted.
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Viewing a Job’s History
In the Queues or Storage window, right-click the job and select Job 
History.

The Job History window appears.

Job Ticket Report
The Job Ticket report contains all information from the Job Parameters 
window (including Job Parameters window title bar data). The Job Ticket 
report presents the job parameters on a single sheet and may be exported 
or printed as a hard copy.

This feature is useful for:

• Making the job information available in case of customer query.

• Saving the job parameters for future use.

• Providing the client or customer a tool for following up printed jobs.

To display the job ticket report:

1. Right-click a job in the Storage window, and from the menu select Job 
Ticket Report.

The Job Ticket Report window appears.

For more information about the Job History window, see “Job History” on 
page 202.
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2. You can export or print the report by clicking Print or Export.

The Job Ticket Report is exported as a text file.

Editing a Job
You can preview and edit jobs in two ways in the Spire CXP50 color server:

• Before processing, use the Enfocus PitStop Edit software for Adobe 
Acrobat software. See “Editing an Unprocessed Job” on page 44.

• After processing, use the Spire CXP50 color server Job Editor. See 
“Editing a Processed Job” on page 44.
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Editing an Unprocessed Job

The PitStop Edit software enables you to:

• View and change an object’s properties—for example, color properties

• Create action lists, which you can use to automate repetitive tasks

To edit your job using PitStop Edit:

1. In the Storage window, right-click the job and select Job 
Preview&Editor.

Your file opens in Adobe Acrobat.

2. Use the PitStop Edit software to edit your job as desired.

Editing a Processed Job
The Job Preview & Editor window enables you to preview and edit RTP 
jobs before printing them. You can use the Job Preview & Editor window 
to insert, move, or delete pages. While you navigate to the various pages of 
a job, you can view thumbnails of the job. For an imposed job, you can 
view the imposed sheets, including the layout of the pages on each sheet. 
You can also view the pages’ orientation, crop marks, and fold marks.

To open the job editor:

In the Storage window, right-click an RTP job that you want to 
preview, and select Job Preview&Editor.

The Job Preview & Editor window appears, displaying the first page of 
the selected job. 

Note:  This feature is available only for the Spire CXP50 color server with the 
Professional Kit.

Note:  The job must be a PDF or PostScript file. For information on editing 
processed jobs, see “Editing a Processed Job”, below.

Tip:  To familiarize yourself with the PitStop Edit software functions, refer to the 
PitStop Edit documentation (C:\Program Files\Adobe\Acrobat\plug-
ins\Enfocus\Documentation\PitStop Manual.pdf).
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Navigating in the Job Editor

The navigation buttons enable you to select a specific booklet or page to 
view, and to browse through the pages of the current job.  

Previewing a Job
The preview buttons enable you to switch the display mode of the page.

Table 8: Preview Buttons

Note:  When the first page of a booklet is in view, the previous page navigation 
button takes you to the previous booklet. When the last page of a booklet is in 

view, the next page button  takes you to the next booklet.

This button Enables you to:

Pan

View a different area of the image

Eye Dropper

Find out the CMYK values of a specific area 
on the page. To find the values, first click the 
Eye dropper button. Then move the pointer 
to the point on the page where you want to 
measure the color values, and click. The 
CMYK values appear briefly near the pointer.

Zoom In

Increase the magnification of the selected area 
by 100%

Zoom Out

Reduce the magnification of the selected area 
by 50%

One to One Zoom

View the page at a resolution of one screen 
pixel to one image pixel

Fit to Screen

Scale the page to fit the available screen space
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Viewing a Page in the Job Editor
The Job Preview & Editor window has three tabs—Booklets, Thumbnails, 
and Imposed Sheets—which enable you to switch views.

Using the Booklets Tab

The Booklets tab displays the booklets included in the selected job and the 
names and numbers of the pages in each booklet. The Booklets tab opens 
by default when you are previewing an RTP job that has not been imposed.

To view a page on the booklets tab: 

In the left pane of the Booklets tab, double-click the name of the page 
that you want to view.

The page is displayed in the right pane.

View the image at different preset levels of 
magnification by selecting a percentage in the 
list

Rotate View

Rotate the page by 90°, 180°, and 270°

Show/Hide 
Separation

Select the separations that you want the 
gradation graph to show

This button Enables you to:
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Using the Thumbnails Tab 

The Thumbnails tab displays miniature views (“thumbnails”) of each page 
in the selected booklet. These thumbnails enable you to find a specific page 
easily.

To view a page on the Thumbnails tab:

1. Click the Thumbnails tab.

Miniature versions of the pages appear on the left side of the tab, in the 
thumbnail pane.

2. Use the scroll bar to move from one page to the next.
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3. To view the thumbnails side by side, resize the thumbnail pane by 
dragging the bar that divides the panes to the right.

4. Double-click the thumbnail of the page that you want to view. 

The page is displayed in the right pane.

Using the Imposed Sheets Tab

The Imposed Sheets tab is available only for imposed RTP jobs. This tab 
enables you to view the imposed sheets and check your imposition 
parameters. You cannot edit a job on this tab.

To display a page of an imposed job:

1. Click the Thumbnails or Booklets tab.

2. Select the desired thumbnail or page.

3. Click the Imposed Sheets tab.

The selected page of the imposed job appears.

Notes:

• In VI jobs, the booklet number appears instead of the sheet number—for 
example, Booklet 1, Page 15.

• In duplex jobs, each sheet is displayed twice, once for side A and once for 
side B—for example, Sheet 1, Side A.
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4. To edit the job, click the Booklets or Thumbnails tab. 

Editing an RTP Job
You can edit an RTP job in the following ways:

• Move pages within the job 

• Delete pages from the job 

• Insert pages from another job

To move a page in a job:

1. Click the Thumbnails tab.

2. In the thumbnail pane, click the page that you want to move.

Note:  If you edit an imposed RTP job and then return to the Imposed Sheets 
tab, the view is updated according to the applied changes.

Note:  Jobs that you edit in the Job Editor cannot be re-RIPed. Once you save a 
job in the Job Editor, it becomes a new RTP file without an associated PDL file. 
You cannot apply parameters that require re-RIPing to such jobs.
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3. Drag the page to the target location.

The page moves to the selected location, and the page numbers are 
updated accordingly.

4. Click Save As to save the changes in the job.

To delete a page from a job:

1. Select the page that you want to delete, and click Delete.

The page is deleted, and the page numbers are updated accordingly.

2. Click Save As to save the changes in the job.

Inserting Pages Into a Job

You can copy pages from one job and insert them into another.

To insert one page into a job:

1. Click Select Job.

The RTP Jobs window appears.

Note:  The red line indicates where the page will be inserted.
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2. Select the job with the page that you want to copy, and click OK. 

On the Thumbnails tab, the left pane splits into two. The thumbnails of 
the second job appear below those of the job you are editing.

3. In the lower set of thumbnails, locate the page that you want to copy.

Note:  The Spire CXP50 color server displays only those RTP jobs that have 
the same page size and orientation as the job that you are editing.
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4. Drag the page to the upper set of thumbnails, to the desired location 
in the job that you are editing.

The copied page is inserted in the desired location, and the page 
numbers are updated accordingly.

5. Click Save As to save the changes in the job.

To copy all the pages of a job into another job:

1. Follow steps 1-4 in the procedure for copying a page into a job (see 
page 50).

2. Click the Merge Jobs button.

All the pages of the second job that you opened are inserted at the end 
of the job that you are editing.

3. Click Save As to save the changes in the job.

Note:  The red line indicates where the page will be inserted.
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Managing Virtual Printers
The Spire CXP50 color server provides three default network printers, also 
known as virtual printers. Virtual printers are a function used for 
automating workflows, which then define job streaming. They contain 
preset workflows that are automatically applied to all print jobs processed 
with that virtual printer. There is no need to reset job settings for each job, 
thus increasing printing efficiency.

A virtual printer is a printer published on the network with specific 
parameters set for processing and printing on the Spire CXP50 color 
server. The Spire CXP50 color server contains a mechanism that 
automatically installs the published virtual printers on your client 
workstation with the PPD and suitable printer driver.

The Spire CXP50 color server is predefined with three virtual printers:

• ProcessPrint 
Files sent to this printer are automatically processed and immediately 
sent to print from the Xerox DocuColor 5000 digital press.

• ProcessStore 
Files sent to this printer are automatically processed and stored in RTP 
format in the Storage window. Later, you can submit the job to print, 
or change the parameters of the job and resubmit it for processing or 
printing.

• SpoolStore
Files sent to this printer are automatically stored in the Storage window 
until the you submit them for processing and printing. You can only 
import PDL files (such as: PS, PDF, VIPP, VPS) to the spool store, not 
RIPed, RTP files.

The Printer Default options defined in the PPD use the default parameters 
set for the chosen virtual printer.

Adding a new printer
When adding a new virtual printer, you can specify if it is published on the 
network and if the virtual printer parameters will override the PPD 
parameters.

Note:  The print-related job parameters that are set in the job from the driver or 
PPD override the parameters set in the virtual printer. 
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In addition, based on predefined paper sets, you can specify that a virtual 
printer supports dynamic page exceptions and select the desired paper sets 
(up to four paper sets for each virtual printer). A job that has embedded 
dynamic page exceptions commands, and is submitted for print using a 
dynamic page exceptions virtual printer, is printed using the defined paper 
sets.

To add a new printer:

1. From the Tools menu, select Resource Center.

The Resource Center window opens.

2. From the Resource list, select Virtual Printers.

3. Click the Add button .

The Add New Virtual Printer dialog box appears.

Note:  Dynamic page exceptions are supported only in the Spire CXP50 color 
server with the Professional Kit.
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4. In the Name box, type a name for the new printer you want to add.

5. From the Based on list, select an existing printer.

6. In the Comments box, type any comment regarding the virtual printer 
parameters (optional).

7. The Publish the printer on the network check box is selected by 
default. Clear the check box if you do not want to publish the printer 
on the network.

8. Select the Override PPD parameters check box if you would like the 
Virtual Printer settings to override the PPD parameter selection.

9. If you would like this printer to support dynamic page exceptions, 
select the Support dynamic page exceptions check box. 

10. Edit the job parameters of your new virtual printer (see “Editing an 
Existing Printer”). 

11. Click OK in the Add New Virtual Printer dialog box. 

The new printer appears in the Printer list.

For more information about dynamic page exceptions, see “Dynamic Page 
Exceptions” on page 94.

Note:  If you don't edit the Job Parameters, the settings of the new virtual 
printer are taken from the printer on which it was based.



56  Chapter 3 – Basic Workflows

Editing an Existing Printer

To edit an existing printer:

1. In the Virtual Printers area, select a printer from the list and click the 

Edit button .

The Edit Virtual Printer dialog box appears.

2. Click Edit.

The Job Parameters window appears.

3. Select the desired parameters and change their settings according to 
your requirements.

4. Click OK to return to the Edit Virtual Printer dialog box.

5. Click Save to save the new settings.

Deleting an Existing Printer
1. In the Virtual Printers window, select a printer from the list and click 

the Delete button .



Managing Paper Sets 57

2. In the message that appears, click Yes to delete the designated printer.

Managing Paper Sets
The Spire CXP50 color server is provided with predefined paper sets for 
your convenience. These paper sets cannot be removed but they can be 
modified. In addition, you can add, modify or remove custom paper sets 
according to your requirements.

To add a new paper set:

1. From the Tools menu, select Resource Center.

The Resource Center window opens.

2. From the Resource list, select Paper Sets.

3. Click the Add button .

The Paper Set Properties window appears.
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4. Enter the following parameters:

Name: enter the new paper set name. It is recommended that the 
name is as descriptive as possible—for example, 
Letter90gsmuncoat.

From the Size, Color, Weight, Coat and Type lists, select the desired 
properties for the new paper set.

If you have enabled the custom paper function, map the paper set 
to a Custom Profile.

5. Click OK.

To modify a paper set:

1. In the Paper Set window, select the paper set you would like to modify.

2. Click the Edit icon .

The Paper Set Properties window appears. 

3. Modify the desired properties of the paper set.

4. Click OK.

Note:  You can set up to ten custom profiles.

For information on enabling the custom paper function, see “General 
Defaults” on page 190.
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To delete a paper set:

1. In the Resource Center window, with the Paper Sets option selected, 
select the paper set you would like to delete.

2. Click the Remove icon .

The Paper Set is deleted.

Note:  The system predefined paper sets can’t be deleted.
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Overview
To print a job from a client workstation, select one of the following 
methods:

• Print the job via one of the Spire CXP50 color server network (virtual) 
printers—for example, ProcessPrint.
The job is spooled and then processed or printed (according to the 
selected job flow of the virtual printer). If you use this method, you can 
print from any software—for example, Microsoft Word— and use any 
file format from any client workstation (Windows, Macintosh, or 
UNIX).

• Drag the job to a hot folder.
The job is spooled and processed or printed (according to the selected 
job flow of the corresponding virtual printer). 

If you use the hot folder method, you can print most PDL files on the 
Spire CXP50 color server— for example, PostScript, PDF, EPS, Variable 
Print Specification, and VIPP files. 

Working From Windows Client Workstations
The Spire CXP50 color server can print from a Windows client workstation 
that has one of the following operating systems:

• Windows 98, Windows ME

• Windows NT 4.0, Windows 2000, Windows XP

As an example, the following section describes how to define a Spire 
CXP50 color server network printer for a client workstation with a 
Windows XP Professional operating system.

For more information about hot folders, see “Using Hot Folders” on 
page 76.

Note:  PDL jobs that are spooled to the Spire CXP50 color server must have 
the appropriate file name extensions—for example, *.ps or *.pdf.
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Defining a Printer - Windows XP
Use the Windows Add Printer wizard to define the Spire CXP50 color server 
network printers.

To define a network printer in Windows XP using the network 
neighborhood:

1. On the desktop, double click My Network Places and browse to the 
desired network printer.

2. Double-click on the network printer icon.

The network printer is defined on your Windows client workstation.

Note:  When you add a new Spire CXP50 color server network printer to a client 
workstation, there is no need to install the Spire CXP50 color server PPD file and 
Adobe PostScript printer driver separately. They are installed automatically in the 
Windows Add Printer wizard.
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Copying the Printer Driver from Windows
Perform this procedure if you need to create PostScript files from 
workstations that are not on the same network as the Spire CXP50 color 
server—for example, at customer sites.

1. On the Spire CXP50 color server D:\ drive, double-click the Utilities 
folder.

2. Click PC Utilities, and then Printer Driver.

3. Find the directory of the driver relevant to your version of Windows.

4. Using a compression utility, such as WinZip, compress the directory, 
and either copy it to a disk or send it by email to the customer.

Printing From Windows
1. Open the file you would like to print in the corresponding software—

for example, open a PDF file in Adobe Acrobat.

2. From the File menu, select Print. 

The Print window appears.

3. From the Name list, select the desired Spire CXP50 color server 
network printer—for example, Spire_ProcessPrint.

For more information about installing Spire CXP50 color server network 
printers on client workstations, see “Working From Windows Client 
Workstations” on page 62.
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4. If desired, click the Properties button and modify the job parameters.

5. Click OK.

6. Click OK in the Print window.

The file is sent to the Spire CXP50 color server. 

Working From Macintosh Client Workstations
The Spire CXP50 color server can print to Macintosh client workstations 
running Mac OS 9 and Mac OS X (10.x).

As an example, the following section describes how to define a Spire 
CXP50 color server network printer for a Macintosh client workstation 
running Mac OS X.

You can also submit jobs using the Spire CXP50 color server virtual 
printers over a TCP/IP protocol. This connection enables a significantly 
higher spooling speed.

Notes:

• Unless the Override PPD Parameters option was selected in the 
virtual printer, any changes to the printer parameters override the 
parameters of the selected virtual printer. 

• Printer's Default indicates that the value is taken from the settings of 
the selected virtual printer on the Spire CXP50 color server.
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Copying the Spire CXP50 Color Server PPD File for Mac OS X 
(10.4)

Before you define a network printer you need to install the Spire CXP50 
color server PPD file on your Macintosh client workstation.

1. From the Go menu, select Connect to Server.

The Connect to Server window appears.

2. Click Browse to locate the desired Spire CXP50 color server, and then 
click Connect.
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The Connect to Server window appears.

3. Select Guest, and then click Connect.
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4. Select the server Utilities folder, and then click OK.

The CXP50_Utilities folder is mounted on your desktop.

5. Double-click the CXP50_Utilities folder on your desktop.

6. Double-click the PPD folder, and then double-click the folder for the 
desired language.

7. Copy the PPD file from the Spire CXP50 color server to your 
Macintosh hard disk.

 

Setting the Network Printer for Mac OS X (10.4)
1. Copy the Spire CXP50 color server PPD file to the Library > Printers > 

PPDs > Contents > Resources > en.Iproj folder on your client 
workstation.

2. From the Go menu, select Applications.

Tip:  It is recommended that you copy the PPD file by dragging it from the Spire 
CXP50 color server to the Library > Printers > PPDs > Contents > Resources 
> en.Iproj folder on your Macintosh.

For more information about copying the PPD file, see “Copying the Spire 
CXP50 Color Server PPD File for Mac OS X (10.4)” on page 66.
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3. Open the Utilities folder and double-click the Printer Setup Utility
icon.

4. Click Add.
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5. Select the Spire CXP50 color server.

6. In the Print Using list, select Other.

7. Locate the folder to which you have copied the PPD file, and then 
select the file.

8. Click Open to assign the PPD file to the selected Spire CXP50 color 
server network printer.
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9. Click Add to add the new printer to the printer list.

Printing from a Macintosh
1. Open the file you would like to print in the corresponding 

application—for example, open a Quark file.

2. From the File menu, select Print.

3. From the Printer list, select the desired printer.
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4. In the Copies & Pages list, select Printer Features.

5. Adjust the printer options as desired.

6. After modifying the job settings, click Print.

The file is sent to the Spire CXP50 color server. 

Notes:

• The Printer's Default option indicates that the value is taken from the 
published printer that is currently selected.

• The PPD parameters are divided into five Printer Specific Options in 
the list.
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Spire Web Center
The Spire web center is an internet site that provides Spire information and 
can be accessed from client workstations. 

The Spire web center enables you to:

• View the status of jobs in the Spire queues, the Job Alert window in its 
current state, and the printer system information

• Download remote client tools, utility software, color profiles, and print 
drivers

• View Spire related documentation, such as release notes, Spire guides, 
frequently asked questions and answers, and other troubleshooting 
information

• Find links to related vendors or products

To connect to the web center from a client workstation:

1. On your desktop, click the Internet Explorer icon.

2. When the Internet Explorer starts, in the address field type: 
http://<spire name>—for example, if the Spire station name is 
FALCON_E, type http://FALCON_E.

Important:  To connect to the Spire Web Center from a client workstation, you 
must first enable the web connect service on the Spire CXP50 color server. To 
enable this service, select the Settings window > Administration > Remote 
Tools Setup.

For more information about setting up the web connect service, see “Remote 
Tools Setup” on page 178.

Note:  You can also use the Spire color server IP address—for example, 
http://192.168.92.0.

Important:  If you would like to connect to the Spire CXP50 color server 
from a Macintosh client workstation, contact your system administrator to 
add the Spire name to the DNS. This is required since Windows name 
resolution protocols are not supported in Macintosh. The DNS addition is 
required when clients go through a main server on the network.
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The Spire CXP50 color server web center appears.

The Web Viewer
The Web Viewer page enables you to view the printer configuration and 
system information, the jobs that currently reside in the Spire CXP50 color 
server Queues window and Storage window, and to view the alerts that 
currently appear in the Job Alert window. This information is important 
when you print from a client workstation because it enables you to 
monitor your jobs in the queues and then make any necessary changes. 

In addition, if you have a system that uses XML protocol, you can retrieve 
information about the job list and printer status.
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Web Viewer API
The JobList.xml file and the Printer Status.xml file enable you to retrieve 
information about the job list and the printer status.

The JobList.xml file contains information about files in the Print Queue, 
Process Queue, and the Storage window.

To see the Job List view, type the following path: 
http://<ComputerName>/WebViewer/GetView.asp?View=JobList_xml.

The Printer Status.xml file contains information about the various printer 
states. To see the Printer State view, type the following path: 
http://<ComputerName>/WebViewer/GetView.asp?View=PrinterStatus_xml.

Downloads
The Downloads page enables you to access the Spire CXP50 color server 
Utilities folder and download available tools and files for Windows and 
Macintosh client workstations—for example, the Spire CXP50 color server 
PPD file.

Links
The Links page enables you to link to related vendors or products.

Table 9: Description of tabs in the Web Viewer

This tab Enables you to view

Queues Jobs that are currently running in the Spire CXP50 color 
server print and process queues

 Storage Spire CXP50 color server Storage window and the jobs that 
reside in this window

 Alerts The Spire CXP50 color server Job Alert window messages. 
For example, if a job that you sent to print from your client 
workstation has failed—you can view the message in the 
Job Alert window, edit the job parameters (PPD file), and 
then resend it for processing and printing on the Spire 
CXP50 color server.

 Printer Spire CXP50 color server system information
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Using Hot Folders
For every published Spire CXP50 color server network printer that you 
define on a client workstation, a corresponding hot folder is automatically 
created in the Spire CXP50 color server D:\Hot Folders folder. The Spire 
CXP50 color server has three default hot folders, HF_ProcessPrint, 
HF_ProcessStore, and HF_SpoolStore. These hot folders correspond to the 
three default printers.

Each hot folder carries the virtual printer's name HF_printer’s name.

When you connect from a client workstation to the Spire CXP50 color 
server over the network, you can use the hot folder to submit PDL jobs to 
the Spire CXP50 color server. When you establish a connection, drag your 
jobs onto the desired hot folder (according to the selected workflow).

Jobs that reside in the hot folder will automatically be submitted to the 
Spire CXP50 color server through the corresponding virtual printer. 
Consequently, all of the virtual printer job parameters, inclusive of the 
workflow, will be applied to the job.

As soon as the job has been spooled to the Spire CXP50 color server, it 
disappears from the hot folder and enters the Spire CXP50 color server 
process queue or Storage window, according to the selected workflow.

Hot Folder File Formats
Hot folders can contain all PDL formats that are supported by the Spire 
CXP50 color server, PS, PDF, EPS, PRN, VPS, VIPP, PPML, TIF, JPG and 
GAP. 

Files of unsupported formats that are moved to a hot folder are not 
imported to the Spire CXP50 color server and remain in the hot folder.

Tip:  You can also drag the hot folder icon to your desktop to create a short cut 
to the folder for future usage.

Note:  If you send files for printing through a hot folder while the Spire CXP50 
color server software is down, when the software restarts, the files that reside in 
hot folders will immediately be imported to the system.
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Hot Folders and Brisque or Prinergy jobs (GAP Formats)
When you use hot folders to print GAP jobs, the process is automated and 
the job is converted to a PDF, which is displayed in the Spire CXP50 color 
server queues. The PDF files can then be programmed and printed as any 
other PDF file.

Using Hot Folders from Client Workstations
You can use hot folders to process and print files from any client 
workstation. The following procedures explain how to print using hot 
folders from Windows and Mac OS X.

To print a job using a hot folder from Windows:

1. On your Windows desktop, double-click the Network Neighborhood 
icon. 

2. Locate your Spire CXP50 color server.

3. Double-click the Spire CXP50 color server. 

A list of all the shared folders, hot folders, and virtual printers appears.

4. Double-click the desired hot folder—for example, HF_ProcessPrint.

Tip:  You can also drag the hot folder icon to your desktop to create and 
use a shortcut to the folder in the future.
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You can now drag the desired files to the hot folder. All the files are 
processed and printed automatically to the printer, according to the 
hot folder workflow.

To print a job using a hot folder from a Mac OS X:

1. On your Macintosh desktop, from the Finder menu bar, select Go > 
Connect to Server.

The Connect to Server window appears.
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2. Locate your Spire CXP50 color server on the network, and click 
Connect.

3. Select Guest, and then click Connect.

4. From the list, select the desired hot folder—for example, 

HF_ProcessPrint —and then click OK.

The hot folder icon appears on your desktop. You can now drag the 
desired files to the hot folder icon. All the files are processed and 
printed automatically to the printer, according to the hot folder 
workflow.
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Imposition Workflow
Imposition is part of the process of producing finished documents. 
Imposition refers to the placement of the job pages on a sheet for printing. 
In addition to pages, you can add various marks to the sheet to aid the 
production process, for example—fold, trim, or crop marks. The content 
of an individual page is not affected by imposition. 

In the Spire CXP50 color server, imposition parameters are set in the 
Imposition tab. Whenever possible, you should define imposition settings 
in your job before RIPing.

For imposition workflows using the same settings, you can use a virtual 
printer to predefine your imposition settings and streamline the print 
process.

Imposition Templates
The Resource Center Imposition Template area enables you to import and 
manage user-defined imposition templates that were created in stand-
alone software—for example, Ultimate inSpire. 

To import a user-defined imposition template:

1. On the toolbar, click the Resource Center button . 

2. In the Resource list, select Imposition Templates.

3. Click the Import button .

4. In the Open dialog box, locate the user-defined that template you 
want to import. 

5. If you want to lock the template, select the lock job ticket check box.  

For more information, see “The Imposition Tab” on page 231, and “Setting 
Exceptions for Imposed Jobs” on page 94.

For information on virtual printers, see “Managing Virtual Printers” on page 53.

Note:  Locking a template means that you cannot set or change imposition 
parameters in the Job Parameters window.
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6. Click Import.

To rename a user-defined imposition template:

1. On the toolbar, click the Resource Center button . 

2. In the Resource list, select Imposition Templates.

3.  From the list, select a user-defined imposition template and click the 

Rename button .

4. Type a new name for the user-defined imposition template.

5. Click OK.

The new name of the user-defined imposition template appears in the 
imposition template list.

To delete a user-defined imposition template:

1. On the toolbar, click the Resource Center button . 

2. In the Resource list, select Imposition Templates.

3.  From the list, select a user-defined imposition template and click the 

Remove button .
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High-Resolution Workflow
Working with high-resolution files during the design and page layout 
process can often be long and inefficient. Processing and manipulating 
large files and graphics can be time consuming. To speed production, it is 
recommended that you work with low-resolution files until the RIPing 
stage.

The Spire CXP50 color server with the Professional Kit includes the Creo 
APR (Automatic Picture Replacement) feature and supports Open 
Prepress Interface (OPI)workflows for replacing low-resolution files with 
high-resolution files during RIPing. 

High-resolution image file, 5.23 MB Low-resolution image file, 306 KB
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Creo APR

Creo APR is an image replacement method for PostScript files. 

When you send your PostScript file to be processed, the Spire CXP50 color 
server checks it for Creo APR instructions. The instructions specify how an 
external high-resolution image is placed in a PostScript file as it goes to RIP. 
It then searches for the external high-resolution file, performs the specified 
image replacement and RIPs the PostScript file.

A standardized set of file instructions The instructions specify the type, 
size, position, rotation, cropping and location of the high-resolution 
images themselves. 

For more information on setting the APR settings, see “The Services Tab” 
on page 238.

OPI 

Like Creo APR, OPI is a standardized set of file instructions that specify 
how an external high-resolution image is placed in a PostScript file as it 
goes to RIP. The instructions specify the type, size, position, rotation, 
cropping and location of the high-resolution images themselves. 

When you send your PostScript file to be processed, the Spire CXP50 color 
server checks it for OPI instructions. It then searches for the external high-
resolution file, performs the specified image replacement, and RIPs the 
PostScript file.

Note:  This feature is available only for the Spire CXP50 color server with the 
Professional Kit.

Note:  This feature is available only for the Spire CXP50 color server with the 
Professional Kit.
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Many OPI systems use remote storage of high-resolution files. The Spire 
CXP50 color server supports the storage and replacement of high-
resolution OPI files internally. 

To select OPI support:

1. From the Tools menu, select Settings.

The Settings window appears.

2. Under Preferences, select General Defaults.

3. In the OPI area, select Enable OPI Spire Support.

Note:  PDL files from some DTP software (such as QuarkXPress) may contain 
these instructions (“comments”) by default, even though the high-resolution 
files are unavailable because they have been embedded in the job. In this case, 
the job is not processed and an error message appears. To ensure continuous 
printing, the Spire CXP50 color server OPI image replacement is then unavailable 
by default.

Note:  When the Enable OPI Spire Support option is selected, the 
Support Helios Server check box is automatically selected by default. If you 
do not want Helios server support, clear this check box.
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Creo APR and OPI File Formats  

Creo APR and OPI function identically on the Spire CXP50 color server. 
Creo APR low-resolution files have an *.eps extension in Windows and an 
*.e extension on the Macintosh, while OPI low-resolution files have a *.lay 
extension. The Creo APR and OPI workflows support Creo Continuous 
Tone, EPSF, Jpeg, PDF, DCS1, DCS2 and TIFF high-resolution file formats. 
You can use either the Creo APR or OPI workflow, depending on your 
high-resolution file type.

Preparing to Print Using Creo APR or OPI
1. Create low-resolution files from high-resolution files.

2. Export each image file as a low-resolution *.e file—for example, a file 
called duck is exported as duck.e. 
OPI images can be created in other software or can be provided by a 
print service bureau. Make sure that you have created or obtained the 
desired image files.

3. When you design the document in DTP software, use low-resolution 
files.

Note:  This feature is available only for the Spire CXP50 color server with the 
Professional Kit.

Note:  You can use the PS Image Exporter Plug-In in Adobe Photoshop to 
create Photoshop Image (APR low-resolution) files. You can install the PS 
Image Exporter Plug-In from the Spire CXP50 color server Documentation 
and Utilities CD-ROM.

Notes:

• A PostScript image (*.e) file is a low-resolution preview of the original 
high-resolution file. It contains preview information saved at 72dpi in 
black and white or color. Also, it contains pointers to the location of the 
high-resolution Image.

• APR low-resolution files have a. “*.e” extension on the Macintosh and 
an “*.eps” extension in Windows. OPI low-resolution files have a 
“*.lay” extension. 
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4. Perform detailed graphic work on the original high-resolution file. 
Only use the low-resolution file for positioning, rotating, scaling and 
cropping. 

5. Place the high-resolution files in a defined path on the Spire CXP50 
color server. The Spire CXP50 color server looks for this path when it 
RIPs your jobs. Define the high-resolution path through the Job 
Parameters window for each job.

Printing with Creo APR or OPI
If your high-resolution files are located in the Spire CXP50 color server 
default folder (D:\Shared\HighRes), you can print APR or OPI jobs 
without adjusting APR settings. 

Perform the following steps:

1. Print, download, or import the job from the client workstation to the 
Spire CXP50 color server Storage window.

The job is processed according to the settings of the selected virtual 
printer using APR or OPI high-resolution files.

2. Double-click the job in the Spire CXP50 color server workspace.

3. Select the Print Quality tab in the Job Parameters window.

4. Adjust the job parameters.

Note:  Once you create the low-resolution file, do not change the name of 
the high-resolution file. This is the file name for which the Spire CXP50 color 
server searches.

Notes:

• The Spire CXP50 color server default HiRes folder used for APR and 
OPI is D:\Shared\HiRes.

• Paths other than the default path are defined on a per-job basis. You 
can define the APR path to any connected server or disk.

Important:  OPI support is unavailable by default. If you would like to select 
the Spire OPI support, see “To select OPI support:” on page 86.

Note:  If your high-resolution files are not located in the Spire CXP50 color 
server default folder, specify the APR path(s), see “Setting a High-Resolution 
Path” on page 240.
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5. Set other high-resolution job parameters as desired. 

6. Click Submit. 

The job is processed on the Spire CXP50 color server and sent to the 
Xerox DocuColor 5000 digital press for printing.

PDF Workflow
When you print PDF jobs with repeated elements, you can decrease 
processing time significantly if you apply the PDF workflow.

The PDF workflow caches the repeated elements in the PDF once, and 
reuses them as needed without repeated processing.

For more information on PDF optimization, see “The Services Tab” on 
page 238.

To distill a PostScript file on the Spire CXP50 color server:

1. In your client workstation, copy the desired PostScript file.

2. Locate the Spire CXP50 color server on the network, and paste the file 
to D:\Shared.

3. On the Spire CXP50 color server station, click the Start button and 
select Programs > Acrobat Distiller.

Note:  If the masking data in the PS Image file defines a completely different 
part of an image than the masking data in the high-resolution file, no 
masking data is used. 
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4. From the Settings menu, select Edit Adobe PDF Settings.
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5. In the General tab, verify that Optimize for fast web view is selected 
and click Cancel. If this option is not selected, select the Optimize for 
fast web view check box, and click OK.

6. From the File menu, select Open.

The Acrobat Distiller - Open PostScript file dialog box appears.

7. Locate the desired PostScript file, and then click Open.

The Acrobat Distiller - Specify PDF File Name dialog box appears. 

8. The default name is the PostScript file name. You can change it in the 
File name box.

9. Verify that the file is saved in D:\Shared.

10. Click Save.

Your file is distilled and a PDF file is created.

11. In the Spire CXP50 color server software, from the Job menu, select 
Import.

You can import the PDF file for printing.

Export as PDF2Go
PDF2Go is a port through which you can export RTP files, and convert 
them to a PDF file during export.

The Spire CXP50 color server is capable of exporting jobs that are standard 
PDF files after processing. For an exported RTP job, the PDF file includes 
the rasterized data of the job.

The operation converts the RTP information to raster files that can be 
encapsulated in a PDF format. This process ensures that the file can be 
processed and printed on any PDF printer. 

Tip:  You can create a shortcut to the Acrobat Distiller on the Spire CXP50 color 
server desktop. This shortcut can be used to drag files onto the Acrobat Distiller 
for quick distilling. To create a shortcut, click the Start button on your 
Windows desktop, and follow the path Programs > Acrobat Distiller. Right-
click Acrobat Distiller and follow the path Send To > Desktop (create 
shortcut).

Note:  Except for RTP jobs that were originally VI jobs, you can export every type 
of file.
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While exporting as PDF2Go, a running bullet starts to move from right to 
left in the bottom arrow adjacent to the server-printer animation.

To export as PDF2Go:

1. Right-click a file in the Storage window, and from the menu select 
Export as PDF2Go.

2. Select the Print Optimized option to generate a high-resolution PDF 
file in 300dpi. 

The Screen Optimized option (default) generates a low-resolution 
PDF file in 72 dpi. 

3. Click OK.

Tip:  Use the Screen Optimized option when you want to generate a light PDF 
file—for example, a file that you can send as a proof by e-mail.
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4. Locate the folder in which to save the file, and then click Export.

The file is saved as a PDF file under the job's name in the selected 
location.

Page Exceptions
Page exceptions are used when you want to use different paper sets for 
special exceptions within a job or add inserts (interleaves). This feature 
uses the following terminology:

• Exceptions are special pages within a job for which you want to assign 
different paper stock. For example, you can choose to assign a different 
paper stock for each chapter within a book. 

Note:  When you export PDL files as PDF, the file is converted to PDF using 
the Acrobat Distiller. 

For more information in setting page exceptions, see “The Exceptions Tab” 
on page 249.
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• Inserts are blank pages of a selected paper stock that are assigned to a 
job after a specified number of pages. For example, you can choose to 
add blank pages between sections within a brochure. 

Setting Exceptions for Imposed Jobs
You can set different paper sets for special exceptions within a job and also 
add inserts (interleaves) in imposed jobs. You set these exceptions and 
inserts in the Exceptions tab.

If the selected imposition method is Saddle Stitch or Perfect Bound, the 
exceptions are handled in the imposed sheet level (and not on a page level).

You cannot set exceptions or inserts if the selected imposition method is 
Step & Repeat and its sub-option Cut & Stack.

Dynamic Page Exceptions

Standard PostScript setpagedevice commands that specify different paper 
types are embedded into the incoming files and enable you to print 
complex jobs of varying paper size, stocks, and paperweight. These 
commands indicate that the printer must switch media during the printing 
of a job. When a job is RIPed, the Spire CXP50 color server identifies the 
dynamic page exception commands and maps them to the selected paper 
sets. The printer then prints the job in order, automatically printing on the 
defined paper sets as the job requires.

Typically, you use the dynamic page exceptions workflow for VI jobs or a 
very large PostScript files that include page exceptions or inserts.

For more information about paper sets, see “Managing Paper Sets” on 
page 57.

Notes:

• For the Step & Repeat imposition method, exceptions are handled on a 
page level (same as for non-imposed jobs).

• An imposed sheet contains the multiple images that are all printed on the 
same physical sheet.

Note:  Dynamic page exceptions are available only for the Spire CXP50 color 
server with the Professional Kit.
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The Spire CXP50 color server supports dynamic page exceptions for the 
following file formats:

• PostScript

• Variable Print Specification

• VIPP

• PDF

Setting the Spire CXP50 Color Server for Dynamic Page 
Exceptions

To set up the job flow for dynamic page exceptions you need to:

1. Create a file with embedded setpagedevice commands on your client 
workstation.

2. Select Resource Center > Paper Sets and create the paper sets that you 
need to print your file. 

3. Create a dedicated virtual printer that supports dynamic page 
exception commands, and then map specific paper sets in the 
Exceptions tab. 

4. Import the file into the Spire CXP50 color server via the dedicated 
virtual printer, and submit the job for printing.

When the job is RIPed, the dynamic page exception commands are 
identified and mapped to the selected paper sets. The desired paper 
sets are used when the job is printed.

For more information about adding a new virtual printer and mapping 
specific paper sets, see “Managing Virtual Printers” on page 53.

Notes:

• If a job is printed using a dynamic page exceptions virtual printer, the 
Imposition tab in the Job Parameters window is unavailable.

• If you have the Spire CXP50 color server Professional Kit, once you 
import your file via the dedicated virtual printer, you can perform a 
preflight check before the job is sent to print, see “Preflight Check” on 
page 105.
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Tips and Limitations
The following list describes tips and limitations for the dynamic page 
exceptions workflow:

• Define all pages in the original file using the dynamic page exceptions 
commands.

• To add inserts, use a dynamic page exceptions command in the file that 
requires a paper stock but will not print anything on it. If a job is 
duplex, make sure that you use the command twice.

• Virtual printers that support dynamic page exceptions should not be 
used for other jobs. 

• Virtual printers that support dynamic page exceptions do not support 
page exceptions and imposition. In addition, the paper stock selection 
is limited to the assigned stocks and not the entire database.

• When you create the dedicated virtual printer, you should define the 
paper feed direction for the paper sets in the job. All paper sets that are 
used in a dynamic page exceptions job must be in the same paper feed 
direction. Make sure you do not select the Best Fit option. 

Fonts
This section lists all the fonts available on the Spire CXP50 color server, 
and explains how to work in the Fonts area of the Resource Center. 

A step-by-step procedure explains how to use the FontDownLoader driver 
to download fonts from a Macintosh client workstation.

In addition, you can download Windows fonts from a client workstation to 
the Spire CXP50 color server. This is done by dragging the fonts to the 
HF_Fontdownloader hot folder.

For information about defining the paper feed direction, see “The Paper 
Stock Tab” on page 219.
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Managing Fonts

1. On the toolbar, click the Resource Center button . 

2. In the Resource list, select Fonts.

3. Choose a Font Library option. The default option is Latin.

4. To set the default font, select a font from the list, and click Set as 
Default.

5. To delete a font, select the font, and click Delete font.

Notes: 

• To add new fonts to the Spire CXP50 color server, copy the new fonts to 
the C:\CXP50\General\RIP\Font folder.

• You can substitute fonts. For more information, see “Substituting Fonts” 
on page 239.
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Downloading Fonts 

Using the Fontdownloader for Macintosh Networks
The Fontdownloader is a driver provided for Macintosh networks and 
enables you to download fonts from a Macintosh client workstation. The 
Fontdownloader functions as a communications port and sends messages 
between the Fontdownloader software and the Spire CXP50 color server. 
You cannot send files through the Fontdownloader, only fonts.

To download fonts using the Fontdownloader driver (Mac OS 9.x):

1. From the Apple menu, select Chooser.

2. Select AppleShare and browse the network to where the Spire CXP50 
color server is configured.

3. Select the Spire CXP50 color server—for example, CXP50—and then 
click OK.

 

The Login dialog box appears.

4. Log in as Guest and click the Connect button.

The corresponding Spire CXP50 color server window appears.

Note:  Mac OS X users that want to download fonts need to use a previous 
Mac OS version—for example, Mac OS 9.x. It is recommended that you 
embed the fonts in the file.
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5. Select the Utilities folder, and then click OK.

6. Double-click the Adobe Downloader 5.0.5 folder. 

7. Copy the Adobe Downloader 5.0.5 to your desktop.

8. From the Apple menu, select Chooser.

The Chooser window appears.

Note:  Do not select the check box, otherwise it will mount with every 
restart.
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9. Select LaserWriter (8.x) and select the desired fontdownloader.

10. Click Create.

11. Double-click the Downloader 5.05 on your desktop.

12. On the File menu, select Download Fonts.

13. In the font area, select the desired font directory.

14. Verify that Disk 0 is the selected device.

15. Add all the desired PostScript fonts and click the Download button.
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Using the Fontdownloader Hot Folder for Windows

You can use the HF_Fontdownloader hot folder to install new or missing 
fonts to the Spire CXP50 color server fonts dictionary. The hot folder is 
located with the other hot folders on your client workstation and can be 
used with the following operating systems:

• Windows 2000

• Windows NT 

• Windows XP

Graphic Arts Workflow
This section describes the workflow for printing Graphic Art Port (GAP) 
files.

The GAP is a port through which you can import various file formats used 
in the graphic arts industry. GAP files are already rasterized. The Spire 
CXP50 color server only needs to prepare the files for printing, which 
means adjusting the file resolution and rotation. 

For more information about hot folders, see “Using Hot Folders” on page 76.
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Importing GAP Files
To print a specific page, import the assigned file for the specific page. To 
print a specific job, import the assigned file for the specific job. 

Supporting GAP Files
The Spire CXP50 color server can import and convert the following file 
types:

• Brisque jobs

• TIFF

• TIFF/IT

• CT / LW

The system converts these file types to “pre-rasterized” PDF files. GAP 
PDF files behave the same as any other PDF file and have the same job 
parameters.

GAP File Structure

TIFF/IT
A TIFF/IT file has 3 components:

• CT.TIF

• LW.TIF

• FP (final page) file, which combines CT.TIF and LW.TIF

Note:  When the assigned job file is imported, it is converted to a PDF file and 
appears in the Spire CXP50 color server queues. The PDF file can be configured 
and printed as any other PDF file. 

Note:  The Spire CXP50 color server supports the following GAP file formats: pre-
separated and composite.
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To import a TIFF/IT file to the Spire CXP50 color server, first import the 
FP file. During import, the file is converted to a PDF file, and appears in 
the Spire CXP50 color server queues. The PDF file can be configured and 
printed as any other PDF file.

CT, LW, TIFF
Brisque jobs and TIFF/IT files include CT, LW and TIFF files that can be 
imported and printed separately to the Spire CXP50 color server.

Rasterized Brisque Jobs
All rasterized Brisque jobs share a common structure. Each job contains an 
assigned file with one or more pages (in case of a multiple job). Also, every 
page contains its own assigned file, which combines LW and CT.

• To import a Brisque job to the Spire CXP50 color server, import the 
assigned file of the job.

• To print a specific page, import the assigned file of the specific page.

Preflight

The following preflight features are available:

• PDF analyzer

• Preflight check

• Preflight report

Analyzing a PDF Job

Note:  Make sure that in the Spire CXP50 color server Import window, Gap files 
is selected in the Files of type box.

Note:  Preflight features are available only for the Spire CXP50 color server with 
the Professional Kit.

Note:  This feature is available only for the Spire CXP50 color server with the 
Professional Kit.
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You can use the PDF analyzer to check imported PDF files for problems 
that may affect processing. The PDF analyzer checks the following 
elements:

• Document: identifies incompatibilities of Acrobat software with 
compression, encryption, security, and other properties

• Pages: detects empty pages and identifies the page size, annotations, 
and other properties

• Fonts: determines whether specific fonts are in the PDF file and 
whether they are embedded

• Colors: detects color space information, spot colors, rendering 
information, and color management settings

• Images: identifies image resolution, whether images are skewed or 
flipped, and whether images are compressed

• OPI: detects whether OPI is used. If so, the PDF analyzer detects the 
OPI version and determines whether any high-resolution images in the 
OPI path are missing

• Text and line art: identifies the size of text, the width of the lines, white 
text, and objects and flatness tolerance

• PDF/X: determines whether the file conforms to PDF/X-1a or to 
PDF/X-3 and whether the file contains PostScript fragments

To run the PDF analyzer:

1. In the Storage folder, right-click the PDF file, and select PDF analyzer.
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2. In the PDF PreFlight Settings area, do one of the following actions:

• To check the entire PDF file, select Complete Document.

• To check specific pages, select Pages and enter the desired page 
range.

3. If you do not want the report to automatically open when it is 
generated, clear Display report automatically.

4. If desired, change the report file name. By default, the report file name 
consists of the original file name with the suffix _rep—for example, if 
the file to be checked is sample.pdf, the report file is named 
sample_rep.pdf.

5. If you want to save the report to a specific location, click Browse and 
navigate to the desired location.

6. Click Run.

The PDF report is generated and opens automatically.

Preflight Check
Note:  This parameter is available only if you have the Spire CXP50 color server 
with the Professional Kit.
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The Preflight parameter enables you to check the status of key job 
components before the job is sent for printing. 

During the preflight check, your job is RIPed and the missing components 
are identified. The preflight check detects the status of the following key 
job components:

• High-resolution images or the wrong links to the high-resolution 
images folder

• Missing fonts

• Spot colors that are not defined in the Spire CXP50 color server spot 
color dictionary

• Dynamic exception commands for a file that was submitted via a 
dynamic page exceptions virtual printer

The results of the preflight check are displayed in a Preflight Report. By 
default, a preflight report is not issued for each job. To issue this report, 
you must run a preflight check for the job using the Preflight job 
parameter.

To run a preflight check:

In the Preflight options area, select Run Preflight check.

All four check boxes of the key job components are active, but you can 
clear any check box that you don’t want to include in the preflight 
check. 

Note:  You can select the preflight options before the job is processed, but you 
can only view the preflight report after the job is processed.

Note:   If a job component is missing, the job fails before it is RIPed (an alert 
message appears) and information about missing components appears in the Job 
History window.

Note:  If one of the selected elements in the list is missing, the job status at 
the end of the preflight check is “Failed” and the job is transferred to the 
Storage window.
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Preflight Report

The preflight report is a job-related report that provides information about 
the status (missing or found) of key job components prior to printing and 
enables you to correct your files accordingly.

It is especially useful to run the preflight check before you print a complex 
job with a large quantity of pages or copies. The preflight check detects the 
missing job components and displays them in the Preflight Report dialog 
box. You can review the report and resolve the missing components and 
thus save processing time without error or failed messages constantly 
appearing.

If you run a preflight check and all key components are found, the job is 
processed and printed according to the job flow that you selected. If the test 
fails (missing key elements are detected), the job is returned to the Storage 
window with the preflight report available for inspection.

The preflight report always reflects the last preflight run. If more than one 
preflight check is run on a job, the latest preflight report overrides the 
previous. When a preflight report is produced, the date and time of the 
preflight check are indicated in the Jobs History window.

To view the preflight report:

1. Right-click the job in the Storage window, and from the menu select 
Preflight Report.

The Preflight Report dialog box appears. If you selected the HiRes files 
option in the Preflight Options area, the HiRes Report appears first.

Note:  This feature is available only for the Spire CXP50 color server with the 
Professional Kit.

Note:  Since the Preflight Report dialog box lists all key job components (missing 
and found), you can use this report to view the existing (found) key job 
components—for example, the list of the existing fonts in a job, and their 
corresponding paths.
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If there are key components in the job not found, this will be indicated 
by the missing indicator  next to the HiRes, Spot Colors, and Fonts 
report options.

If you did not select a preflight option for the preflight check, the not 

preflighted indicator  appears next to the report option. 

If all of the files are found for a preflight option, the found indicator  
appears next to the report option.

2. From the Show list, select one of the following options:

• To display all files, select All.

• To display only files that were found, select Found Only.

• To display only the missing files, select Missing Only.
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3. Select the Spot Colors report option.

The Spot Colors Report area displays the missing spot color names 
(spot colors which were not found in the spot color dictionary) and 
the found spot color names (spot colors which were found in the spot 
color dictionary). The C,M,Y,K columns display the spot color CMYK 
equivalences:

• If the status is missing, the Spire CXP50 color server uses the 
original CMYK values that are embedded in the PS file to emulate 
the desired spot color.

• If the status is found, the Spire CXP50 color server uses the CMYK 
values that are in the spot color dictionary.

4. Click the Fonts report option.
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The Font Report area displays the name of the missing fonts that are 
not embedded in the file and that do not exist in the Font Library, as 
well as the found fonts.

The Source column indicates whether the font is embedded in the file 
or was found in the Font Library.

5. Click the Dynamic Exceptions report option.
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The Dynamic Exceptions area displays the dynamic page exception 
commands found in the file. 

6. To save the preflight report, click Save and browse to the desired 
location.

7. To print the report, click Print.

Export as Creo Synapse InSite Job

Creo Synapse InSite provides an internet-based communication between 
you and your customers and enables you to proof jobs and receive 
approvals remotely. 

If your site includes a Creo Synapse InSite server, exporting your job as an 
InSite job from the Spire CXP50 color server allows you and your 
customers to proof online with geographically dispersed users 
simultaneously, append annotations or comments, and approve or reject 
pages over the World Wide Web using a standard browser.

After the RTP job is created on the Spire CXP50 color server, it can be 
exported as an InSite job from the Storage window. When the customer 
logs on (using their unique user name and password), they see the status of 
their jobs, view a thumbnail of all pages in each job, and quickly identify 
which pages require further corrections. The customer can measure color 
density, make annotated comments, and approve pages. The online 
proofing cycle is shortened and accurate, and consequently, the need for 
reprints is reduced.

For more information about dynamic page exceptions, see “Dynamic Page 
Exceptions” on page 94.

Tip:  If more than one preflight check is run on a job, the latest preflight 
report overrides the previous. You can save the report for future use.

Note:  This feature is available only for the Spire CXP50 color server with the 
Professional Kit.
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To export as InSite:

1. Select the desired job in the Spire CXP50 color server Storage window.

2. Right-click the job, and from the menu select Export as InSite Job.

The Open window appears.

3. Locate the file in which you want to export the job, and then click 
Export.

A Brisque job is created in the selected location. You can now register 
the files on the InSite server and start the approval cycle.
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Calibration
One of the most important issues in obtaining satisfactory print quality is 
steady toner density. Toner density is affected by many factors such as heat, 
humidity and service settings. You should perform a daily calibration to 
compensate for these factors. 

The calibration process corrects the printer colors by measuring their 
density and creating calibration look-up tables. The Spire CXP50 color 
server uses the data in these tables to compensate for the differences 
between the actual, measured density level and the target level, the target 
density.

You should perform calibration in the following instances:

• When you use a new paper stock

• When you use a different screening method

• At least once every eight hour shift for every combination of paper 
stock and screening method used

• When prints show “color casts”

• After machine maintenance or hardware changes—for example, 
replacing a “Charge Coroton”

• On drastic ambient changes (temperature and humidity)

Guidelines for Successful Calibration
To ensure your calibration is as accurate as possible, check the following 
guidelines before you calibrate:

• Ensure that your X-Rite DTP34 QuickCal densitometer is connected 
properly

Important:  Perform a different calibration for every combination of media and 
screen type you are going to use for printing. When calibrating, always use the 
same media that you intend to use for printing.

Tip:  You can set a reminder to remind you to calibrate the Xerox DocuColor 
5000 digital press. For more information, see “Calibration Reminder” on 
page 195.
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• Ensure that your X-Rite DTP34 QuickCal densitometer is calibrated. 
You should calibrate the device at least once a week, or whenever the 
power to the device is interrupted. Use the manufacturer calibration 
chart supplied with the device. After you finish calibrating the device, 
make sure you store the chart in the designated envelope.

• To warm up the printer, use any media to print at least 25 duplex sheets 
of any four color test job.

• Print a reference job and use the same media and screen type on which 
you will print the final job. 

• Prepare the calibration pad to measure the calibration charts. If a 
calibration pad is not available, set a white media, at least 200 gsm, or 
two sheets of lighter paper, on the surface. Read the calibration chart 
on this surface.

• Set the Spire CXP50 color server emulation method to the method you 
will use to print the customer job (CSA or Device Link).

The Calibration Process
The calibration process consists of the following steps:

1. Calibrate the X-Rite DTP34 QuickCal densitometer, see “Calibrating 
the X-Rite DTP34 QuickCal Densitometer” on page 116.

2. Set the calibration method, see “Setting the Color Calibration 
Method” on page 120.

3. Load the paper set you are going to use for printing in the Xerox 
DocuColor 5000 digital press.

4. In the Spire CXP50 color server, from the Tools menu, select 
Calibration, see “Calibrating the Spire CXP50 Color Server” on 
page 120.

5. Click Calibrate to run the Color Calibration Wizard, and to create a 
calibration table.

6. Follow the Color Calibration Wizard steps.

Note:  Make sure you set the screen type to the one you are going to use to print 
the job—for example, 200 dot.
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7. When you measure the calibration chart, place it on the surface you 
prepared—for example, on top of the white paper.

8. When the calibration is complete, print the job using the calibration 
table, see “Printing the Job with the Calibration Table” on page 135.

Calibrating the X-Rite DTP34 QuickCal Densitometer
The X-Rite DTP34 QuickCal densitometer is a color measurement 
instrument that reports densitometer and dot data.

Perform the following steps before first time use of the densitometer:

• Familiarize yourself with the X-Rite DTP34 QuickCal Densitometer 
Operator’s Manual. 

• Connect the X-Rite DTP34 QuickCal densitometer

• Calibrate the X-Rite DTP34 QuickCal densitometer

Tip:  It is strongly recommended that you include the specific paper name and 
screen method in the calibration table file name. This helps you select the correct 
calibration table in the job setup.

You can also use the DTP34 Tutorial to learn how to use the densitometer 
correctly. Access the tutorial from Tools > Calibration, and then click 
Calibrate. In Step 1 of the Color Calibration wizard, click Densitometer 
Tutorial - Click & Learn.
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Connecting the X-Rite DTP34 QuickCal Densitometer to 
the Spire CXP50 Color Server

 

Before calibrating the X-Rite DTP34 QuickCal densitometer, make sure 
that you perform the following steps:

• Interface the X-Rite DTP34 QuickCal densitometer directly with one of 
the computer's serial ports

• Quit all programs and shut down the computer before you install 
interface cabling

Plug the power supply into an AC wall outlet and connect to the X-Rite 
DTP34 QuickCal densitometer communication cable. The LED indicates a 
variety of instrument operation conditions, such as calibration mode and 
operation. 

PC
Db9

MAC
Mini-DIN 8

Power Input

Mini-Din 8 Plug

SE108-94-02
Interface Cable

SE108-DB9PA-01
(Optional)

Note:  Verify that the Mini-Din 8 Plug is firmly seated, and that you hear a click 
sound. The connector is spring loaded and must be properly seated.

For a complete list of all conditions reported by the LED, see the X-Rite DTP34 
QuickCal Densitometer Operations Manual.
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Calibrating the X-Rite DTP34 QuickCal Densitometer

Frequency of Calibration

Your X-Rite DTP34 QuickCal densitometer should have a quick 
calibration at least once a day. A full calibration should be performed 
annually, during heavy usage to provide accurate measurements, or if the 
quick calibration consistently fails. Typically, the host computer prompts 
for an instrument calibration (amber LED) when required, but the process 
can be invoked manually at any time. See the following procedure for 
information about the calibration process.

Handling the Reflection Reference

Handle the reflection reference by the edges. Make sure that the reflection 
reference is free of dust, dirt, and smudge marks. To obtain the most 
accurate calibration, hold the instrument with consistent and nominal 
pressure during the calibration process.

Position the instrument on the designated location of the reflection 
reference (indicated by a dotted outline of the instrument). Do not move 
the instrument more than 0.25" (6.35mm) before reading the strip.

STATUS  X

DTP34-100   #:

X-Rite
Reflection Reference

C=  .XX

AXXXXXXXX-XXXXX  D:  XXX

M=  .XX Y=  .XX

R
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Quick Calibration
You can perform a quick calibration at any time. The only required action 
is to scan the reflection reference as you would with any other strip. You 
should only perform a quick calibration after a full calibration has been 
done. New densitometers are fully calibrated before leaving the factory.

1. Position the X-Rite DTP34 QuickCal densitometer on the reference as 
previously mentioned.

2. Press and click the button and scan the reference to the opposite end. 
Release the button. The LED should indicate green if the calibration 
was successful. If calibration fails (fast flashing amber LED), verify 
that the strip is clean and re-read.

3. Place the reflection reference in its protective envelope, and store the 
envelope away from light and heat.

Full Calibration

1. To manually invoke the calibration mode, press and hold the 
Instrument button for a minimum of three seconds. The LED slowly 
flashes amber when calibration is initiated.

2. Press and hold the button (if not previously held) and scan the 
reference to the opposite end. Release the button. The LED should 
indicate green if the calibration was successful. If calibration fails, (fast 
flashing amber LED), verify the strip is clean and re-read.

3. Place the reflection reference in its protective envelope, and store the 
envelope away from light and heat. 

Note:  If the host computer initiated calibration (amber LED), skip to step 2.
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Calibrating the Spire CXP50 Color Server

Setting the Color Calibration Method
The Spire CXP50 color server provides you with two color calibration 
methods:

• Target Calibration
This calibration method enables you to calibrate the Xerox DocuColor 
5000 digital press according to the following fixed, predefined density 
values:

The target calibration method ensures that the density values of the 
printed output do not exceed the predefined density values. The 
purpose of this color calibration method is to ensure consistency over 
time. 

• Auto Adjusted Calibration
This calibration method enables you to calibrate the Xerox DocuColor 
5000 digital press according to the printer’s performance capabilities.
With this method, you can set the maximum density of the printed 
output by selecting the desired percentage level. The higher the 

Table 10: Fixed density values for uncoated paper

Toner Density value

Cyan 1.85

Magenta 1.584

Yellow 1.104

Black 1.75

Table 11: Fixed density values for coated paper

Toner Density value

Cyan 2

Magenta 1.723

Yellow 1.162

Black 1.9
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percentage, the greater the density of the printed color.
The purpose of this method is to achieve optimal color intensity for a 
specific printer at a certain point in time.

The default setting for the color calibration method of the Spire CXP50 
color server is target calibration. You can change the setting, if necessary, 
before calibrating the Spire CXP50 color server.

To specify the calibration method:

1. In the Settings window, select Preferences > Color.

2. In the Calibration Method area, select the desired calibration method, 
Target or Auto Adjusted.

3. If you selected Auto Adjusted and you would like to change the 
default settings, click Advanced.
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The Auto Adjusted window appears.

4. Change the Percent of Printer Max Setup density if desired, by 
moving the slider, or by typing a percentage value in the 
corresponding box.

5. Click Save.

The Calibration Window
The Calibration window enables you to create and edit calibration tables. 
You can use the Color Calibration Wizard to create a calibration table, or 
edit an existing calibration table. 

The Color Calibration Wizard analyzes the measurements and creates 
calibration tables. Using these tables, the Spire CXP50 color server 
compensates for the difference between the printer’s performance and the 
required values.

The following calibration look-up tables are provided: 

• None: Applies no calibration table to the job.

• SpireNormal: Applies the factory default calibration table. Since this is 
a default look-up table, it cannot be overwritten. 

Note:  The default percentage value is 85%.

Important:  Changes to the calibration method during RIP will not take effect. 
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• SpireSaturated: Applies the factory default saturated calibration table. 
This look-up table applies a darker calibration table in comparison to 
the SpireNormal look-up table. Since this look-up table is a default 
table, it cannot be overwritten. 

• Normal: Initially the Normal look-up table is identical to the 
SpireNormal look-up table. This resemblance changes as soon as you 
calibrate your Spire CXP50 color server and, at the end of the 
calibration process, save your calibration table as default. Your 
calibration table is saved as the Normal look-up table. 

• Saturated: Initially the Saturated look-up table is identical to the 
SpireSaturated look-up table. This resemblance changes as soon as you 
calibrate your Spire CXP50 color server and, at the end of the 
calibration process, save your calibration table as default. Your 
calibration table is saved as the Saturated look-up table. 

To open the Calibration window:

1. From the Tools menu, select Calibration.

The Calibration window appears.

Note:  Each time you save a calibration table as default, it is saved twice, once 
as Normal look-up table, and once as the Saturated look-up table.
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The following options are available:

• Click Calibrate to run the Color Calibration Wizard. This wizard 
guides you in the use of the densitometer to create calibration tables, 
see “Creating a Calibration Table”, below.

• Select a calibration table from the Calibration Name list and select one 
of the following options: 

Click Edit  to edit the calibration table. See “Editing Calibration 
Tables” on page 129.

Click Delete  to delete the calibration table.

Click Info  for the Density Graph. See “Reading Color Density 
Data” on page 133.

Click Close to end a test job and close the Calibration window.

Creating a Calibration Table
1. In the Spire CXP50 color server application, from the Tools menu, 

select Calibration.

2. In the Calibration window, click Calibrate.

The Calibration Wizard window appears.
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The first step in the wizard is Print Calibration Chart. This step enables 
you to detect the point where you start to see toner on the paper. 

3. In the Tray list, select the desired input tray.

The default tray setting is Auto. When this option is selected, the 
wizard looks for a tray that contains Letter LEF or A4 LEF paper. If the 
wizard does not find a tray with either of these sizes, an alert appears.

You can print calibration charts on any size paper. Ensure that the 
desired paper is in one of the trays, and then select that tray in the 
wizard.

4. In the Screening Method list, select the desired screening method.

5. In the Paper Weight list, select the desired paper weight.

6. In the Paper Coating list, select the desired paper coating.

7. Set the number of copies you need by typing the number or using the 
arrows next to the box to select the number.

8. Click Print.

The Start Point Density calibration is printed.  

9. Collect the chart(s) from the printer.

Step 2 of the Color Calibration Wizard appears. In this step you scan 
the start point chart so that the wizard can measure each separation 
and find the point at which the toner appears on the paper.

Tip:  Click the Densitometer Tutorial - Click & Learn icon to display an 
animation of the measurement process and to learn how to use the 
densitometer correctly.

Note:  Make sure you set the screening method to the one you are going to 
use to print the job.

Note:  Since the performance of the Xerox DocuColor 5000 Digital Press is 
best after several pages have been printed, it is recommended that you print 
at least 10 copies of the first calibration chart and use one of the last copies 
printed.

Note:  If you selected Automatic as the Screening Method in Step 1 of the 
wizard, the Xerox DocuColor 5000 Digital Press prints two charts, an Image 
Density Calibration Chart and a Text/Line Art Chart.
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If you selected Automatic as the Screening Method in Step 1 of the 
wizard, you need to calibrate the Spire CXP50 color server using two 
charts. Step 2 of the Calibration Wizard appears as follows:
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10. While pressing down the button on the X-Rite DTP34 QuickCal 
densitometer, align the head with the cyan arrow’s tip. The arrow is to 
the left of the cyan column on the Image Density Calibration Curve. 
Its tip intersects the semi-dotted line.

11. Sweep the X-Rite DTP34 QuickCal densitometer over the cyan 
column. 

A beep sounds and a green light blinks when the scan is complete. A 
check mark appears over the cyan icon and instructions appear for the 
next sweep, this time for the magenta column.

12. After each color sweep, wait for the check mark to appear next to the 
appropriate icon and follow the instructions as listed.

When all of the separation columns have been successfully scanned, a 
check mark appears next to all icons.

Step 3 of the Color Calibration Wizard appears. 

Note:  Ensure that the separation columns on the chart are scanned in the 
order they appear in the icons: Cyan > Magenta > Yellow > Black.

Notes:

• If at any stage the scanning has not been completed properly, click 
Reset and scan again.

• If an error occurs while you are scanning the chart, an alert message 
appears. Click OK and re-scan the charts.

• If you selected Automatic as the Screening Method in Step 1 of the 
wizard, repeat steps 10-12 for the Text/Line Art chart.
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13. Select Save as and select the desired name for the calibration table. 
Type your own or select one from the list.
Or: 
Select As default table (Normal) to save the calibration table as 
Normal. 

Note:  Each time you save a calibration table as default, it is saved twice, once 
as the normal look up table, and once as the saturated look up table. The 
Spire CXP50 color server automatically overwrites the existing Normal and 
Saturated calibration tables.

Tip:  It is strongly recommended that you include the specific paper name and 
screen method in the calibration table file name. This helps you select the correct 
calibration table in the job setup.
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14. Click Finish. 

Regardless of the option you chose, two calibration tables are saved:

• Normal: A table that maintains the gray balance throughout the 
range of colors in the print job file

• Saturated: A table that is the same as the normal table for 80% of 
the color range but from that point on, each color has a greater 
density. You can use this table when you need dark colors that are 
more intense than in the normal table.

For example, if you name your Normal calibration table Tuesday23, 
the Saturated table is automatically named Tuesday23sat.

Editing Calibration Tables
You can review a calibration table to make sure that the curves are relatively 
smooth and continuous. If you are not satisfied with the results, the Edit 
option enables you to adjust the values of the image in the value table.

To edit a calibration table:

1. From the Tools menu, select Calibration.

2. In the Calibration Name box, select a calibration table, and then click 

Edit .
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The Edit Calibration window appears.

The Edit Calibration window includes the following:

• Screen—If you selected Automatic as the screening method, you can 
view two calibration tables, CT or LW. In the Screen list, select the table 
you want to view.

• Separation—The graph displays cyan, magenta, yellow, and black 
separations. You can see information about each separation by 
selecting it from the list. 

• Calibration Graph—The graph shows the values from your calibration 
table.

The horizontal axis represents the dot percentage values of the RTP file. 
The vertical axis represents the dot percentage values of the final output 
data (after applying the calibration table) that is sent to the printer. 

During printing, the Spire CXP50 color server automatically replaces 
the CMYK values in the RTP file with new values that compensate for 
the printer’s current performance level.
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The graph displays cyan, magenta, yellow, and black separations. You 
can view detailed information about each separation by clicking its 
button. To view the information for all the separations together, click 

the button that shows all four colors .

• Value Table

You can change the separation values by adjusting the File Value and 
Printer Value settings. The table displays some of the dot percentage 
values shown in the graph. You can add, edit, or delete entries in the 
table. Your changes will be displayed immediately in the calibration 
graph.

To add an entry to the value table: 

1. Highlight a row in the value table. The new entry row will appear 
below this row.

2. Click Add Entry . 

The Add Entry dialog box appears.

3. Select the desired values from the File Value and Printer Value lists.

4. Click OK. 

The value table is updated and the calibration graph is adjusted.

To delete an entry from the value table:

1. In the value table, highlight the entry to be deleted.

2. Click Delete Entry .

The entry is removed. 

Organizing Calibration Tables
You can use the Save and Save As functions to organize your calibration 
tables.
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To save an existing calibration table:

1. In the Edit Calibration dialog box, adjust calibration table values and 
parameters as desired.

2. Click Save.

The edited calibration table is saved with its original name.

To save a new calibration table:

1. In the Edit Calibration dialog box, adjust calibration table values and 
parameters as desired.

2. Click Save As. 

The Save As dialog box appears.

3. In the File Name box, type the new calibration table name.

4. Click OK. 

The calibration table is saved with the new name. 

5. Click Close to exit the Edit Calibration dialog box.

Note:  When you click Save, new calibration settings override previous 
calibration table settings.

Note:  You can’t overwrite the default calibration tables, Spire Normal and 
Spire Saturated.

Note:  To edit a calibration table, select Tools > Calibration > Edit. To view 
information about a calibration table, select Tools > Calibration > Info.
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Backing Up Calibration Tables
1. Locate the ColorCalibrationDB folder, following the path 

C:\CXP50\General\ColorCalibration\ColorCalibrationDB.

2. Open the ColorCalibrationDB folder.

3. Copy the desired calibration table files to your backup location. 

Reading Color Density Data

To view the Density Graph:

1. In the Calibration window, from the Calibration Name list, select the 
table for which you want to receive detailed color information.

2. Click Info . 

The Density Graph appears. The Density Graph gives you detailed 
information about the saved calibration tables.
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The Density Graph contains the following data:

• Calibration name

• Measured D-Max values for each separation

• Target D-Max values for each separation 

• Minimum accepted density values for each separation (Xerox values) 

• View options: filtering by color - select which colors are shown/hidden

• Calibration curves (target and measured) for each separation

Target is displayed as bold lines

Measured is displayed as thin lines

• Index - emphasizes the difference between target lines and measured 
lines



Calibration 135

• Properties: paperweight, screening, paper coating 

Printing the Job with the Calibration Table
Now that you have calibrated using the paper you are going to use for 
printing, you can select the calibration table to print any job on the same 
paper stock using the same screen type. You can print the reference job you 
printed before with the new calibration table to evaluate the calibration 
results.

To print the reference job:

1. In the Spire CXP50 color server workspace, suspend the Process 
Queue.

2. Import the job.

3. Double-click the job to open the Job Parameters window.

4. In the Paper Stock tab, select the desired paper stock.

5. On the Color tab, select the calibration you created for the particular 
stock from which you printed. 

6. In the Color tab, select the screening method you used for the selected 
calibration.

7. Set all other desired parameters, and then click Save to close the Job 
Parameters window.

8. Activate the process and print queues, and inspect the printed job.

If you see that the print out has any color imperfection, review the job 
parameter settings and make changes if necessary. If there are still color 
imperfections, perform machine maintenance and repeat the calibration 
process.

Note:  When the density of the Xerox DocuColor 5000 digital press is lower 
than 80% of the target density, the following message appears: 
“Attention: Below standard D-Max value(s) measured for <cyan, 
magenta, yellow, black>. Standard (Minimum): <C - 1.5>, <M - 1.4>, 
<Y - 0.9>, <K - 1.5>
Measured: <C - >, <M - >, <Y - >, <K - >”.

For more information about the Color tab, see “Default Color Flow” on 
page 136.
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Default Color Flow
Job color parameters are located in the Job Parameters window > Color tab. 
The Color tab provides you with tone compression tools such as 
brightness, contrast, and gradation, as well as color tools, including 
rendering intent, ink saving, and RGB and CMYK Workflow. In addition, 
you can select various screening methods for your job.

The tone compression tools and screening methods—Gradation, 
Brightness, Contrast, and Calibration—can be applied to your RTP jobs 
without requiring the Spire CXP50 color server to re-RIP the jobs. The 
color tools—Destination, Rendering Intent, Emulation, RGB Workflow, 
and Spot Color Editor—should be applied prior to initial RIPing or your 
job will need to be re-RIPed. 

The Spire CXP50 color server supports the following color formats:

• RGB

• CMYK

• L*a*b* color space

• Spot color

• Grayscale

• Duotone

To submit jobs for color adjustment on the Spire CXP50 color server:

1. Import the job to the Spire CXP50 color server workspace.

2. Double-click the job in the Storage window.

3. Select the Color tab in the Job Parameters window.

The Color tab enables you to apply last-minute color corrections, or to 
set the output job to align with other output devices.

4. Adjust the desired color parameters. See the relevant parameter in the 
Color tab.
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5. Click Submit to send your job to print. 

The job is processed on the Spire CXP50 color server and sent to the 
Xerox DocuColor 5000 digital press for printing.

Color Tools

Profile Manager
The Profile Manager enables you to import and delete source and 
destination ICC profiles, and map destination profiles to specific paper 
colors.

Source profiles are used to emulate other devices, or color spaces. You can 
import source CMYK or RGB profiles. To use a profile in a job, in the Job 
Parameters window, select Color > RGB workflow or Color > CMYK 
workflow > Emulation, depending on the profile you imported. 

Destination profiles define the color space of your printer and are based on 
the combinations of paper and toner that you are using. For different 
paper stocks, you need different destination profiles. Each custom 
destination profile will be used with coated and uncoated paper. To use a 
different destination profile in a job, in the Job Parameters window, select 
Color > Destination profile.

Note:  You can also use a virtual printer to adjust job parameters.

For more information about submitting jobs to the Spire CXP50 color server, see 
“Importing and Printing a Job” on page 28.

Custom source RGB profiles are not available in the CSA emulation mode.

For more information about selecting a source profile in a job, see “RGB 
Workflow” on page 226 and “CMYK Workflow” on page 226.

For more information about selecting a destination profile in a job, see 
“Destination Profile” on page 228.
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After you import a destination profile, you can use the Media Color 
Mapping dialog box to map the profile to a paper color. The profile is 
linked to the paper color and the Spire CXP50 color server will 
automatically select the correct profile for your job. This is useful—for 
example, in jobs that have mixed paper types. Select Linked from Color > 
Destination profile.

To import a source ICC profile:

1. On the toolbar, click the Resource Center button . 

The Resource Center opens.

2. In the Resource list, select Profile Manager.

The Source Profile tab appears and the predefined source ICC profiles 
are displayed.

3. Click the Import button .

The Import Source ICC Profile dialog box appears.
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4. In the Source profile area, click the browse button . Locate and 
select the desired source profile, and then click Open.

The new emulation name is displayed in the Emulation name box; you 
can change the name if you want.

5. Click Import.

The new source ICC profile is added to the Emulation (Device Link) list 
in the Job Parameters window, to either the CMYK Workflow 
parameter or the RGB workflow parameter. 

To import a destination ICC profile:

1. In the Resource Center > Profile Manager, select the Destination 
Profile tab.

The predefined ICC profile is displayed.

For more information on destination profiles, see “Destination Profile” on 
page 228.
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2. Click the Import button .

The Import Destination ICC Profile dialog box appears.

3. In the Destination profile area, click the browse button . Locate 
the desired source profile, and then click Open.

The new emulation name is displayed in the Emulation name box; if 
you would like to change the name you may do so.

4. Click Import.

5. If you would like to set the imported destination as your default, select 
it and click Make Default.

6. To map ICC profiles to specific paper colors:

a. Click Color Mapping.

The Media Color Mapping window appears.

b. In the Profile column, select the desired profile for each paper 
color.
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c. To add a new paper color, click the Import button .

d. In the Add New Color box, type the name of the new color and 
click OK.

e. To delete a paper color, select the desired paper color and click the 

delete button .

f. In the message that appears, click OK.

g. In the Media Color Mapping dialog box, click Close.

To delete an ICC Profile:

1. In the Resource Center > Profile Manager, select the profile you would 
like to delete.

2. Click the delete button .

The profile is deleted from the profile list.

Spot Color Editor
You can use the Spot Color Editor to edit colors in the spot color 
dictionary, and to define specific RGB, grayscale, or CYMK colors that you 
want to protect.

Note:  If you don’t map a destination profile to a paper color, the Spire 
CXP50 color server uses the default profile, which is for white paper.

Note:  You cannot delete predefined ICC profiles.
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Editing the Spot Color Dictionary
Individual job pages can contain continuous tone (CT), line work (LW), 
and spot color elements. The Spire CXP50 color server Spot Color Editor 
enables you to edit the CMYK values of every spot color in the spot 
dictionary without affecting the CT or LW page elements. The Spot Color 
Editor also enables you to create custom spot colors and to define fixed 
CMYK values for those spot colors. The Spire CXP50 color server supports 
HKS and PANTONE 2000 spot colors.

To edit a PANTONE color:

1. From the Tools menu, select Spot Color Editor.

The Spot Color Editor window opens on the Spot Editor tab, with the 
Spire CXP50 color server's entire collection of colors listed.

Note:  Spot colors—for example PANTONE spot colors—are not affected by 
CMYK emulation. A spot color has the same appearance with any selected 
CMYK emulation.
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2. Under Color, search for a particular color.

3. Alternatively, from the Spot dictionary list, select the color dictionary 
that contains the color you want to edit.

4. Select the desired spot color. 

The CMYK values for that spot color and a color preview appear on 
the right-hand side of the Spot Color Editor window.

5. Change the CMYK values as desired.

6. Click Apply. 

The new spot color is added to the custom color dictionary.

To create a new spot color:

1. In the Spot Color Editor window, click the add button.

The Spot Color Editor dialog box appears.

Note:  When you are searching for a color, you can type the first letter of the 
first word in the search. For example, if you are searching for Cool Gray 4 
and type cool, the mouse pointer locates the first color in the list that 
begins with the letter c.

Note:  Use the PANTONE CV dictionary if you are working in QuarkXPress 
software.
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2. Type the new spot color name as it appears in the PostScript file. 

3. Adjust the CMYK values as desired.

4. Click OK. 

The new spot color is added to the custom dictionary.

To delete a spot color (from the custom dictionary only):

1. From the Spot dictionary list, select Custom Dictionary. 

2. From the list of custom colors, select the spot color that you want to 
delete.

3. Click Delete.

The following message appears.

4. Click Yes to delete the spot color.

Protecting Specific Colors
Using the Spot Color Editor, you can protect specific colors—for example, 
official logos or company colors—to help produce color fidelity and color 
consistency between devices. When you define a specific color as an RGB, 
gray, or CMYK spot color, and enter a fixed CMYK target for it or align it 
to a predefined spot color, the Spire CXP50 color server treats it as a spot 
color, protecting it accordingly.

To define an RGB color as a spot color:

Note:   Spot color names are case sensitive. Ensure that the new name is 
identical to the name that appears in the DTP software.

Note:  The RGB spot workflow applies only to LW elements.
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1. In the Spot Color Editor window, click the Protect RGB tab.

2. Click the add button.

3. In the Color name box, type a name for your color.

4. Type the RGB source values and the CMYK target values, or select a 
spot color from the list.

5. Click Save.
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6. On the Protect RGB tab, select the color.

The color information appears.

7. If necessary, in the Corrected column adjust the CMYK values.

8. Click Apply.

To define a grayscale color as a spot color:

1. In the Spot Color Editor window, click the Protect Gray tab, and follow 
the procedure for defining RGB colors as spot colors.

2. In the Protect Gray dialog box, enter the gray source value.
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3. Continue to follow the procedure for defining RGB colors as spot 
colors.

To define a CMYK color as a spot color:

1. In the Spot Color Editor window, click the Protect CMYK tab, and 
follow the procedure for defining RGB colors as spot colors.

2. In the Protect CMYK dialog box, enter the CMYK source value.

3. Continue to follow the procedure for defining RGB colors as spot 
colors.



148  Chapter 6 – Color Workflow

Gradation Tool
Sometimes you need to perform tone corrections when printing a job. 
Gradation changes can include brightness, contrast, and color balance 
adjustments throughout the tone range of an entire image, or in specific 
tone ranges. 

The Gradation tables that you create using the Gradation tool are added to 
the gradations list in the Color tab, and may be applied to print jobs. The 
Spire CXP50 color server also enables you to visually check the effect of 
different gradation adjustments on RTP jobs prior to printing.

Using the Spire CXP50 color server Gradation tool, you can apply the 
default gradation table or another pre-configured gradation table to a job. 
You can also edit an existing table and save your changes. Gradation is an 
interactive function and changes are automatically applied to the displayed 
image.

The Gradation tool is used to create and edit gradation tables and to check 
the effect of different gradation adjustments on specific RTP jobs. These 
tables can then be applied to your jobs during job processing for tailored 
gradations.

To open the Gradation tool:

From the Tools menu, select Gradation.

The Gradation dialog box appears.

Preview 

Note:  You can edit an existing gradation table, but you cannot overwrite the 
default gradation table, DefaultGradTable.

Notes:

• Gradation is an interactive function. Gradation changes are automatically 
applied to the displayed image.

• The gradation table created is not automatically applied to the previewed 
job. You must use job parameters to assign a gradation table to a job.
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To preview a job:

1. Click Browse to select a job for display in the Preview window. 

The Processed Jobs window appears. The jobs that are displayed are 
the RTP jobs listed in the Storage window.

2. Select the job you wish to preview, and then click Open.

The job appears in the Gradation dialog box.
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Editing Gradation Tables
When you open the Gradation Tool window, the default gradation table, 
DefaultTable, is selected in the Gradation Table list, and is displayed in the 
graph. This table serves as a baseline and consists of a 45° gradation curve, 
with Brightness and Contrast set to 0, and Contrast Center set to 50. All of 
the color separations are selected.

Gradation tables that you create also appear in the Gradation Table list. 
When you select a gradation table for a job (see “Gradation” on page 230), 
the predefined settings are immediately applied to the processed job that 
you are working with.

The separations buttons enable you to select one, all, or any combination 
of separations to edit for a specific gradation table. Selecting a specific 
separation enables you to change the color balance for a specific tonal 
range.

When you open the Gradations Tool window, all of the separations are 
selected.

1. Do one of the following:

• Click the All Colors button  to edit all the separations 
simultaneously.

• Click the individual separations you wish to edit—for example, 
select the cyan separation only.

2. Click the curve in the graph to add a point, and then drag the point to 
modify the separation. When you select a point, its value appears in 
the Input or Output boxes. You can add multiple points to the curve in 
the same way. Drag the point(s) to the desired location(s).

The Input axis represents the tone values of the image before gradation 
changes. The Output axis represents the tone values of the image after 
gradation changes.

3. To view gradation changes in your job, click Refresh. Changes are 
automatically applied to the displayed image in the After view.

4. To remove a point on the curve, select the point and then click 
Remove.
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5. To reset the gradation curve to a 45° curve, click the individual 

separation and click the Reset button .

6. To revert to the original gradation settings, click Revert.

7. To remove the last change you made to the gradation graph, click 
Undo.

Creating a New Gradation Table
1. In the Gradation Tool window, modify your gradation table as desired.

2. Click the Save button . 

3. In the Table name box, type the desired name for the new gradation 
table, and click OK. 

The gradation table is saved and added to the Gradation Table list and 
to the Color Modes tab in the Job Parameters window.

Deleting a Gradation Table
1. Select the gradation table in the Gradation Table list, and then click the 

Remove button .

2. In the confirmation message, click Yes.

Navigation Buttons

The navigation buttons enable you to select a specific booklet or page to 
view, and to browse the pages of the current job. 

Note:  You cannot delete the predefined gradation table.
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Using the Preview Tools
The preview buttons enable you to switch the display mode in the original 
and edited views.

Table 12: Preview Buttons

This button: Enables you to:

Pan

View a different area of the image

Eye Dropper

Find out the CMYK values of a specific area 
on the page. To find the values, first click the 
Eye dropper button. Then move the pointer 
to the point on the page where you want to 
measure the color values and click. The 
CMYK values appear as a tool tip.

Zoom In

Magnify the selected area of the page

Zoom Out

Reduce the size of the selected area by 50%

One to One Zoom

View the actual size of the page one to one 
(1:1)

Fit to Screen

Scale the page to fit the available screen space

View the image at different preset levels of 
magnification by selecting a percentage in the 
list

Rotate View

Rotate the page by 90°, 180° and 270°

Show/Hide 
Separation

Turn on or off one or more separations
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Brightness and Contrast Slider Controls
The Brightness and Contrast slider controls are active only when all of the 
separations are selected.

Brightness

Brightness increases or decreases the luminance of the image. Increasing 
brightness brightens the image and results in a concave curve. Decreasing 
brightness darkens the image and results in a convex curve. 

Move the Brightness slider to the right to increase brightness or to the 
left to decrease brightness.

Contrast

Contrast increases the image contrast by making the highlights lighter and 
the shadows darker. It can also be used to decreases the contrast.

Move the Contrast slider to the right to increase contrast (S shaped 
curve), or to the left to decrease contrast (inverted S shaped curve).

Before/After view

Toggle between the Before and After views

Before/After view

View the Before and After views in portrait

Before/After view

View the Before and After views in landscape

This button: Enables you to:
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Contrast Center

Contrast increases the image contrast mainly in the midtones. Using 
Contrast Center, you can adjust where the contrast is increased. To 
enhance contrast in highlights, the Contrast Center is shifted toward the 
highlights. To enhance contrast in shadows, the Contrast Center is shifted 
toward the shadows.

Set the image contrast, by adjusting the Contrast slider.

Your change affects the gradation graph by moving the point where the 
curve changes from convex to concave.

Organizing Gradation Tables
The Gradation window provides a number of options for organizing 
gradation tables, including Reset, Save, Delete, and Save As.

If you work only with the default gradation table, the Reset and Save As 
options are activated. These options enable you to use the default 
gradation table as a base on which to build and save new gradation tables. 
When you work on gradation tables other than the default table, the Save 
and Delete options are also active.

To reset all Gradation window settings, click Reset. 

The gradation curve is reset to a 45° line. 

To delete the selected gradation table, click Delete. 

To save the specified gradation settings, click Save.

To create new gradation tables by saving existing gradation tables with 
new names, click Save As.

Note:  Contrast Center only affects the image if Contrast has also been 
adjusted.

Note:  You can not delete the DefaultGradTable.

Note:  You can only save the default gradation table under a new name.
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VI Overview
Variable information (VI) jobs are jobs in which the printed materials are 
individualized for specific recipients or purposes. These materials can 
include bills, targeted advertising, and direct mailings.

VI jobs are composed of booklets, which are personalized copies of a 
document. A booklet can consist of one or more pages, with the entire 
document targeted at a specific individual or address. For example, a 
booklet can be either a single-page gas bill or a multi-page personalized 
document.

Each page in the booklet is constructed as a collection of individually 
RIPed elements that may differ from booklet to booklet, including text, 
graphics, pictures, and page backgrounds. These elements are self-
contained graphical entities that may be line art, text, RIPed images, or a 
combination of these. There are two types of elements in VI jobs:

• Unique elements that are used only once for a specific individual or 
purpose. For example, an individual’s name.

• Reusable VI elements can be used more than once in different pages, 
booklets, or jobs. A company logo is an example of a reusable element.

On the Spire CXP50 color server, each element, text, graphic, picture, or 
page background is RIPed only once, whether the element is used once, 
several times, or on every page of the VI job. Elements that are used more 
than once are cached for further use. If you have the Spire CXP50 color 
server with the Professional Kit, you can manage these elements in the 
Resource Center Cached VI Elements area. Each set of elements associated 
with a particular job is assigned a unique name. Inline variable elements 
that are used only once, usually text, are not cached. 

Pages are assembled from the pre-RIPed reusable elements and the RIPed 
unique elements just before printing. Then the job is printed in the same 
way as all other jobs in RTP format.

Whenever a VI or PS job is imported to the Spire CXP50 color server, its 
page size is automatically recognized. The page size is displayed in the Spire 
CXP50 color server Job Parameters window.

For more information about cached VI elements, see “Managing VI Elements” 
on page 164.
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VI Document Formats
VI jobs are created using VI authoring software that support Variable Print 
Specification and VIPP formats. Most VI authoring software can convert 
VI files to conventional PS files, which can also be processed by the Spire 
CXP50 color server, although less efficiently than Variable Print 
Specification and VIPP files. Each authoring software creates VI code that 
instructs the RIP where to place the VI elements and each authoring 
software does so in a slightly different manner.

The format you choose can be a stand-alone format that covers all aspects 
of document design, data management and text capture or it can be an 
extension of an existing software that enables the creation of VI documents 
and VI jobs.

The Spire CXP50 color server can process VI jobs that are in one of the 
following file formats:

• Creo Variable Print Specification

• Xerox Variable data Intelligent Postscript Printware (VIPP)

• Personal Print Markup Language (PPML)

• PostScript

Note:  Variable Print Specification, VIPP, and PPML elements are displayed in the 
Resource Center under the Cached VI Elements area (only). 
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Creo Variable Print Specification
Creo Variable Print Specification is the Creo developed formal language 
designed for effective production of VI documents.

Creo Variable Print Specification is comprehensive and can specify a 
complete range of VI documents. It also provides the means for efficient 
implementation—fast and efficient data processing, and storage prior to 
printing.

A Variable Print Specification job consists of the following components: 

• Booklet
A personalized copy of a document within a single print run where 
pages and/or elements within a page may vary from booklet to booklet.

• Sub-job
All copies of a particular document—for example, book, brochure, or 
flyer—within a single print run. On the Spire CXP50 color server, sub-
jobs can be deleted, archived, or reprinted at any time. However, you 
can still maintain reusable elements for future runs. Reusable elements 
are cached elsewhere, so only the unique data, which is embedded in 
the job, is deleted.

• Reusable Elements
Self-contained graphical entities that can be line art, text, raster images 
or a combination of these types. Reusable elements are represented in 
PostScript and can be stored as EPS files when appropriate. Reusable 
elements include clipping and scaling instructions as well as the image 
data.

Reusable elements can be used repeatedly in different pages, booklets 
and jobs. On the Spire CXP50 color server, all reusable elements are 
processed once and cached as RTP elements for further use. They can 
be reused either within the sub-job itself, or in additional runs of 
sub-jobs.

• Inline Elements 
Unique information is drawn from a database and is embedded in the 
sub-job. This data prints only once for individual booklets.

Note:  Grayscale TIFF and EPS images that are created in CMYK applications 
(such as Adobe Photoshop) are counted correctly as B&W instead of Color in 
both the Spire CXP50 color server and the Xerox DocuColor 5000 digital 
press billing meters.
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VIPP 
VIPP is a PostScript-based format that merges the VI pages during the 
processing stage. VIPP is mostly used with financial software, using the 
dynamic graph-charting capability of VIPP for bank statements, telephone 
bills, electric bills, and so on.

Whenever a VI job is imported to the Spire CXP50 color server, the file 
type and number of pages per booklet are automatically recognized and 
shown.

VIPP jobs are composed of the following four files:

Note:  To use VIPP files on your Spire CXP50 color server, first install the VIPP 
software on your system. This installation should be done by a service engineer. 
Contact your service provider for more information.

Table 13: VIPP files

File Name File Description

File.PS The PostScript Master Form, which 
contains all of the fixed elements from the 
original document.

File.JDT The Job Descriptor Ticket, which contains 
header and setup information for the job.

File.DBM The Database Master, which contains the 
VIPP coding.

File.DBF The Database File, which contains all the 
ASCII data to be merged. It should include 
database information taken from the range 
of database records that were specified in 
the DataMerge dialog.
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VIPP software creates xgf and xgfc folders on your system. Within the xgfc 
folder, a number of sub-folders are created. Table 14 lists in which 
sub-folders you should store VIPP job files.

To print a VIPP job:

Import the *.DBF file to the Spire CXP50 color server. 

The VIPP job is processed and printed. 

VIPP 2001 and PPML
The PPML format is a new XML-based industry standard that 
print-technology manufacturers developed for the high-speed production 
of reusable page content.

The Spire CXP50 color server supports VIPP 2001 and PPML formats. 
Some of the features that are included enable you to:

• Process VIPP 2001 and PPML jobs efficiently

• Manage VIPP 2001 and PPML reusable elements

• Import jobs in various VI formats to the Spire CXP50 color server 

• Import VI elements to the Spire CXP50 color server and submit them 
for pre-cache

• View VI elements in their structural hierarchy

Both PPML and VIPP 2001 have a hierarchical structure. Document 
components are separated from their submission file and can be organized 
and stored in different levels of the hierarchical structure.

Table 14: VIPP sub-folders

File Name Store in VIPP Sub-folder

File.PS formlib

File.JDT jdtlib

File.DBM formlib

File.DBF mislib

Variable Image Files imglib
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In PPML, you can store different jobs in one PPML file. Thus, the display 
in the navigation pane varies from the way Variable Print Specification and 
VIPP appears. 

You can print a booklet range within a PPML file.

PostScript Files
PostScript files are suitable for simple, very short run jobs. All page 
elements are re-RIPed for each page. These jobs do not use a VI authoring 
tool. Instead, they use a mailmerge function in a Microsoft Word document 
or a Microsoft Excel spreadsheet.

Using Creo Variable Print Specification to Print a 
VI Job

The Spire CXP50 color server first searches for high-resolution files in the 
input folder that contains the PDL file, and then in the predefined APR 
path—D:\Shared\High Res. The Spire CXP50 color server will look for VI 
images in these locations when it RIPs the job.

To print a VI job:

1. Copy VI graphic elements to one of the defined APR folders on the 
Spire CXP50 color server. 

2. Submit your job to the Spire CXP50 color server.

Reusable elements are identified, processed, and placed in the Resource 
Center Cached VI Elements area (this area is available only for users with 
the Spire CXP50 color server with the Professional Kit). They are ready for 
rapid assembly into pages and for reuse during the printing stage.

Note:   You can also define a custom path to any connected server or disk. For 
more information about adding an APR path, see “High-Resolution Workflow” 
on page 84.

For more information about how to import files, see “Importing and 
Printing a Job” on page 28.
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Your VI job is processed and printed on the Spire CXP50 color server. The 
Xerox DocuColor 5000 digital press prints RTP booklets at full engine 
speed working uninterrupted from the printer disk. Booklets are compiled 
concurrently while the printer prints. As pages are sent to the print engine, 
they are assembled from the various inline and reusable elements 
on-the-fly.

After the job is completed, an RTP job is placed in the Storage window. 
This RTP job contains the complete variable job including all booklets, 
variable images, and unique elements.

Useful VI Print Options

Gallop
The Gallop parameter on the Print Settings tab enables the Spire CXP50 
color server to RIP and print VI jobs concurrently. Large jobs do not have 
to be RIPed entirely to disk before printing. You can predefine the number 
of pages to be processed before the engine starts to print. As soon as these 
pages are processed, printing starts while the rest of the job is streamlined 
through the Spire CXP50 color server. The Xerox DocuColor 5000 digital 
press continues printing at its rated speed without interruption or slowing 
down until the job is finished.

Notes:

• If an element is to be used more than once but with different clipping or 
scaling parameters, it is treated as a new page element and processed again.

• The cache is kept intact until the job is completed. This enables you to reuse 
RIPed elements anywhere in the job. Elements may remain in the cache for 
subsequent jobs. You can also archive job elements.

• Deleting a job does not delete the cached job sub-folder. This must be done 
manually in the Resource Center.

For more information about setting the Gallop option, see “Gallop” on 
page 218.
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Job Deletion
When you are printing a large VI job that takes up a substantial amount of 
the Spire CXP50 color server disk space, it is recommended that you use 
the Job Deletion parameter.

Imposition
When you impose VI jobs:

• Every booklet must have the same number of pages 

• When you use the Step & Repeat method to print a single page 
booklet, the VI job does not print the same image repeatedly. Several 
booklets are printed on the same sheet and each record is printed on 
the sheet once.

For a booklet with several pages, the pages are printed in order along 
the length of the sheet. The next booklet is printed beside the first. After 
the sheets are cut, the booklets are aligned with their pages in the 
proper order.

For more information about setting the Job Deletion option, see “Job 
Deletion” on page 238.
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Managing VI Elements

When the Spire CXP50 color server processes your VI job, it stores the 
reusable VI elements in a specific location. When the job is printed, the 
RIP engine looks for the VI elements in that location and reuses the 
elements when necessary. The VI elements can also be reused in future 
jobs.

In the Resource Center, use the Cached VI Elements area to manage the VI 
elements on your system and to perform the following tasks:

• Delete VI elements

• Archive VI elements

• Retrieve VI elements

Note:  The above example uses the step and repeat method. There are no 
special considerations for VI jobs using saddle stitch and perfect bound 
methods.

For more information about setting Imposition parameters, see “The 
Imposition Tab” on page 231.

Note:  You can only manage VI elements if you have the Spire CXP50 color server 
with the Professional Kit.
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Deleting VI Elements
VI elements that are no longer in use take up valuable disk space on the 
Spire CXP50 color server. To free up disk space, you can delete the VI 
elements you no longer need.

1. On the toolbar, click Resource Center . 

2. In the Resource list, select Cached VI Elements.

Your VI jobs are listed in the left pane. In the right pane, you can see all 
of the VI elements that are associated with your job. In addition, a 
thumbnail viewer lets you check elements visually.

3. Select the element that you want to delete, and then click Delete.

Note:  You can also delete the entire folder.
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Archiving VI Elements
If you have finished printing a large VI job and you know that you will 
need to reprint it in the future, it is a good idea to archive the VI elements 
and retrieve them when needed. You can archive your VI job folder in a 
location that you specify.

1. On the toolbar, click Resource Center . 

2. In the Resource list, select Cached VI Elements.

3. Select the VI folder in which to archive, and then click Archive.

The Open dialog box appears.

4. Find the location in which to archive your VI elements, and then click 
Archive.

Retrieving VI Elements
When you need to reprint your job, you can retrieve the VI elements from 
the archive.

1. From the Job menu, select Retrieve from Archive.

The Open dialog box appears.
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2. Select the folder in which your VI elements are archived.

3. Select the desired file and then click the add button .

4. Click Retrieve.

The Spire CXP50 color server retrieves the archived VI elements and 
displays them at the end of the file list in the Cached VI elements dialog 
box.

Note:  Use SHIFT or CTRL to select several files or CTRL+A to select all the files. 
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Setting Up and Configuring the Spire CXP50 Color 
Server

Basic system configuration and settings are defined in the Spire CXP50 
color server Settings window. The Settings window contains items that 
enable you to manage your system.

To open the Settings window:

From the Tools menu, select Settings.

The Settings window appears. The settings are divided into two lists: 
Administration and Preferences. 

• Administration: All users can view these settings, but only an 
administrator can configure the settings. 

• Preferences: All users can view these settings, but only users of 
Administrator and Operator user levels can configure the settings. 

To save changes in the Settings window:

In the Settings window, click Save.

Note:  If you log on to the Spire CXP50 color server as a guest, the Settings 
window is unavailable.
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Server Setup

Changing the Server Name
1. In the Settings window, select Server Setup.

2. In the Server Name area, click Change.

The System Properties dialog box appears.
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3. On the Computer Name tab, click Change.

The Computer Name Changes dialog box appears.

4. In the Computer name box, type a new name for the computer. 
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5. If you want to change the Workgroup or the Domain in which your 
computer appears, select the desired option and type a new name in 
the corresponding box.

6. Click OK.

7. Click OK in the System Properties window.

The system prompts you to restart your computer for the new settings 
to take effect. 

8. Click No if you want to change other system parameters, or click Yes 
and restart your computer.

Changing the Date and Time
1. In Settings window, select Server Setup.

2. In the Date & Time area, click Change.

The Date and Time Properties dialog box appears.

3. On the Date & Time tab, select your local time settings.

Note:  Do not change the workgroup or domain unless you are instructed to 
do so.

Important:  If you want to change the domain, you are required to type 
the password for the domain account. If the password is unavailable, the 
computer is locked.
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4. Select the Time Zone tab and set the correct time zone.

5. Click OK.

Network Setup
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IPX Printing
IPX Printing enables the Spire CXP50 color server to act as a job server for 
the Novell queue. A job server checks each assigned queue at a specified 
interval, taking care of jobs on a first-in, first-out basis. Once a job is 
processed, its associated file is deleted from the queue directory.

To set the Spire CXP50 color server IPX parameter:

1. In the Settings window, select Network Setup.

2. In the IPX Printing area, click Change Settings next to the Tree 
parameter.

The Local Area Connection Properties dialog box appears, followed by 
the NWLink IPX/SPX Properties dialog box.

3. To change the frame type, select a frame type from the Frame type list 
and click OK.

4. Click OK also in the Local Area Connection Properties window.

You are prompted to restart your computer. 

5. Click No if you need to make more changes, or Yes to restart.

Note:  Using this procedure requires further setup by the network administrator.
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TCP/IP Setup
The Spire CXP50 color server is predefined with a default IP address. The 
TCP/IP option enables you to change this IP address and other TCP/IP 
settings.

To change the TCP/IP network settings:

1. In the Settings window, select Network Setup.

2. In the TCP/IP area, click Change Settings next to the IP Address 
parameter.

The Local Area Connection Properties dialog box appears, followed by 
the Internet Protocol (TCP/IP) dialog box.

3. To change the IP Address, do one of the following:

• Select Obtain an IP address automatically.

• Select Use the following IP address and type the desired address—
for example, IP address:192.168.62.1 and Subnet 
mask:255.255.255.0, and enter the default gateway.

4. Click OK.

Note:  Before changing the network settings, consult your System Administrator.
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5. Click OK in the Local Area Connection Properties window.

You are prompted to restart your computer. 

6. Click No if you need to make more changes, or Yes to restart.

AppleTalk Setup
The AppleTalk Setup utility enables you to change the AppleTalk zone in 
which your Spire CXP50 color server is located.

To change the AppleTalk network settings:

1. In the Settings window, select Network Setup.

2. In the Apple Talk Setup area, click Change Settings next to the The 
System will appear in zone parameter.

The Local Area Connection Properties dialog box appears, followed by 
the AppleTalk Protocol Properties dialog box.

3. From the zone list, select the desired AppleTalk zone for your 
computer, and click OK.

4. In the Local Area window, click OK.
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Remote Tools Setup
The Remote Tools Setup parameter includes setup for the Remote Admin 
tool and enables the connection of clients to the Spire CXP50 color server 
over the network using the Spire Web Center.

Remote Admin
The Remote Admin utility enables the system administrator to connect, 
view, operate and perform administration actions on the Spire CXP50 
color server from a client workstation. While this remote connection and 
operation takes place, the regular operation of the Spire CXP50 color 
server is not affected. In fact, the only indication the Spire operator has that 
such connection takes place is in the server icon in the workspace status 
panel.

The following graphic shows the server and printer icons as they appear 
when the remote session is active (for administrator only).
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To secure the remote connection, a password should be assigned by the 
system administrator. 

The remote admin setup process includes the following stages:

1. On the Spire CXP50 color server, the remote admin service is enabled 
and a password is assigned.

2. On the System Administrator’s station, the client software is 
downloaded and launched.

To enable the remote admin service and set a password:

1. In the Settings window, select Remote Tools Setup.

2. In the Remote Tools Setup area, select Enable RemoteAdmin Service.

3. In the Password box, type a password.

4. Click Save.

To download and launch the Remote Admin Client software:

1. From the system administrator workstation, connect to the desired 
Spire CXP50 color server. From the Utilities folder, in PC Utilities, 
double-click SpireRemoteAdmin.exe.

When the installation is complete, the Login window appears.

Note:  This tool is designed for the exclusive usage of the system administrator. 
Clients who would like to connect to the Spire CXP50 color server from their 
workstations may do so by using the Spire Web Center, which enables you to 
view and monitor your jobs in the Spire CXP50 color server queues.

For more information about viewing and monitoring your jobs from a client 
workstation, see “Spire Web Center” on page 73.

Note:  This password will be used later to connect to the Remote Admin 
software from the system administrator workstation.

Tip:  You can also download the software from the Spire Web Center. 
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2. From the Spire Server list, select the desired Spire CXP50 color server.

3. Click OK.

The next Login window appears.

4. In the Session password box, type the password that you created in 
the Remote Tools Setup window.

5. Click OK.

The Spire CXP50 color server workspace appears on your screen.

Web Connect Setup
The Web Connect Setup enables clients to connect to the Spire CXP50 
color server over the network by using the Spire Web Center. This option is 
disabled by default.

To enable web connections:

1. In the Settings window, select Remote Tools Setup.

2. In the Web Connect Setup area, select Enable Web Viewer.

For more information about viewing and monitoring your jobs from a client 
workstation, see “Spire Web Center” on page 73.
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Security

User Passwords
The system administrator assigns each user an access level, as follows:

• Operator (default): Enables the user to operate the Spire CXP50 color 
server and configure the Preferences area in the Settings window 

• Administrator: Enables the user to access all features and settings on 
the Spire CXP50 color server

• Guest: Enables the user to import a job through an existing virtual 
printer and view the workspace

To set Password settings:

1. In the Settings window, select Security.

2. Select Auto Log On to enable users to log on automatically. 

3. Select Disable Guest Connection to prevent Guest users from 
accessing the Spire CXP50 color server.

Note:  This option is not available if you selected the Auto Log On option.
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To change Administrator/Operator passwords:

1. In the Settings window, select Security.

2. In the Administrator/Operator area, enter the old password.

3. Enter the new password.

4. In the Verify new password box, retype the new password.

5. Click Apply and Save in the Settings window.

The password is changed and the Settings window closes.

Disk Wipe
Usually when you delete a file, the file’s dictionary entry is removed but 
data still remains on the disk. The Disk Wipe utility enables you to clear 
previously deleted files. The utility eliminates the contents of your deleted 
files by scanning all of the empty sectors on the disk and replacing them 
with zeros. Non-empty sectors are left untouched. This feature enables you 
to work in a more secure environment. If there is a system shutdown, the 
disk wipe operation can begin immediately.

To operate the Spire Disk Wipe utility:

1. In the Settings window, select Security.

2. To enable the disk wipe feature, select Wipe disk on system 
shutdown.

Note:  Ensure that the Auto Log On check box is not selected.
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3. Quit the Spire color server software.

The disk wipe operation permanently deletes files.

System Disks

Notes:

• The disk wipe operation does not function well when the Norton Utilities 
software is installed. Before you activate the Disk Wipe utility, make sure 
that Norton Utilities is not installed on the Spire CXP50 color server.

• In rare cases, the process of deleting files from the Storage window is not 
completed—for example, the system shuts down before the deletion process 
is completed. In these cases, parts of the deleted files still reside in the 
D\:Output folder. Therefore, it is recommended that before you start the 
disk wipe operation, check the D\:Output folder to ensure that all the 
relevant files were deleted.

• The Disk Wipe utility affects the user disk and printer disk.

• Do not operate the Disk Wipe utility while other software is running.

• The supported language is English.
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When the printer or user disks reach a pre-defined threshold of minimum 
available space (the default is 250 MB), RIP is suspended and a system 
warning message appears. The RIP resumes automatically only after disk 
space is available. 

To set the system disk’s threshold:

1. In the Settings window, select System Disks.

2. In the System Disks area, set the minimum free disk space desired for 
RIP.

Backing up the Configuration
The Configuration Backup item enables you to back up your Spire CXP50 
color server configuration to a local hard disk, to a network drive or to an 
external media—for example, an external zip drive—connected to the 
Spire CXP50 color server.
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Configuration Backup

To back up the configuration of your Spire CXP50 color server:

1. In the Settings window, select Configuration Backup.

2. In the Configuration Backup area, click Browse.

The Save window appears.

3. Browse to the desired directory path for the backup, and type a file 
name.

4. Click Save.

5. In the Settings window, click Start Backup.

Note:  You can also back up to an external media.

Note:  The last path will be saved and displayed to the path box. If the 
backup was made to an external media, the displayed path will be the 
default: C:/CXP50/General/Configuration.
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Configuration Restore

To restore the configuration on your Spire CXP50 color server:

1. In the Settings window, select Configuration Backup.

2. In the Restore Configuration area, click Browse and locate a different 
directory path in which to restore the configuration.

3. Click Start Restore.

The Restore Configuration window appears.

4. Select the categories that you want to restore and click OK.

The following message appears:

Notes:

• The configuration file’s name will always be: "SpireConf.Cab" (Cabinet 
file.)

• You may also restore the configuration from an external media.

Note:  When restoring the configuration all the custom tables/sets are 
added to the system (for example—imported user-defined imposition 
templates, new virtual printers, downloaded fonts, and so on.
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5. Do one of the following actions:

• Click Yes if you would like the restored files to replace the current 
ones. 

• Click No if you do not want the restored files to replace the existing 
files.

Localization

Setting the Localization Measurement
1. In the Settings window, select Localization.

2. In the Localization area, select Millimeters or Inches, as desired.

Notes:

• The Restore Configuration date is updated in the Configuration Backup 
window.

• Restart the Spire CXP50 color server for changes to take effect.
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Setting the Language
1. In the Settings window, select Localization.

2. In the Language area, select the language, as desired.

When configuring the Spire CXP50 color server interface for Russian 
localization, several steps must be performed manually to define Russian 
as the default language.

1. Close the Spire CXP50 color server and turn off the Xerox DocuColor 
5000 digital press.

2. On the desktop, go to Start > Settings > Control Panel. 

3. Double-click Regional and Language Options and select the 
Advanced tab.

4. In the Language for non-Unicode programs area, select Russian from 
the list.

5. In the Default user account settings area, select the Apply all settings 
to the current user account and to the default user profile check box.

Note:  If you switch to another language, you need to restart the Spire CXP50 
color server software.
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6. To confirm the new language setting, click OK in the popup window.

7. Click OK to close the Regional and Language Options window.

8. If the following window appears, click Yes to confirm using the 
required resources from the local hard disk.

9. Restart the Spire CXP50 color server.

10. Wait until the Spire CXP50 color server workspace appears, and then 
turn on the Xerox DocuColor 5000 digital press.

Pre-RIP Preview
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1. In the Settings window, select Pre-RIP Preview.

2. In the PS Preview area, select one of the following: 

• Save as PDF saves the file as a PDF file

• Return to original PS file returns to the original PS file

3. In the VI Job Preview area, select the desired number of booklets for 
pre-RIP preview.

General Defaults

1. In the Settings window, select General Defaults.

2. In the Default Image Size area, select the Size.

3. In the OPI area, select the desired OPI setting.

4. In the Default archive path area, set the archiving path. 

Note:  This feature is available only for the Spire CXP50 color server with the 
Professional Kit. For more information about setting the OPI, see “OPI” on 
page 85.

For more information on the default archive path, see “Archiving and 
Retrieving a Job” on page 39.
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5. In the Custom Paper Function area, select the check box to enable 
custom profiles for paper sets. 

6. In the OCT Offset between jobs area, the OCT Offset between jobs 
check box is selected by default, meaning offset is always done 
between jobs. Clear the check box if you do not require this option.

7. In the Job Title Recognition area, select one of the following options:

• Use PostScript Internal name: select this option to use the internal 
file name as written inside the PostScript file by the print driver.

• Use files name (Use when Printing via LPR): select this option to 
use the job’s given file name. Selecting this option ensures that the 
job appears in the Spire CXP50 color server with the name last 
given by the user.

8. In the Cache global VI elements area, select the check box to cache 
global VI elements for VPS format. When selected, VI elements are 
cached for further use (this feature is available only for the Spire 
CXP50 color server with the Professional Kit.).

For more information, see “Managing Paper Sets” on page 57.
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Print Queue Manager

Job Batching
The Job Batching utility enables you to print several jobs with the same 
settings in a single batch, one after the other without cycling down, and 
subsequently save production time.

To set the desired job batching option:

1. In the Settings window, select Print Queue Manager.

2. In the Job Batching Policy area, select one of the following options:

• Enable Job Batching to print jobs with the same page parameters, 
one after the other without the cycle down.

• Disable Job Batching to disable the printing of jobs with the same 
page orientation one after the other, and enable cycle down.

For more information about job batching, see “Batching Jobs” on page 32.
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To set the desired held jobs option:

In the Held Jobs Policy area, select one of the following options:

Bypass held jobs to bypass frozen jobs in the In Print queue.

Don’t Bypass held jobs to stop the printing from the queue when a 
job is assigned a frozen status.

Color

Calibration
For more information on setting the calibration method, see “Setting the Color 
Calibration Method” on page 120.
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Automatic Screening
The Spire CXP50 color server supports Dot and Stochastic screening. 
When you print a job from the Spire CXP50 color server, select the desired 
screening method or choose Automatic in the Color parameter of the 
Settings window. By default, Automatic applies two types of screening:

• Text / line-art elements - LW (Line Work):
The system uses Line type screen of Line 200.

• CT (Continuous Tone):
The system uses Dot type screen of Dot 200.

To change the values of the automatic screening method:

1. In the Settings window, select Color.

2. In the Automatic Screening area, select the desired auto screen 
settings for LW from the LW list.

3. Select the desired auto screen settings for CT from the CT list.

You are prompted to restart the software for the new settings to take 
effect.

Color Conversion Tables
The Color Conversion Tables utility enables you to select the set of color 
conversion tables used for your jobs. 

To select the color conversion tables:

1. In the Settings window, select Color.

2. In the Color conversion tables area, select the conversion table to be 
used.

By default the current version color tables are selected. To apply the 
previous version color tables, select Previous version color tables.
The following message appears.

For more information, see “Screening” on page 228.

Important:  The Process queue must be suspended while changing the color 
tables set.
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3. Click OK.

Calibration Reminder
Set the Calibration Reminder to remind you when to perform a calibration.

1. In the Settings window, select Color.

2. In the Calibration Reminder area, select the Set calibration reminder 
every (Hours) check box and select the number of hours in the list.

 The calibration reminder indicator  appears when it is time to 
calibrate.
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Messages

Alert Messages
The Alert Messages utility enables you to select whether the Job Alert 
window will open automatically when an error occurs.

To set the Job Alert window settings:

1. In the Settings window, select Messages.

2. In the Alert Messages area, select Launch Alerts window 
automatically on new error (default).

If you would like to open the Job Alert window upon selection only, 
select Launch Alerts window on user selection only.

Accounting Log Setup
By default, all the jobs that were handled during the past 90 days are listed 
in the Spire CXP50 color server Accounting window. This utility enables 
you to specify different values for how long information remains before 
being overwritten.
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To setup the accounting log:

1. In the Settings window, select Messages.

2. In the Accounting Log Setup area, select the desired value to 
Overwrite messages after. 

3. To remove all the existing information from the windows, whenever 
desired, click Clear Log Now.

Message Viewer Log Setup
By default, all the jobs that were handled during the past 90 days are listed 
in the Spire CXP50 color server Message Viewer. This utility enables you to 
specify different values for how long information remains before being 
overwritten.

To setup the message viewer log:

1. In the Settings window, select Messages.

2. In the Message Viewer Log Setup area, select the desired value to 
Overwrite messages after. 

3. To remove all the existing information from the windows, whenever 
desired, click Clear Log Now.

Note:  For more information about the Accounting window, see “Job 
Accounting” on page 206.

Note:  For more information about the Message Viewer, see “Job 
Accounting” on page 206.
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JDF Outputs

The Spire CXP50 color server receives the JDF job ticket via hot folders, 
returns JDF output with job accounting information, and submits JMF 
(Job Messaging Format) signals with the job's status. 

If the JDF job has a target path specified in the job, JDF output is always 
created. For JDF jobs that don’t have a specified target path, the JDF output 
is only created if this option is selected in the Settings window. 

1. In the Settings window, select JDF Outputs.

2. Select Create JDF Outputs to create JDF output.

3. In the Target Path box, enter the target path, or click Browse to 
browse to the desired directory path for the JDF output.

Note:  This feature is available only for the Spire CXP50 color server with the 
Professional Kit.
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View Configuration

The View Configuration utility enables you to view the configuration of 
your Spire CXP50 color server and to print it to any printer on the network 
connected to your Spire CXP50 color server. In addition you can save the 
configuration in the network or export it to an external media as a text file.

1. In the Settings window, select View Configuration.

2. Click Print to print the configuration.

The Print window appears.

3. From the Printer list, select one of the defined printers and click OK.

4. If you would like to save the configuration, click Export.

The Save window appears.
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5. Locate the desired folder, and click Save.

Storage Management
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Use the Storage Management parameter to set a deletion policy for the 
Storage folder.

1. Select the Automatically delete jobs from storage folder check box.

2. Select the desired days or hours option, and enter the number of days 
or hours after which to delete jobs from the Storage folder.

System Messages
While jobs are being handled by the Spire CXP50 color server, various 
messages are emitted. You can view the messages of each job in the Job 
History window, of the entire session in the Message Viewer window, or 
just the error messages within the Job Alert window.

The Job Alert Window
By default, the Job Alert window is open in the Spire CXP50 color server 
workspace. Any time the system emits an error message, the message 
appears in the Job Alert window. The Job Alert window lists all error 
messages as they appear during the workflow. 

From the View menu, select Job Alert.

Note:  You can specify whether you would like the Job Alert window to launch 
automatically on a new error, or upon user selection only. To set the preferred 
option, see “Alert Messages” on page 196.
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System Disks Threshold Message
When the printer or user disks reach a pre-defined threshold of minimum 
available space (the default is 250 MB), RIP is suspended and a system 
warning message appears. The RIP resumes automatically only after disk 
space is available. If necessary, you can increase the System Disk threshold.

Job History

To view the job history:

Do one of the following actions:

Right-click a job in the Queues window or Storage window, and 
from the menu, select Job History.

Select a job and from the Job menu, select Job History.

The Job History window appears, listing all the messages that were 
generated during the workflow of the selected job. 
The Job History window indicates the job title and the sender name 
(the user name of the system from which the job originated).

For more information about setting the system disk’s threshold, see “System 
Disks” on page 183.
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Message Information
For each message, the following information is indicated by default:

• An icon denoting the type of message (Error, Warning, or 
Information)

• The date and time on which the message was emitted (the time stamp)

• The stage in the workflow (for example, Print or Process)

• The message text

You may filter the messages by type, and/or sort the list by one of the 
column headers. 

The Message Viewer

To open the Message Viewer:

At any stage of work, from the Tools menu, select Message Viewer.

The Message Viewer window appears, listing all the messages that were 
generated during the workflow. 

For more information about viewing messages related to a specific job, see 
“Job History” on page 202.
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By default, all the jobs that were handled during the last 3 months (90 
days) are listed. 

Managing Messages
You can filter the messages by type, and/or sort the list by one of the 
column headers. In addition, you may print the list of messages.

If desired, you may reorder and resize columns, filter the list, or sort the list 
by one of its column headers.

The default may be changed in the Settings window under Messages. For 
more information about changing the default setting, see “Messages” on 
page 196.

Notes:

• This section is relevant for the Message Viewer and Job History windows (but 
not for the Job Alert window).

• These settings are retained after closing a window.
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Filtering the Messages by Type

Each message in the Message Viewer and Job History windows is assigned 
an icon to denote the message type:

You can filter the list in order to view only messages of certain types. 

Click any message type icon—for example, Error— in order not to list 
such messages.

By default, all message types are listed in the Message Viewer. 

The list updates accordingly.

Printing the Message List

You can print the information as it appears in the Message Viewer (as it is 
currently filtered and sorted).

To print the message list:

1. Filter and sort the list as desired (the data is printed according to the 
current filtering and sorting).

2. Click Print List.

The Page Setup window is displayed.

Information

Warning

Error

Note:  If the message type is not selected, messages of this type do not 
appear in the list.
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3. Set the printing options as desired, and then click OK.

Job Accounting
The Accounting feature provides information about all the jobs that were 
printed successfully via the Spire CXP50 color server. The report is in the 
form of a tab-delimited file. You can filter, sort, and print the jobs in the 
report and also export the report to a spreadsheet software—for example, 
Microsoft Excel—where you can manipulate the data.

Viewing the Accounting Information
At any stage of work, from the Tools menu select Accounting.

The Accounting Viewer window appears, listing information related to 
all the jobs that printed successfully via the Spire CXP50 color server. 
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Each row in the Accounting report contains information related to a 
specific job.

The columns indicate the following information.

Notes:

• To see additional columns, use the horizontal scroll bar.

• By default, all the jobs that were handled during the past 3 months are 
listed. From the Tools menu, select Settings. In the Settings window, under 
Preferences > Messages, you can specify how long information remains 
before being overwritten. In addition, you can remove all the information 
from the window whenever desired.

Table 15: Description of columns in the Accounting Viewer

Column name Indicates the

Job Title Original name of the file related to this job (that is, 
without the extension)

Sender User name of the system from which this job 
originated

Submitted Date and time the job was first submitted into the 
Spire CXP50 color server

Started Printing Date and time on which the job first started 
printing
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Processing Time Total time during which the job was processed

Printing Time Total time during which the job was printed

Job Size Job size in MB

Paper Size Size of the media set for the job—for example, 
Letter, A3, A4

Paper Weight Paper weight in gs/m

Coating Paper stock coating status (Coated or Uncoated)

Sets Actual number of printed copies

Job B/W Pages Number of black-and-white pages in the original 
PDL file 

Inserts Number of inserts in jobs with exceptions

Job Color Pages Number of color pages in the original PDL file 

Total Pages 
Printed

Number of pages that were printed

Purged B/W Number of B/W pages that were already in the 
paper path, and were cleared due to job abort, or 
paper jam

Purged Color Number of color pages that were already in the 
paper path, and were cleared due to job abort, or 
paper jam

Page Exceptions Existence of exceptions in the job 
(Yes/ No)

Account [Optional] string of text, if such was entered in Job 
Parameters

Table 15: Description of columns in the Accounting Viewer

Column name Indicates the
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Setting the Accounting/Message Viewer
By default, all the jobs that were handled during the past 90 days are listed 
in the Spire CXP50 color server Accounting window. Also, all jobs that 
were handled during the past 56 days are listed in the Spire CXP50 color 
server Message Viewer. You can specify how long information remains 
before being overwritten.

Printing and Exporting the Accounting Log
You can save the Accounting information to an ASCII Tab delimited file.

To export the accounting information:

1. Filter the information as desired.

2. Click Export.

The Export Accounting window appears.

Recipient [Optional] string of text, if such was entered in Job 
Parameters

Job Comments [Optional] string of text, if such was entered in Job 
Parameters

Table 15: Description of columns in the Accounting Viewer

Column name Indicates the

To change the Accounting/Message Viewer log setup, see “Messages” on 
page 196.
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3. Locate the folder in which to save the report.

4. Click Save.

The log is saved as a Tab delimited text file in the specified location. 

5. If desired, open the *.txt file in a text editor or in a spreadsheet 
software—for example, Microsoft Excel—and manipulate the data.

You can print the Accounting information (filtered and sorted) to any 
connected printer.

To print the accounting log:

1. Filter and sort the report as desired.

Notes:

• The log includes all the columns (even those that were hidden), listed in 
the original order and sorting.

• To export specific rows, select them before clicking Export. The 
exported log will include only these rows.

• The exported data is not deleted from the Accounting report on the 
Spire CXP50 color server (that is, it will still be displayed in the Job 
Accounting window).

Note:  To print specific rows, select the desired rows now. The printed report 
will include only these rows.



Job Accounting 211

2. Click Print List.

The Page Setup window appears.

3. Set the printing options as desired and click OK.

The data is printed according to the current filtering and sorting.

Notes:

• To fit the maximum amount of columns on the page, print using 
Landscape orientation (if your printer supports it).

• The report includes all the columns (including those that were hidden), 
listed in the original order.
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Setting Parameters in the Job Parameters 
Window

This section describes each area in the Job Parameters window, and 
explains how to set the job parameters.

The Print Settings Tab

For more information about opening the Job Parameters window, see “The Job 
Parameters Window” on page 23.
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Print Mode
In the Print Mode area, select the desired print mode:

• Composite (default setting): prints the job without separations. Each 
page of the job is printed once.

• Separations: prints the job with color or grayscale separations. If you 
select color, each page in the job is printed separately in four colors; C, 
M, Y, and K. If you select grayscale, each page in the job is printed 
separately four times in different shades of grayscale (K).

• Progressive (this option is available only for the Spire CXP50 color 
server with the Professional Kit): prints each page of the job four times 
in progressive color separations:

Sheet 1 is printed only in C.

Sheet 2 is printed in C and M.

Sheet 3 is printed in C, M, and Y.

Sheet 4 is printed in C, M, Y, and K.
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• Custom (this option is available only for the Spire CXP50 color server 
with the Professional Kit): enables you to select the separations that 
you want to print for each sheet for each page of the job.

Number of Copies
Type the number of copies to be printed.

Print Range 
Select the desired print range.

To select specific pages/booklets or page ranges, select Pages/Booklets 
and specify the pages or booklets to be printed as follows:

Type one or several numbers separated by commas and no spaces. 
For example, 1,3,5.

Type a range of pages or booklets with a hyphen between the 
starting and ending numbers in the range. For example—1-5.

Print Method
Select one of the following options:

Simplex for single-sided printing

Duplex head to toe for calendar-style hard copies (usually used 
with landscape jobs)

Duplex head to head for printing book-style hard copies (usually 
used with portrait jobs)

Note:  For imposed jobs, instead of typing the desired pages, you should type 
the desired imposed sheets.
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Print Order
Set the print order to From 1 to N (front to back) or From N to 1 (back 
to front).

Delivery
Select Face up or Face down as the delivery option.

Collation
Select the Collation option:

Yes prints a complete copy of the job before the first page of the 
next copy prints

No prints all copies of each page before going on to the next page

Image Position
This option enables you to adjust the image positioning on the sheet’s 
printed page (simplex or duplex). The following terminology is used: 

• Rear is the sheet's edge near the printer rear, where printing stops

• Lead is the edge of a sheet at which printing begins

The page’s lead and rear edges are determined just after the page is printed 
out, before making any change in the page orientation. 

Select one of the following:

To print your job in the center of the page, click Center

To set page offsets, click the directional arrows or type Rear and 
Lead values

To apply page offsets values to both odd and even pages, select the 
Same on both sides check box.

Note:  To collate a document and print the set in the correct order, select Face 
down and From N to 1 or Face up and From 1 to N.

Tip:  Use this option to move duplex page data away from the spine.
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Image Scale
Perform one of the following:

To print the original image size, select 100% (default).

To fit the image to the selected paper size, select Fit to Paper.

To custom size the image, select Custom and type the percent by 
which you would like to proportionally increase or decrease the 
image size.

Rotate 180°
To rotate your job by 180°, select Yes.

Gallop
Gallop enables you to begin printing a defined number of pages before the 
entire job has been RIPed.

To enable this option, select Yes and enter the number of pages to RIP 
before printing starts.

Note:  If you also select Finisher Module > CSS Staple Tray, the staple position 
is modified. For example, instead of stapling on the upper left-hand corner, you 
can staple on the lower right-hand corner.
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The Paper Stock Tab

Paper Set Name
Select the desired paper set from the Name list. If desired, a paper set 
can be added.

The selected paper set values (Paper Size, Type, Weight, and Coating) 
appear in the corresponding parameters in the Paper Stock tab.

Paper Size
From the Size list, select the desired stock size. If you select Custom, 
perform the following actions:

a. Type the desired Height and Width. 

b. Select the desired Feed Direction:

• LEF (Long Edge Feed)

• SEF (Short Edge Feed)

For more information on managing paper sets, see “Managing Paper Sets” on 
page 57.
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Type 
1. Select one of the following options:

Paper

Transparency

2. If you want to insert a blank page between transparencies, select the 
Add Interleave check box and customize the interleave by performing 
one of the following actions:

• Select the desired paper set from the list

• Select Same as job to use the default paper size

• Click the browse button  and add a new paper set

3. In the Tray list, select the desired tray and load the specific stock in 
this tray. If you select Auto, any tray with the specific paper stock is 
used. 

Weight
From the Weight list, select the desired stock weight. 

Coating
Select Coated to print on coated paper.

For more information about adding a paper set, see “Managing Paper Sets” 
on page 57.

Notes:

• Slip-sheets and/or blank pages (interleave) in a transparency job are 
counted by the number of sheets, not by the number of pages, 
(rastered pages) reported on the Admin page.

• If the job is imposed, the interleave is the size of the imposition sheet 
and is inserted between each sheet.

Note:  For the Xerox DocuColor 5000 digital press, the paperweight ranges are: 
60-80 gsm, 81-105 gsm (default), 106-135 gsm, 136-186 gsm, 187-220 gsm, 
and 221-300 gsm.
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Tray
In the Tray list, select the desired tray and load the specific stock in this 
tray. If you select Auto, any tray with the specific paper stock is used.

The Print Quality Tab

Text /Line Quality
The Text/Line Quality parameter improves text quality. Text/line quality 
and text and line-art elements are processed separately to produce optimal 
rendering of all the elements on a page. This option improves the text 
quality of diagonal lines, borders, and blends; causes blends to appear 

Notes:

• The Auto tray option uses the paper in the selected tray only if it 
complies with all the other paper stock parameters. If the paper stock in 
the assigned tray does not match any Job Stock parameter, the job is 
frozen.

• If you selected the Custom Paper Function option in the Settings 
window (see “General Defaults” on page 190), in the Custom Profile 
list, select the custom profile.
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smooth with no banding; and displays crisp diagonal lines without (or 
with minimal) jaggies (rough edges) which are the result of the limited 
resolution of the print engine.

1. In the Text/Line quality options area, perform one of the following 
actions:

• Select Text Line Resolution, and select one of the following 
options:

• Normal (default) provides regular text quality.

• High smooths LW elements and renders contours to 1200 dpi.

• Max smooths LW elements and renders contours to 2400 dpi.

• Select Edge Enhancement to enhance edges (LW only)

2. In the Enhance area, select the elements you want to enhance:

• Overlapping elements improves the quality of overlapping vector 
and image elements

• Text/Line in images improves the resolution of text and line-art in 
images

Image Quality
The Image quality parameter refers to the ability to maintain the same 
detail and smoothness with different degrees of enlargement. This feature 
is especially useful when your PostScript file includes several images of 
different qualities—for example, images that were scanned at different 
resolutions, were rotated, or were downloaded from the internet.

Note:  You cannot merge jobs with different gray font rendering.

Note:  If you select Overlapping elements, the corresponding 
enhancement is automatically selected in the Image Quality 
parameter.
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1. In the Image quality options area, select one of the following options:

High to provide superior image quality. This setting applies the Creo 
proprietary smooth scale algorithm, which improves the quality of 
images containing several resolutions (such as images taken from 
the Internet).

Normal (default) to provide normal image quality (for jobs that do 
not require improved picture quality)

2. In the Enhance area, select the Overlapping elements check box to 
improve the quality of overlapping vector and image elements.

Trapping
Trapping is a solution that solves misregistration between color 
separations in both offset and digital printing. Misregistration occurs 
regardless of the accuracy of the printing device and results in white lines 
around objects on top of a background (in a knock-out procedure) and 
also between adjacent colors. Trapping extracts the element or the 
background and creates an overlap between them. 

1. To set trapping, select Yes.

Note:  If you select the High option, the processing speed is decreased.

Note:  If you select Overlapping elements, the corresponding 
enhancement is automatically selected in the Text/Line Quality parameter.

Note:  Do not use this option with VI jobs.

Notes:

• If you select Yes, the Frame Thickness and Protect Small Text options 
are activated. These options cannot be selected through the PPD.

• If you select No, trapping incorporated by DTP software (for example, 
Photoshop) is not affected. Creo Full Auto Frame trapping software (FAF) 
should not be used with software-based trapping. In a PostScript file 
that already contains trapping from the originating software, it is not 
necessary to use Spire CXP50 color server trapping.
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2. In the Frame Thickness box, select the default thickness (0.08mm/
0.003 inch), or type the desired value. The thicker the frame, the less 
chance that white areas appear between images.

3. Do one of the following actions:

• Select the Protect Small Text check box to prevent the trapping of 
text that is 12 points or less.

• Clear the Protect Small Text check box to trap all text elements.

Black Overprint
Select Yes to ensure that black prints cleanly within a tint or picture 
area.

The text appears in a richer, deeper black, with the underlying CMY 
values equal to those of the printed background.

PS Overprint
Select Yes to use the overprint information that exists in the input file.

This parameter also determines whether the DTP software overprint 
settings are honored in the RIP.

Image Noise
The Image Noise parameter enables you to smooth and blend vignettes of 
continuous tone (CT) images.

Select Yes to set the image noise level and move the slider to change the 
noise level as desired.

Tip:  Apply the Protect Small Text option to small or complex images to ensure 
their quality is not decreased.
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The Color Tab

Color Mode
Select one of the following options:

Color to print the job in color using CMYK

Grayscale to print the job as black and white using Black (K) toner 
only

Note:  If the job contains grayscale images that were created in RGB 
software, such as Microsoft PowerPoint, specify as monochrome. This 
selection ensures that grayscale images are counted as black and white 
instead of color in both the Spire CXP50 color server and in the Xerox 
DocuColor 5000 digital press billing meters.
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RGB Workflow
The RGB Workflow parameter enables you to select an RGB profile and 
apply it to RGB elements in your job. You can use predefined profiles, or to 
achieve better color results, import your own custom profile via the Profile 
Manager.

1. In the RGB Workflow list, select the desired RGB source profile: 

• To use the embedded color space array (CSA) or source CSA, select 
Use SourceCSA.

• To use a Spire or Adobe CSA, select a CSA from the list. The default 
option is SpireRGB_2.1.

• To use a custom RGB profile, select the profile name from the list.

2. In the Rendering intent list, select the desired option.

3. To print RGB gray text and graphics with black toner only, select the 
Print grays using black toner check box.

4. Select Apply CMYK emulation to convert RGB elements according to 
the CMYK emulation method selected in the CMYK Profile list in the 
CMYK Workflow parameter. The RGB elements receive the same look 
as the CMYK elements, creating a consistent appearance.

CMYK Workflow
The CMYK workflow option is used to emulate various standards used in 
lithographic printing. These standards represent specific combinations of 
paper and ink, as well as popular proofing systems. This option is also used 
to emulate other digital printers or other printing devices, such as offset 
presses. An example of a CMYK workflow job would be printing a test 
sample for a survey before moving to an offset press to print millions of 
survey forms. In such a case, it is best to emulate the offset press before the 
job actually goes to offset printing.

For more information on rendering intent, see “Rendering Intent” on page 265.

Note:  The Print grays using black toner check box not only affects 
R=G=B values, but may also cause slightly different values 
(R+/-4=G+/-4=B+/-4) to produce gray.

Note:  RGB colors are not affected by the CMYK workflow.
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The CMYK workflow parameter is also used to specify the desired 
rendering intent for CMYK elements.

To select CMYK workflow options:

1. In the CMYK Profile list, select the desired CMYK profile.

2. In the Rendering intent list, select the desired option.

3. To emulate the original paper tint, select the Emulate source paper 
tint check box. 

4. Select the Preserve pure colors check box to preserve pure cyan, 
magenta, yellow, and black during transformation.

Spot Workflow
By default, the Spire CXP50 color server searches the spot color dictionary 
for the correct value for each recognized spot color. 

Note:  The system emulates the selected option during the RIP process. GCR 
and CMYK emulation do not affect the processed job.

For more information about choosing the correct rendering intent, see 
“Rendering Intent” on page 265. 

Notes:

• The Emulate source paper tint check box is available only if you select 
Device Link as the CMYK profile.

• When you select the Emulate source paper tint check box, the Spire 
CXP50 color server applies the absolute colorimetric rendering method.

• When you select the Emulate source paper tint check box, the RGB 
Workflow > Apply CMYK emulation check box is selected by default.

• If the job is simplex, only the front side will be printed using the tint 
emulation.

For more information about spot colors, see “Spot Color Editor” on page 141.
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Select the relevant options:

Use Spire spot color dictionary: to use spot colors in the dictionary

Protect RGB colors: to retain RGB colors as defined

Protect Gray colors: to retain grays as defined

Protect CMYK colors: to retain CMYK colors as defined  

Destination Profile
Select the desired profile, or select Linked to use the destination profile 
that was mapped to a paper color in the Profile Manager.

There is one predefined Spire CXP50 color server profile; SpireDC5000.

Screening
Screening converts Continuous-Tone (CT) and Line-Work (LW) images 
into information (halftone dots) that can be printed. The human eye 
smooths out this information, which seems visually consistent with the 
original picture. Thus, the more lines per inch, the more natural the image 
appears.

Screening is achieved by printing dots in numerous shapes or lines in an 
evenly spaced pattern. The distance between the screen dots or lines is fixed 
and determines the quality of the image.

Using screening, printers can work with even amounts of toner and still 
produce a wide range of colors when you use screening. The darker the 
color, the larger the dot, or the thicker the line. In this manner, screens give 
the appearance of different toner quantities printed in a certain area.

Note:  If you protect RGB, grayscale or CMYK colors, all colors with that specific 
combination found in the job will be protected. For example, a specific color 
combination used in a logo may align with a color used in an image in the job. 
The spot transformation affects the image color as well as that of the logo, 
sometimes to undesired results.

For more information on managing destination profiles, see “Profile Manager” 
on page 137.
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To select a screening method:

In the Screening list, select the desired option. For CT images, use a 
dot option; for LW images, use a line option. 
If you select Automatic, Dot 200 is used for CT images, and Line 200 is 
used for LW images.

Calibration 
The purpose of color calibration is to achieve a consistent level of color 
quality. Calibration corrects printer colors by measuring a color density 
chart. 

The Spire CXP50 color server calibration tool enables you to create and 
edit calibration tables, either through an automatic process or by editing 
an existing calibration table. The available calibration options are Normal, 
Saturated, and None.

The Calibration parameter enables you to select the desired calibration 
table for the job.

To select a calibration table for a job:

In the Calibration list, select a calibration table. The default calibration 
table is Normal.

Ink Saving (GCR)
Gray component replacement (GCR) prevents the consequences of 
excessive toner buildup, such as flaking and cracking, and the curling effect 
that may occur when you print transparencies.

To set ink saving, select one of the following options:

For more information about calibration tables, see “Creating a Calibration 
Table” on page 124 and “Editing Calibration Tables” on page 129.

Tip:  For optimal printing performance, use the Normal calibration setting 
with Ink Saving (GCR) set to Medium.

Note:  There is no change to the color quality of the printed image even though 
the gray component of each color is replaced by black.
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None: no GCR is performed on the file, and the printer applies 
maximum dry ink coverage

Low, Medium, or High: the selected amount of CMY dry inks 
replaces the black dry ink.

Color Adjustments

Gradation

The Gradation list contains gradation tables that were created by the Spire 
CXP50 color server’s gradation tool. Each gradation table contains specific 
settings for brightness, contrast, and color balance.

When you select your predefined gradation table, your job is adjusted 
according to the specific table’s settings. 

In the Gradation list, select one of the defined gradation tables. 

Brightness

Use this option to make last-minute adjustments to the print job after 
proofing. 

To select a brightness level for a job, move the Brightness slider to the 
desired brightness level (the range starts from Light, which 
applies -15%, to Dark, which applies +15%). 

No GCR Low GCR Medium GCR High GCR

Note:  Select High for minimum ink coverage and to save on toner. High also 
prevents curling effects.

For more information about creating gradation tables, see “Gradation Tool” on 
page 148.

Note:  The default setting is None—no gradation table is applied to your job.
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Contrast

Adjust the Contrast option to control the difference between light and dark 
tones in your image.

To select a contrast level for the print job, move the Contrast slider to 
the desired contrast level (the range starts from Less, - which 
applies -10%, to More, - which applies +10%).

The Imposition Tab
The Imposition tab enables you to set job options related to the 
positioning, folding, trimming, and binding of pages.

Note:  If you use a dynamic page exceptions virtual printer to print a job, the 
Imposition tab is unavailable. For more information, see “Dynamic Page 
Exceptions” on page 94.



232 Appendix A – Setting Parameters

Imposition Method
The Imposition Method parameter specifies how printed sheets are 
finished.

Select one of the following options:

None for no imposition (this is the default option). The imposition 
parameters are unavailable and the thumbnail viewer does not 
display an image.

Step & Repeat prints multiple copies of the same image on one 
sheet so that the sheet is used to maximum capacity. This method is 
used mainly for printing business cards.

If you select Step & Repeat, the following option is available:

• Cut & Stack enables Step & Repeat jobs to be printed, cut, 
stacked, and bound in the most efficient manner, while 
preserving the original sorting. A job’s pages, booklets, or 
books are sorted in a Z-shape. In other words, each stack of 
pages is sorted in consecutive order. When stacks are piled one 
on top of another, the entire job is already sorted up or down.

Saddle Stitch prints pages ready for applying a book-finishing 
technique in which the pages of a book are attached through 
stitching or stapling in the spine fold—for example, brochures.

Notes:

• When you use the Step & Repeat template for VI jobs, the job 
prints in Z-Sorting mode. This mode enables imposed VI jobs to be 
sorted for Cut & Stack finishing.

• You can use specific Step & Repeat templates to print several 
different images on one sheet.

Note:  If you select Cut & Stack, you cannot make changes or enter a 
valid exception in the Exceptions tab.
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Perfect Bound prints pages ready for applying a book-finishing 
technique in which the pages of a book are attached by trimming 
the spine fold, roughening the edges of the gathered pages, and 
gluing them together—for example, hardcover books.

Sizes
1. In the For sheet size use paper set list, select the desired paper set. If 

you need to add a new paper set, click the browse button .

Paper set defines the paper stock attributes (paper size, type, weight 
and coating) on which the imposed job will be printed. The Spire 
CXP50 color server enables you to define all the paper stock settings of 
an imposed job on the Imposition tab with no need to switch to the 
Paper Stock tab and define the paper stock settings there.

2. In the Trim Size list, select the desired trim size. Trim size is the size of 
the finished, trimmed document. You can adjust your page size by 
adjusting the trim size.

If you select Custom, define a custom trim size and type the desired 
height in the H box, and the desired width in the W box.

For more information about adding paper sets, see “Managing Paper Sets” 
on page 57.

Note:  If you set the trim size to be smaller than the page size set in the DTP 
software, some of the data is cropped. Setting a larger trim size results in a 
larger border on the printed page.
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3. Select the desired Orientation (Portrait or Landscape) for the trim 
size. If you specify the wrong orientation, an unsuitable template 
might be selected and the job might be cropped.

4. Select Fit to sheet size to fit the page to the sheet size.

Template
1. From the Category options, select one of the following options:

• Predefined to choose a predefined Spire CXP50 color server 
imposition template

• User-defined to choose a user defined Spire CXP50 color server 
imposition template

2. The rows and columns indicate how the pages will be placed on the 
sheet. Set the Layout as follows:

a. In the Columns list, select the number of pages to place 
horizontally. You can select the number of columns from the 
drop-down list. The template preview area displays your settings.

b. In the Rows list, select the number of pages to place vertically. You 
can select the number of rows from the drop-down list. The 
template preview area displays your settings.

3. Select the Print Method from the list.

For more information about user defined templates, see “Imposition 
Templates” on page 82.

Note:  If you select the User Defined option, Layout is unavailable.
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4. Select the North South check box if the template you chose is either 
step and repeat 2×1 or 1×2. The pages will be placed 180 degrees from 
each other, on the same side of the imposed sheet.

Previewing the Template Layout

When you choose a template, you need to account for other job 
parameters—for example, Trim Size, Bleed, Margin, Gutters, and Paper 
Size. In the Template Options area, you can preview the template layout of 
your job and check your imposition settings. For example, green arrows 
indicate that the template layout is rotated, which the blue and black 
arrows indicate the direction of the pages on the sheet. The sequence of 
pages is indicated by the page numbers.

If the parameters conflict, you will see where the conflicts exist when you 
preview the template layout:

• Red corners indicate that the trim size is larger than the sheet size.

• Yellow corners indicate unsuitable margin settings—for example, if the 
margin size is unsuitable.

• Dotted lines indicate conflicting trim size settings and template 
settings—for example, A3 trim for Step & Repeat 2x2 Duplex template.

Margins
Enter the desired margin sizes to adjust the spaces between the outside 
edges of pages and the edges of the sheet on which they are printed.

Margin settings must accommodate finishing equipment and 
requirements. Confirm binding parameters with your binder when 
planning your sheet.

Marks & Bleed
The Marks & bleed parameter enables you to mark where trimming and 
folding should occur. 

Note:  You can preview the imposed job in the Job Editor window, Imposed 
sheets tab, see “Viewing and Editing Job Parameters” on page 36.
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When you set bleed options, you extend part or all of the printed image 
beyond the trimming boundary. The bleed options ensure that an 
inaccurate trim setting will not leave undesired white space at the edge of 
the page. The bleed options produce sharp page boundaries with color that 
extends all the way to the edge of the page.

To select marks and bleed options:

1. In the Marks area, select one of the following options:

a. To print lines that indicate where the sheet should be cropped, 
select the Crop Marks check box.

• To print the crop marks on both sides of the page, select the 
Both sides of sheet check box.

b. To print lines that indicate where the sheet should be folded, select 
the Fold Marks check box.

2. In the Bleed area, select one of the following options:

a. Maximum bleed to extend the bleed to the sheet fold lines.

b. Custom bleed size type the desired bleed size in millimeters.

Creep

Notes:

• Crop marks are placed according to the Trim Size option. A minimum 
of 6 mm is required for crop marks, and 10 mm for fold marks.

• If your job already includes crop marks incorporated in the DTP software, 
you do not need to add crop marks here. If you do add crop marks, both 
sets of crop marks can be printed.

• If you want to use crop marks incorporated in the DTP software, make 
sure that enough space is left around your page in the PostScript file so 
that the page prints with crop marks.

Notes:

• You cannot extend the bleed size beyond the sheet fold lines. Bleed 
does not affect the position of crop.

• Bleeding must be defined in your DTP software in order for the Spire 
CXP50 color server to apply the bleed options.

Tip:  It is recommended that you use a border around all documents when you 
use creep.
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The Creep parameter uses the following terminology: 

• Creep in specifies the amount of movement towards the spine applied 
to the center two pages and their backs (in other words, the pages that 
require the most amount of compensation). 
An ever-decreasing amount of movement is automatically applied 
from the center quartet of pages back to the outside four pages of the 
job (in other words, every quartet of pages is moved by an amount less 
than the previous quartet). 

• Creep out is used when you find that the page images are too close to 
the spine. This problem can be resolved by selecting a value for Creep 
out. This will move all the pages of the job further out towards the 
outside margin (away from the spine) by the specified amount. This 
movement takes place before the Creep in value is applied. 

To set the creep options:

1. In the Creep in area, select Auto to automatically set the creep based on 
paper stock weight, or type the desired amount for Creep in.

2. In the Creep out area, type the desired amount.

Note:  The outside two pages and their backs are not moved (the value 0.0 is 
used). 

Note:  Units of measurement (mm or inches) are set in the Settings window, 
see “Localization” on page 187.
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The Services Tab

Job Deletion
Select this parameter to delete each page on the fly after it has been 
successfully printed. In this way, the Spire CXP50 color server maintains 
enough free disk space for the duration of the print run. Reusable elements 
are not deleted.

To set a deletion policy:

1. Suspend the Process Queue and import your job.

2. Double-click your job to open the Job Parameters window.

Notes:

• This option sustains enough free disk space for the duration of the print run 
and only affects the sub-job. 

• The Variable Print Specification file is also deleted.
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3. On the Services tab, in the Automatic deletion options area, select 
one of the following options:

• To remove pages or jobs after printing is completed, select Delete 
after complete.

• To remove failed jobs while processing or printing, select Delete 
on job failure.

4. Click Save. 

5. Select the resume button to resume the Process Queue and start the 
processing of your job.

Substituting Fonts
Select one of the following options:

Yes to substitute a missing font with the default font that is set in 
the Settings window.

No to stop the job processing if the desired font is missing.

APR 

1. In the APR options area, select one of the following options:

• Print with high res to replace low-resolution images in your job 
with high-resolution images that are located in a specified APR 
path.

• Print with low res to print the job with the existing low-resolution 
images—for example, for proofing purposes.

For more information on managing fonts, see “Fonts” on page 96.

Note:  This feature is available only for the Spire CXP50 color server with the 
Professional Kit.

For more information on APR, see “Creo APR” on page 85.
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2. In the Use APR mask from area, select one of the following options:

• PostScript image to use the masking data contained in the 
low-resolution image file.

• High res to use the masking data contained in the high-resolution 
image file.

• Both to use the masking data that is common in both 
high-resolution and low-resolution image files—for example, if 
the images defined by the two sets of masking data overlap, the 
overlapping area is RIPed.

Setting a High-Resolution Path

There are two default paths in which the Spire CXP50 color server searches 
for high-resolution images:

• Search in the input folder: The Spire CXP50 color server first searches 
for high-resolution images in the same folder as the PDL file. 

• D:\Shared\High Res: If you want to save your high-resolution files in 
this folder, copy the files to D:\Shared\High Res. 

You can also add a new high-resolution path, and then edit, or delete the 
path.

Paths other than the default paths are defined on a per-job basis, or set in 
the virtual printer. You can specify paths on local hard drives, CD-ROM 
drives, and the floppy drive connected to the Spire CXP50 color server. You 
can also specify paths on remote clients or file servers.

To add a high-resolution path:

1. Under the APR path box, click Add.

The HiResPath dialog box appears.

2. Click the Add button .

The Open dialog box appears.

3. Locate your high-resolution images, and then click Select.

The new path is displayed in the HiResPath dialog box.

Note:  If the masking data in the low-resolution image file defines a 
completely different part of an image than the masking data in the 
high-resolution file, no masking data is used.
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4. To promote or demote a selected APR path, use the arrow buttons.

To modify a high-resolution path:

1. In the HiResPath dialog box, select the path you want to modify.

2. Click the Edit button .

The Open dialog box appears.

3. Locate your high-resolution images, and then click Select.

The new path is displayed in the HiResPath dialog box.

To delete a high-resolution path:

1. In the HiResPath dialog box, select the path you want to delete.

2. Click the Remove button .

The selected path is deleted.

Job Flow 

This parameter enables you to specify a job flow for a job that is imported 
to the Spire CXP50 color server from the network or from the Spire CXP50 
color server folders.

Select the desired job flow option:

Process & Print to set the Spire CXP50 color server to RIP, print, and 
store the PDL files in the Storage window (unless the Job Deletion 
parameter is set to Delete after Complete).

Process & Store to RIP and move the PDL files to the Storage 
window as RTP jobs.

Spool & Store to place the PDL files directly into the Storage 
window without processing them.

Note:  The order in which the APR paths are listed is the order in which the 
Spire CXP50 color server searches for the high-resolution images.

Note:   This option can be defined only through the PPD parameters of the 
virtual printer.
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Compression
Some jobs can fail to print because they contain images that cannot be 
compressed. Increasing compression can resolve this problem.

Select one of the following options:

Normal for normal compression

High for higher compression

Preflight

Select Run Preflight check to check the status of key job components 
before the job is sent for printing.

For more information on the Preflight parameter, see “Preflight Check” 
on page 105.

Note:  Choosing a higher compression can result in lower quality.

Note:  This parameter is available only if you have the Spire CXP50 color server 
with the Professional Kit.
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Job Slug

Select the desired job slug options to be printed in the margins of your 
job:

Color bar: prints a measurable color bar enabling you to know the 
state and consistency of the printer and calibration, and perform 
color proofing if necessary

Job name: prints the job name

Sheet number and side (front/back): prints the sheet number, and 
front/back side information

Date and Time: prints the date and time the job is printed

Comment: enter comments for your job (up to 30 characters)

Job Info
This parameter provides the following information:

• Job Title—the original name of the file related to this job

• Sender—the user name of the system from which this job originated

• Account—the account number of a specific customer or group

• Recipient—the name of the customer

• Job Comments—the any special instructions that you want to include 
with your job

Job Link
This parameter displays the relevant URL for the linked elements of JDF 
jobs.

Click the link to open the linked element.

Note:  This parameter is available only if you have the Spire CXP50 color server 
with the Professional Kit.

Note:  JDF jobs are only supported in the Spire CXP50 color server with the 
Professional Kit.
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Split to Booklets
The Split to booklets parameter enables you to split a PostScript, PDF, or 
large VI job that does not have a booklet structure into booklets. 

1. In the Split to booklets options area, select Yes.

2. In the Number of pages per booklet box, type the desired number.

PDF/PS Optimization

Use this option if you have a PDF or PostScript job with repeated elements 
and want to significantly decrease processing time by applying the PDF/PS 
workflow.

Select the relevant option.

The repeated elements are cached once, and then reused without 
repeated processing.

Note:  Unexpected results might occur when you use this option for VI jobs that 
already have a booklet structure.

Note:  If the specified number of pages per booklet is not sufficient to 
produce complete booklets and there is a remainder of pages, the last pages 
will form a booklet that contains less pages than specified.

Note:  This option is available only for the Spire CXP50 color server with the 
Professional Kit.

Important:  Verify that in your Acrobat Distiller settings, Optimize for Fast 
Web View is selected (in Acrobat 4.0 the corresponding option is 
Optimize PDF).
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The Finishing Tab

Administration Page
The administration page contains job-related information, such as the job 
title, the name of the sender, the date and time that the job was submitted, 
account information, and comments.

The Administration page is printed in the same order as the job.For 
face-down printing, the page is printed before each set; for face-up 
printing, the page is printed after each set.

To print an administration page:

Select the Print Admin page check box and set the specifications as 
desired.

Note:  If you change the options in the Admin page parameter, you must re-RIP 
the job.
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Slip Sheet
You can print slip sheets with your job and select a different paper set in 
which to print the slip sheet. If the job is collated, the slip sheets will be 
printed between sets. If the job is not collated, the slip sheets will be printed 
between groups.

To set slip sheet options:

1. Select the Print slip sheet check box.

2. In the Paper set list, select the desired paper set. If you need to add a 
new paper set, click the browse button.

3. In the Tray list, select the desired tray.

4. In the Frequency list, type the number of slip sheets you want to print. 
The default is 1; a slip sheet is printed between each set.

Front Cover
By default, your job is printed without a front cover. You can choose to 
print a front cover using the same or a different paper set, as desired. 

To print a front cover:

1. Select the Print front cover check box.

2. In the Paper set list, select the desired paper set. If you need to add a 
new paper set, click the browse button.

3. In the Tray list, select the desired tray.

4. In the Cover printing area, select one of the following options:

• None to print a blank front cover.

For more information about adding paper sets, see “Managing Paper Sets” 
on page 57.

For more information about adding paper sets, see “Managing Paper Sets” 
on page 57.

Note:  A blank page is automatically inserted between the cover page 
and the first page of the job so that both sides of the cover page are 
defined, and the job starts on the next odd page.
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• Print on front side to print the first page of the job as the cover 
page.

• Print on both sides to print the first two pages of the job as the 
cover page.

Back Cover
By default, your job is printed without a back cover. You can choose to 
print a back cover using the same or a different paper set, as desired. 

To print a back cover:

1. Select the Print back cover check box.

2. In the Paper set list, select the desired paper set. If you need to add a 
new paper set, click the browse button.

3. In the Tray list, select the desired tray.

4. In the Cover printing area, select one of the following options:

• None to print a blank back cover.

• Print on back side to print the last page of the job as the back cover.

• Print on both sides to print the last two pages of the job as the back 
cover.

Finisher
The Finisher parameter enables you to select the destination of the printed 
output.

For more information about adding paper sets, see “Managing Paper Sets” 
on page 57.

Note:  A blank page will automatically be inserted between the back 
cover and the last page of the job so that both sides of the back cover 
are defined.

Note:  The available stapling methods for PostScript files depend on the page 
orientation and size. The stapling methods for PDF files depend on the page size.
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In the Module list, select one of the finisher options:

OCT (offset catch tray) (default)

• The Offset check box is selected by default. If you don’t want 
to use an offset between sets, clear this check box.

EHCS (enhanced high capacity stacker)

a. Select the relevant tray type (Top Tray or Stack Tray).

b. If you have a chained EHCS, select the desired tray from the drop-
down list.

c. If you selected Stack Tray, select the Offset check box for the 
following types of jobs:

• Collated to offset each copy from the next copy.

• Uncollated to insert an offset sheet when a new page number is 
delivered (when you are printing more than one copy of each 
page).

CSS (common stacker stapler)

a. Select the relevant tray type (Top Tray or Stack Tray).

b. If you selected Stack Tray, select one of the following options:

• Offset to use an offset.

• Stapler to select stapling.

c. If you selected Stapler, select the desired staple location (Front, 
Rear, or Dual).

DFA (document finishing architecture)

a. Select the desired Profile from the list, according to the profile set 
in the printer you are using.

b. Select the desired Function, according to the profile set in the 
printer you are using. 

Note:  If the page size is larger than A3 (standard or custom), the Offset 
check box is unavailable.
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The Exceptions Tab

The Exceptions tab enables you to add and delete page exceptions and 
inserts. 

Managing Exceptions
You can add and delete exceptions.

To add exceptions to a job:

1. In the Exception area, click the Add button .

2. In the From and To boxes, type the desired page range for the 
exception. 

Note:  If you have the Spire CXP50 color server with the Professional Kit, use the 
Exceptions tab to map paper sets for dynamic page exceptions.

Fo

For more information about the dynamic page exceptions workflow, see 
“Dynamic Page Exceptions” on page 94.
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3. In the Paper set list, select the desired paper set. If you need to add a 
new paper set, click the browse button.

4. In the Tray list, select the desired tray.

5. To set image position options:

a. Click Advanced.

b. Clear the Same as job check box. 

c. To shift an image, follow one of these steps:

• Click the arrows to shift the image on both sides.

• Type a value in the Rear and Lead boxes.

d. To set the values back to 0.0, click Center Image.

e. Click Save.

6. Click Apply.

The exception is added to the Exception area.

To delete an exception:

1. In the Exception area, select the desired exception and click the 

Remove button .

2. In the confirmation message, click Yes.

Managing Inserts

To add an insert:

1. In the Insert area, click the Add button .

2. In the After page box, type the number that will precede the insert. 

3. In the Quantity box, type the number of inserts that you want.

For information about adding a paper set, see “Managing Paper Sets” on 
page 57.

Note:  The default paper stock properties are those specified for the job.
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4. In the Paper set list, select the desired paper set. If you need to add a 
new paper set, click the browse button.

5. In the Tray list, select the desired tray: 

6. Click Apply.

The insert is added to the Insert area.

To remove an insert:

1. In the Insert area, select the desired insert and click the Remove button 

.

2. In the confirmation message, click Yes.

Note:  The default paper stock properties are those specified for the job.

For information about adding a paper set, see “Managing Paper Sets” on 
page 57.
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Setting PPD File Parameters
You can set job parameters from a client workstation using the Spire 
CXP50 color server PPD file or you can define a virtual printer with 
predefined PPD file settings.

To print a file from Windows, first set up a Spire CXP50 color server 
network printer with the appropriate PPD file. The PPD file contains all 
the parameters and paper stock definitions for the printer and enables you 
to print your file properly.

The following table lists the PPD file parameters available. 

Notes:

• In the PPD file, the Printer’s Default option is selected for all PPD file 
parameters. The Printer’s Default option corresponds to the settings of the 
currently selected virtual printer.

• Print settings defined in the job file override the settings of the virtual printer.

Table 16: PPD parameters

PPD Parameter Printing Options

Print Method See “Print Method” on page 216.

Image orientation for 
imposition

See “Sizes” on page 233.

Reverse Print Order See “Print Order” on page 217.

Face Up See “Delivery” on page 217.

Collation See “Collation” on page 217.

Image Scale See “Image Scale” on page 218.

Rotate 180 See “Rotate 180°” on page 218.

Paper Set See “The Paper Stock Tab” on page 219.

Type See “Type” on page 220.

Weight See “Weight” on page 220.

Coating See “Coating” on page 220.
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Text and Line Quality See “Text /Line Quality” on page 221.

Image Quality See “Image Quality” on page 222.

Trapping See “Trapping” on page 223.

Black Overprint See “Black Overprint” on page 224.

PS Overprint See “PS Overprint” on page 224.

Image Noise See “Image Noise” on page 224.

Color Mode See “Color Mode” on page 225.

RGB Workflow See “RGB Workflow” on page 226.

Gray RGB See “RGB Workflow” on page 226.

Rendering Intent for RGB For setting this parameter, see “RGB Workflow” on page 226. 

For more information on rendering intent, see “Rendering 
Intent” on page 265.

CMYK Workflow See “CMYK Workflow” on page 226.

Emulate Source Paper Tint See “CMYK Workflow” on page 226.

Emulate RGB Elements See “CMYK Workflow” on page 226.

Preserve Pure Colors See “CMYK Workflow” on page 226.

Rendering Intent for CMYK See “CMYK Workflow” on page 226.

Use Spire Spot color dictionary See “Spot Workflow” on page 227.

Destination profile See “Destination Profile” on page 228.

Calibration See “Calibration” on page 229.

Screening Method See “Screening” on page 228.

Ink Saving (GCR) See “Ink Saving (GCR)” on page 229.

Brightness See “Color Adjustments” on page 230.

Table 16: PPD parameters

PPD Parameter Printing Options
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Text and Line Quality See “Text /Line Quality” on page 221.

Image Quality See “Image Quality” on page 222.

Trapping See “Trapping” on page 223.

Black Overprint See “Black Overprint” on page 224.

PS Overprint See “PS Overprint” on page 224.

Image Noise See “Image Noise” on page 224.

Color Mode See “Color Mode” on page 225.

RGB Workflow See “RGB Workflow” on page 226.

Gray RGB See “RGB Workflow” on page 226.

Rendering Intent for RGB For setting this parameter, see “RGB Workflow” on page 226. 

For more information on rendering intent, see “Rendering 
Intent” on page 265.

CMYK Workflow See “CMYK Workflow” on page 226.

Emulate Source Paper Tint See “CMYK Workflow” on page 226.

Emulate RGB Elements See “CMYK Workflow” on page 226.

Preserve Pure Colors See “CMYK Workflow” on page 226.

Rendering Intent for CMYK See “CMYK Workflow” on page 226.

Use Spire Spot color dictionary See “Spot Workflow” on page 227.

Destination profile See “Destination Profile” on page 228.

Calibration See “Calibration” on page 229.

Screening Method See “Screening” on page 228.

Ink Saving (GCR) See “Ink Saving (GCR)” on page 229.

Brightness See “Color Adjustments” on page 230.

Table 16: PPD parameters

PPD Parameter Printing Options
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Text and Line Quality See “Text /Line Quality” on page 221.

Image Quality See “Image Quality” on page 222.

Trapping See “Trapping” on page 223.

Black Overprint See “Black Overprint” on page 224.

PS Overprint See “PS Overprint” on page 224.

Image Noise See “Image Noise” on page 224.

Color Mode See “Color Mode” on page 225.

RGB Workflow See “RGB Workflow” on page 226.

Gray RGB See “RGB Workflow” on page 226.

Rendering Intent for RGB For setting this parameter, see “RGB Workflow” on page 226. 

For more information on rendering intent, see “Rendering 
Intent” on page 265.

CMYK Workflow See “CMYK Workflow” on page 226.

Emulate Source Paper Tint See “CMYK Workflow” on page 226.

Emulate RGB Elements See “CMYK Workflow” on page 226.

Preserve Pure Colors See “CMYK Workflow” on page 226.

Rendering Intent for CMYK See “CMYK Workflow” on page 226.

Use Spire Spot color dictionary See “Spot Workflow” on page 227.

Destination profile See “Destination Profile” on page 228.

Calibration See “Calibration” on page 229.

Screening Method See “Screening” on page 228.

Ink Saving (GCR) See “Ink Saving (GCR)” on page 229.

Brightness See “Color Adjustments” on page 230.

Table 16: PPD parameters

PPD Parameter Printing Options
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Contrast See “Color Adjustments” on page 230.

Automatic Deletion See “Job Deletion” on page 238.

APR See “APR” on page 239.

Job Flow See “Job Flow” on page 241.

Split to booklets See “Split to Booklets” on page 244.

Admin Page See “Administration Page” on page 245.

Slip Sheet See “Slip Sheet” on page 246.

Finisher Module See “Finisher” on page 247.

Finisher Offset See “Finisher” on page 247.

Staple Options See “Finisher” on page 247.

Account See “Job Info” on page 243.

Recipient See “Job Info” on page 243.

Job Comments See “Job Info” on page 243.

Table 16: PPD parameters

PPD Parameter Printing Options



24-bit/3-byte image An image can be either RGB or CMY and each of the three colors uses 
1 byte or 8 bits of data. Since 3 bytes equals 24 bits, these images are 
also known as 24-bit images. This system is used for high quality 
video imaging and scanning. For process color printing, a fourth 
color (black) is added for optimum effect. 

32-bit/4-byte image An image that uses 8 bits each for CMYK pixels, or 8 bits for each RGB 
pixel and 8 pixels for a mask layer or other future use. Since 4 bytes 
equals 32-bits, these images are also known as 32-bit images. An 
8-bit CMYK image is the minimum required for high quality print 
reproduction. 

4-color printing Color reproduction method used to create full color output by 
overlaying cyan, magenta, yellow and black inks.

8-bit/1-byte image An image limited to 256 tones of one color or 256 different colors. 
Since 1 byte contains 8 bits and each bit has two choices, 1 byte equals 
28 choices or 256 possibilities.

Absolute colorimetric A rendering intent method similar to “Relative colorimetric” except 
that it does not make adjustments according to the white point. In 
this method, colors that do not fit within the output color space are 
rendered at the extremes of the output color space. Colors that fall 
inside the output color space are aligned very accurately.
This method is valuable for representing signature colors. Colors that 
are highly identified with a commercial product such as the cyan in 
the Creo logo.

Additive color model Color system in which the picture is composed of the combination of 
Red (R), Green (G), and Blue (B) light transmitted by the original 
subject. Effective for monitors and TV's, but not for print. Scanners 
normally first scan in RGB and convert into CMYK for printing. See 
also “RGB”, “CMYK”, “Process colors”, “Subtractive color model”.

Amplitude modulation Halftone screening, as opposed to FM screening, has dots of variable 
size with equal spacing between dot centers.

Glossary
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Anti-aliasing A step effect in which angled lines or curved edges of elements in an 
electronic image look broken or jagged, as a result of producing it in 
a grid format. Increasing resolution can reduce this affect or using a 
technique called anti-aliasing where the edges are softened.

APR Creo's Automatic Picture Replacement workflow. In this workflow, 
two versions of a file are created: a high-resolution file and a 
low-resolution file called PSImage. The latter is used for positioning 
and manipulation in your DTP software. The low-resolution file is 
replaced automatically by the high-resolution version during the RIP 
process. See also “PSImage”.

Binding The process by which pages of a book or other publication are 
attached to one another.

Bit Abbreviation of binary digits. The smallest unit of information used 
to store information in a computer. Bits are expressed as a binary 
notation, that is, in ones and zeros.

Bitmap graphics An image composed of individual pixels. The color value and position 
of each pixel are individually described in bits and bytes of computer 
memory. It is called a bitmap because it is effectively a map of bits. See 
also “Raster file”.

Bleed An extra amount of printed image, which extends beyond the trim 
edge of the sheet or page.

Booklet VI jobs are composed of booklets, which are personalized copies of a 
document. A booklet can consist of several pages, but the entire 
document is targeted at a specific item or address. VI jobs include 
elements that may differ from booklet to booklet, including text, 
graphics, pictures and page backgrounds. 

Byte A grouping of 8 bits of stored information, giving 256 levels of data. 
Each byte represents a value or character, such as a letter or a number. 
In a color system, a byte can describe one out of 256 distinct shades. 

CIE Abbreviation for Commission Internationale d'Eclairage. This body 
was created for the study of illumination problems. CIE color 
coordinates specify proportions of the three additive colors required 
to produce any hue and are used for comparative color measurement.

CMYK The process colors—cyan, magenta, yellow, and black. See also 
“Color separations”, “Process colors”, and “Subtractive color model”.
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Color gamut The range of colors possible with any color system. 

Color separations Separate films are prepared for each of the process printing inks—
cyan, magenta, yellow, and black. These films are used to prepare the 
printing plates for printing on press. See also “CMYK”.

CSA (Color Space Array) Color space array is the spectrum of specific variants of a color model 
with a specific gamut or color range. For example, within the color 
model RGB, there are numerous color spaces, such as Apple RGB, 
sRGB, and Adobe RGB. While each of these define color by the same 
three axes (R, G, and B), they differ in gamut and other specifications. 
CSA is comprised of a three-dimensional geometric representation of 
colors that can be seen or generated using a certain color model and 
are quantitatively measured. Source CSA is to be used only under the 
assumption that the upstream color workflow was managed and 
monitored. Otherwise it should be replaced with a Creo profile, which 
is the default.

CSA profiles There are three CSA profiles with gammas of 1.8, 2.1, and 2.4. The 
higher the gamma, the darker the RGB appears. This workflow should 
be used when you have images from different sources, such as digital 
cameras, Internet, and scanners and you want the images to have the 
common RGB color spaces. 
Other possible CSA profiles are sRGB and Adobe RGB.

Composite mode In composite mode, the data required to separate a page into its 
CMYK components is all contained within one single (composite) 
file. Brisque or PS/M separates the file into CMYK as part of the 
conversion process. This processing mode is the fastest and most 
efficient in the majority of cases.

Creep The effect of middle pages of a folded signature extending slightly 
beyond outside pages, compensated by shingling. See also 
“Shingling”.

Crop To eliminate portions of an illustration or photography so the 
remainder is clearer, more interesting or able to fit the layout.

CT Abbreviation for continuous tone. Color or black and white 
photographic images with tones that change gradually from dark to 
light (unlike the abrupt changes in linework). 
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DCS Abbreviation for Desktop Color Separation, an EPS format 
containing 5 files. Four of the files contain the color information for 
each of the CMYK colors and the fifth is a low-resolution composite 
file used in electronic page layouts. See also “OPI”.

Degradé A gradual blend or transition between colors—also known as a 
vignette or graduated blend (“Vector drawing”).

Digital front end system In electronic publishing, the workstation or group of workstations 
containing all the software for preparing pages of type and graphics. 
In prepress, the workstation that provides access to the user for 
hardware operation. For example, proofer, platesetter, imagesetter.

Digital proof A black and white or color image reproduction made from digital 
information without producing intermediate films. It can be output 
as a digital hard proof using a peripheral output device or displayed as 
a digital soft proof on a video monitor.

Dot  The individual element of a halftone.

Dot area The percentage of an area covered by halftone dots ranging from no 
dots at 0% to a solid ink density at 100%. The size of a single dot is 
stated in a percentage of the area it occupies.

DTP Abbreviation for Desktop Publishing. The process of page production 
using personal computers, off-the-shelf software, and an output 
device such as a printer or imagesetter. Usually, these components 
form a system that is driven by a device-independent page description 
language such as PostScript.

EPS Abbreviation for Encapsulated PostScript, also known as EPSF. EPS is 
a graphic file format used to transfer PostScript graphic files from one 
software to another. It includes both a low-resolution preview and the 
high-resolution PostScript image description. On the Macintosh, the 
preview is in PICT format, on the PC it is in TIFF format.

Finishing stage The stage following the press process, which may include procedures 
such as laminating, perforating and varnishing.

Font A complete assortment of letters, numbers, punctuation marks, 
characters, and so on, of a given design and size.
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Frame A color overlap created intentionally at a color border to minimize the 
effects of misregistration, also known as trap or grip. See also 
“Trapping”.

Frequency modulated screens A method of creating halftones where the spots are all the same size, 
but the frequency or number of dot changes in a given area. There are 
more dots in a dark area and fewer in a light area.

Frozen job A job for which the appropriate paper stock is not available—for 
example, the correct paper type, paper size, or paper weight.

GCR Abbreviation for Gray Component Replacement. GCR is a method 
for reducing the CMY amounts that produce the gray component in 
a color, without changing the color hue. 

Graduated blend See “Degradé”.

Gravure printing A printing method in which the image is engraved through a screen 
below the surface of a cylinder. The toner is transferred to paper when 
pressed to the cylinder. Gravure is used for very long print runs and 
on many substrates.

Gray component The amounts of CMY in a color, which result in neutral gray, based on 
the lowest separation value of the color. See also “GCR”.

Grayscale A scale of gray tones from white to black. Digitally, grayscale images 
have up to 256 different levels of gray. See also “8-bit/1-byte image”.

Halftone A negative or positive image where detail of the image is reproduced 
with dots varying in area, but of uniform density. It creates the 
illusion of continuous tone when viewed with the naked eye.

Highlights The whitest portions of the original or reproduction that have no 
color cast. The highlight dot is ranged in the reproduction from the 
smallest printable dot to approximately 25%. See also “Midtones” and 
“Shadows”.

HSL Abbreviation of Hue, Saturation, and Lightness. This is a color model, 
which specifies a color by its wavelength (hue), chroma or purity of 
the color (saturation) and value of its brightness (lightness).

Image area The portion of a negative or plate corresponding to inking on paper. 
The portion of paper on which ink appears.
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Imposition The arranging of pages in a press form to ensure the correct order 
after the printed sheet is folded, bound, and trimmed.

Ink jet proof A digital image proof printed by using jets that squirt minuscule 
drops of ink. Inkjet proofers can print onto a variety of surfaces.

Job flow Job flow refers to the job parameter settings of selected virtual 
printers that are automatically applied to all jobs printed using that 
virtual printer. These settings determine how a sent or imported file 
is processed. For example, a file sent to a virtual printer with a Process 
& Print job flow will be RIPed, printed, and stored in the Storage 
window. A file sent to a Process & Store job flow virtual printer will be 
RIPed and stored, without printing.

LEF A printer page orientation, where pages are delivered long edge first.

Laserwriter driver A part of the Macintosh system software that generates PostScript 
instructions from a software file when the Print command is 
activated.

Look-up table (LUT) A two or three-dimensional array of values stored for specified 
input-output relationships. When one input value is known, the 
system can automatically determine the correct output value. For 
example, the system can find the needed dot size for a given set of 
printing conditions based on the stored gray level; color setups can be 
saved in color tables (color transformation tables) which are one of 
the many kinds of LUTs.

Linework Linework graphics are characterized by sharply defined lines and very 
clear transitions from one color to another. Linework is stored in the 
computer as a series of geometric (vector) drawing instructions.

Metamerism Metamerism occurs when two colors match under one light source, 
but appear different under another light source. These two colors are 
called a metameric match. A metameric match might cause problems 
when trying to match proofs to presssheets under different lighting 
conditions.

Midtones Density values of an image (original or reproduction) between the 
highlights and the shadows. In the reproduction, midtones are 
printed with dot areas between approximately 40% or 60%. See also 
“Highlights” and “Shadows”.
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Misregistration A situation common during printing where one or more of the color 
separations is slightly misaligned with regard to the others on the 
press. Misregistration shows up as white gaps or tinted overlaps at the 
borders of color pairs. Colors containing such files are trapped to 
compensate for this possibility. On continous tone (CT) images, 
misregistration can lead to blurring. See also “Overprint” and 
“Trapping”.

Moiré An interference pattern caused by differences in halftone screen 
angles or rulings. In process color printing, screen angles are selected 
to minimize this pattern. If the angles are not correct, a pattern that 
distracts the eye from the picture may be produced.

OPI Abbreviation of Open Prepress Interface. OPI is a prepress 
convention established by Aldus Corps. It refers to tags or place 
holders in PostScript source files that point to TIFF or EPS images that 
have not been embedded in the file. These images reside in other 
locations and are merged with the PostScript file when processed. 
Normally used for performing high-resolution/low-resolution image 
substitutions (alternative to Creo APR).

Output resolution The number of laser dots per unit of linear measurement (millimeter, 
inch, and so on) on film or paper. 

Overprint A technique that overlaps colored elements to eliminate the 
appearance of gaps between elements caused by misregistration of the 
various separations during printing. For example, black text is 
normally set to overprint. See also “Trapping” and “Misregistration”.

PDL Printer Description Language files (for example, PostScript, PDF, EPS, 
VPS, VIPP). The Spire CXP50 color server processes image files in 
PDL formats, converting them into a suitable Ready-To-Print format 
for direct, high-quality printing.

Perceptual (Photographic) Default for RGB—a rendering intent method that preserves the visual 
relationship among the colors as they are perceived by the human eye. 
In other words, all colors are proportionally scaled to fit the output 
gamut. All or most colors in the original are changed but the 
relationship between them does not change.
This method is recommended when working with realistic images, 
such as photographs, including scans and images from stock 
photography CDs. 
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PICT A Macintosh file format for bitmaps and vector graphics.

Pixels The contraction of Picture Element; the smallest element of a digital 
image.

PostScript A programming and page description language that has become an 
industry standard for electronic publishing. It is used to describe the 
entire page, including both text graphics and images. The PostScript 
format, developed by Adobe Systems, Inc.™, is completely 
independent of the printing device.

Prepress Generic term used to describe the processes involved in preparing 
images for printing, includes the input, edit, and output stages.

Printer description files PPDs (PostScript Printer Definition) and PDFs (Printer Definition 
Files). These files are used by Macintosh software to prepare page and 
documents for specific output devices.

Process colors The four ink colors used to reproduce full color images—cyan, 
magenta, yellow, and black.

PSImage A low-resolution EPS file used in the Creo APR workflow. This file is 
used for positioning in page layouts. Changes made to this file are 
applied to the high-resolution file, which automatically replaces it 
shortly before exposure. See also “APR”.

Quartertone The tone area of an image influencing highlight detail and with 
density values between the white point and midtone; typically, 
printed with a dot area near 25%. See also “Highlights”, “Midtones”, 
“Shadows”.

Raster file A data file that was scanned, processed or output sequentially, bit by 
bit and line by line. Also known as a bitmap.

Rasterization The translation of vector information into bitmap information. 
Bitmaps may also require a new rasterization to comply with the 
screening parameters (dot shape, dot size) of the imagesetter that 
exposes them on film. See also “RIP” and “RIPing”.

Register Fitting of two or more printing images or plates in exact alignment 
with each other.

Register marks Crosses or other targets applied to the original copy prior to printing. 
Used for positioning films in register or for registering two or more 
colors in process printing.
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Relative colorimetric A rendering intent method in which colors that fall within the output 
color space remain the same. Only colors that fall outside are changed 
to the closest possible color within the output color space. 
When using this method, some closely related colors in the input 
color space can be mapped to a single color in the output color space. 
This reduces the number of colors in the image.

Resolution The number of pixels, points or dots per unit of linear measurement. 
For example, pixels per millimeter on a video display, number of dots 
per inch or millimeter on film or paper.
The resolution of an image is usually set the same vertically and 
horizontally. For example, a square millimeter with a resolution of 12 
contains 144 pixels. The higher the resolution, the more image detail 
is recorded and the larger the digital file size.

Rendering Intent All printers, monitors, and scanners have a gamut or range of colors 
that they can output (or view in the case of a scanner). If a color needs 
to be output and is outside the gamut of the output device, it must be 
mapped or approximated to some other color, that exists within the 
gamut. Rendering intent enables you to compress out-of-gamut 
colors into the color capability of the press you are using. You can set 
any rendering intent value for RGB elements by selecting the desired 
rendering intent from the Rendering intent options list. The default 
value for RGB is Perceptual (photographic). The default value for 
CMYK is Relative Colorimetric. 
There are several methods that can be used when translating colors 
from one color space to another. These methods are called rendering 
intents because they are optimized for various uses. When working 
with ICC profiles, it is important that you select the Rendering Intent 
that best preserves the important aspects of the image. Each rendering 
method specifies a CRD for color conversions. You can modify the 
rendering method to control the appearance of images, such as prints 
from office software or RGB photographs from Photoshop.

Resolution The number of pixels, points, or dots per unit of linear measurement. 
For example, pixels per millimeter on a video display, number of dots 
per inch or millimeter on film or paper.
The resolution of an image is usually set the same vertically and 
horizontally. For example, a square millimeter with a resolution of 12 
contains 144 pixels. The higher the resolution, the more image detail 
is recorded and the larger the digital file size.
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RGB Abbreviation for the additive primaries red, green, and blue. They are 
used in video monitors, scanning, and other uses where the light is 
direct and not reflected. The component colors are the three 
predominant colors in the visible light spectrum detected by the 
human eye; combining these 3 colors together creates white light.

RIP Abbreviation for Raster Image Processor. RIP is software or a 
hardware device that converts vector information into pixel 
information to be imaged on an output file. The output file is imaged 
based on commands from the page description language.

RIPing The process of rastering or converting bitmaps and vector graphics 
into raster images suitable to the screening parameters of the output 
device. Files are RIPed prior to exposure or plotting.

Saturated color A color where the high and medium values approach 100%. In a 
saturated clean color, the values of the wanted colors are near 100% 
and the value of the unwanted color is near 0%. For example, when 
the color is red, 5% cyan, 90% magenta, and 80% yellow is more 
saturated than 30% cyan, 90% magenta, and 80% yellow.

Saturated (presentation) A rendering intent method that scales all colors to the strongest 
saturation possible. The relative saturation is maintained from one 
color space to another.
This rendering style option is optimal for artwork and graphs in 
presentations. In many cases, this style option can be used for mixed 
pages that contain both presentation graphics and photographs.

Saturation The strength of a color.

Screen angle The angle of rows of halftone dots represented in degrees. During 
output of films for reproduction, the dot arrangement of each 
separation film is placed at a distinct and different angle to the other 
separations. See also “Moiré”.

Screen rulings The number of rows of printing dots per inch on a halftone film. A 
150 lpi-screen ruling provides much better quality than 65 lpi.

SEF A printer page orientation, where pages are delivered short end first.

Shadows The darkest part of an image (original and reproduction) having 
densities near to maximum density. In the reproduction, shadows are 
printed with dot areas between 80% and 100%. See also “Highlights” 
and “Midtones”.
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Shingling A procedure that moves the image area of a page toward the direction 
specified, usually towards the binding, in order to compensate for 
creep.

Signature A sheet of printed pages that when folded becomes part of the 
publication.

Solid The point in a picture that is printed with a dot area of 100%. See also 
“Highlights”, “Midtones” and “Shadows”.

Spot color An additional separation (fifth, or more) that is used with special inks 
to achieve difficult color combinations, such as gold, or chocolate 
brown. Spot color is sometimes used by graphic artists to define 
special corporate colors—for example, company logos. On the Spire 
CXP50 color server, spot colors are translated into CMYK values 
using a dictionary that can be edited to adjust CMYK values.

Step and repeat The process of copying the same image by stepping it in position both 
horizontally and vertically according to a predetermined layout.

Stochastic screening A method of creating frequency-modulated halftones that depends 
on the number of laser dots in a given area rather than the size of the 
laser dots in a given area. The dots are randomly placed and very 
small. Areas with a higher dot percent have more spots exposed in 
that area and those with a low dot percent have fewer spots. Stochastic 
screening is used to eliminate moiré and improve picture detail and 
sharpness in high-end color printing.

Subtractive color model A color process in which the red, green, and blue components of the 
original subject are reproduced as three super-imposed images in the 
complementary (subtractive) colors of cyan, magenta, and yellow 
respectively. See also “CMYK”, “Process colors”, “Additive color 
model”.

Three quartertone Tone area of an image influencing the shadow detail and with density 
values between the midtone and the dark point; typically printed with 
a dot area near 75%.

Tone compression The reduction of the density range of an original to the density range 
achievable in the reproduction.

Tone reproduction curve A graph showing the density of each point of the original and its 
corresponding density on the reproduction.
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Trapping Creating an overlap (spread) or an underlap (choke) between colors 
that adjoin each other to hide misregistration during printing. 
Trapping is sometimes referred to as spreads and chokes, or fatties 
and skinnies.

UCR Abbreviation of Undercolor Removal. This is a method for reducing 
the CMY content in neutral gray shadow areas of a reproduction and 
replacing them with black. As a result, the reproduction appears 
normal, but less process color inks are used. See also “GCR”.

Unsaturated color A color whose highest value is less than approximately 80%. In an 
unsaturated, dirty color, the difference in the values of the wanted 
colors and the unwanted color is relatively low. 
For example, when the color is red, 30% cyan, 80% magenta, and70% 
yellow is more unsaturated than 0% cyan, 90% magenta, and 80% 
yellow.

Variable information (VI) Variable information (VI) jobs are jobs in which the printed materials 
are individualized for specific recipients or purposes. These materials 
can include bills, targeted advertising, and direct mailings.

Vector drawing The geometric system used to define lines and curves in many 
computer graphics most often used for line drawings.

Vignette See “Degradé”.

Virtual printer For Macintosh and Windows networks, the Spire CXP50 color server 
provides three default network printers, known as virtual printers. 
Virtual printers contain preset workflows that are automatically 
applied to all print jobs processed with that virtual printer. 

White point The whitest neutral area of an original or reproduction that contains 
detail and is reproduced with the smallest printable dot (typically 3% 
to 5%).
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Aborted status,  18
Absolute colorimetric,  257
Accounting Log

printing and exporting,  209
setup,  197

Accounting Viewer
setting,  209
viewing log,  206

Adding
crop marks,  236
fold marks,  236
interleaves,  220
new virtual printer,  53

Admin Page,  245
Administration Items,  170
Administrator user,  181
Adobe

Acrobat,  64
Photoshop,  87

Alert Messages,  196
Alerts tab,  75
AppleTalk Setup,  177
APR. See Automatic Picture 

Replacement
Archiving

a job,  40
VI elements,  166

Auto Adjusted Calibration,  120
Automatic

deletion,  239
Automatic Picture Replacement

about,  85
file formats,  87
preparing to print,  87
printing with,  88
setting APR options,  239

Automatic Screening,  194

B
Back Cover,  247
Backing up

calibration tables,  133
Black overprint,  224

Bleed,  235
Book-finishing technique,  232
Booklets tab,  46
Brightness,  150,  230

slider,  153
Bypass held jobs,  193

C
Cached VI Elements,  164
Calibration,  114,  229

auto adjusted calibration,  120
backing up tables,  133
creating a table,  124
editing tables,  129
frequency,  118
full calibration,  119
graph,  130
guidelines,  114
method,  121
methods,  120
organizing tables,  131
quick calibration,  119
saving tables,  132
select table,  229
separations,  130
target calibration,  120
value tables,  131
when to calibrate,  114
window,  122
wizard,  124
X-Rite DTP34 QuickCal 

densitometer,  118
Client workstations

Macintosh,  65
Windows,  62

CMYK
editing values,  142
workflow,  226

Coating,  220
Collation,  217
Color

adjustments,  230
conversion tables,  194
flow,  136
formats,  136

last-minute corrections,  136
mapping,  140
settings,  193
tab,  136
tools,  137

Color density data,  133
Color mode,  225
Color Server, turning on,  8
Color Space Array. See CSA (Color 

Space Array)
Colorimetric

Absolute,  257
Relative,  265

Completed status,  18
Configuration

backup,  185
restore,  186
view,  199

Consumables tab,  12
Contrast,  153,  231

center,  154
slider,  153

Creating
spot colors,  143

Creep,  236
Creo Synapse InSite

export,  111
Crop marks,  236
CSA (Color Space Array),  259
CT (Continuous Tone),  142,  194,  228
Curling effect,  229
Custom Paper Function,  191
Cut & Stack,  232

D
Date changing,  173
Default Archive Path

setting,  190
Default Gradation Table,  148
Default Paper Size

setting,  190
Deleting

pages from a job,  50
spot colors,  144
VI elements,  165

Index
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virtual printers,  56
Delivery,  217
Density graph,  133
Destination ICC profile

importing,  139
Destination profile,  228
Device Link

managing profiles,  138
DFE Monitor,  12
Disk threshold,  184
Disk Usage tab,  12
Disk wipe,  182
Distilling a PS file,  89
Domain changing,  173
Dotted line,  235
Downloads,  75
DTP software,  236
Duplex

head to head,  216
head to toe,  216

Dynamic page exceptions,  94
tips and limitations,  96
viewing preflight report,  111

E
Editing

calibration tables,  129
CMYK values,  142
pantone colors,  142
separations,  150
virtual printers,  56

Emulate
CMYK,  226
source paper tint,  227

EPS,  4
Exceptions

dynamic page exceptions,  94
Exceptions tab,  93,  249

deleting exceptions,  250
managing exceptions,  249
managing inserts,  250

Exporting
accounting log,  209
as InSite,  111
as PDF2Go,  92

F
Face Down,  217
Face Up,  217
FAF,  223
Failed status,  18
Fast Web View,  91
File formats,  4
Filtering

messages,  205
Finisher,  247

module,  247
offset,  248

Finisher tab,  12
Finishing tab,  245
Fit to paper,  218
Fold marks,  236
Font Report,  110
Fontdownloader,  96
Fonts,  96

downloading,  98
fontdownloader hot folder for 

Windows,  101
managing,  97
substituting,  239

Front Cover,  246
Frozen job,  13,  221

G
Gallop,  218
GAP (Graphic art port),  4,  76
GAP (Graphic art port). See also 

Graphic Art Port files,  102
GCR (Gray Component 

Replacement),  229
General Defaults,  190
Gradation,  230

brightness,  153
contrast,  153
dialog box,  148
graph,  150
organizing tables,  154
separations,  150
table,  230
tool,  148

Graphic Art Port files,  101
importing,  102
structure,  102

supporting,  102
Gray RGB,  226
Grayscale,  225
Guest user,  181

H
Hardware components,  4
Held Jobs Policy,  193
Held status,  18
Help

online help,  25
Help menu,  25
High-resolution

Automatic Picture Replacement,  
85

deleting a path,  241
modifying a path,  241
Open Prepress Interface,  85
setting a path,  240
workflow,  84

Hot folders
file formats,  76
GAP formats,  77
Mac OS X,  78
using,  76
using from client workstations,  77
Windows,  77

HTH,  216
HTT,  216

I
ICC profiles

deleting,  141
Image

noise,  224
quality,  222

Image orientation for imposition,  234
Image Position,  217
Image Scale,  218
Importing

destination ICC profiles,  139
GAP files,  102
jobs,  28
source ICC profiles,  138
user-defined imposition 

templates,  82
Imposed sheets,  48
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view,  48
Imposition

method,  232
settings,  48
tab,  82,  231
workflow,  82

Imposition templates,  82
deleting,  83
renaming,  83
user defined,  82

Initial creep out,  237
Ink saving,  229
Inline elements,  158
Inserts,  94
Interleave,  220
Internet Explorer,  73
IPX printing,  175

J
JDF Outputs,  198
Job

abort running,  34
accounting,  206
archiving,  40
batching,  32,  192
deleting,  38
deleting pages,  50
duplicating,  38
editing parameters,  36
flow,  241
frozen,  13
history,  202
information,  243
merging jobs,  50
move to storage,  35
moving pages,  49
Preview & Editor,  44
reprinting,  31
retrieving,  40
run immediately,  37
running job,  14
submitting,  38
ticket report,  42
Variable Information (VI),  156
waiting job,  14

Job Alert window,  10,  201
Job Deletion,  163,  238
Job Link,  243

Job Parameters window,  23,  214
Color tab,  24,  225
Exceptions tab,  24,  249
Finishing tab,  24,  245
Imposition tab,  24,  231
Paper Stock tab,  24,  219
Print Quality tab,  24,  221
Print Settings tab,  24,  214
Services tab,  24,  238

K
Key job components,  107

L
Landscape,  216,  234
Language settings,  188
Lead,  217
LEF,  219
Line Work. See LW
Links,  75
Localization,  187
LW (Line Work),  4,  142,  194,  228

M
Macintosh,  5

copying PPD file,  66
defining a printer on client 

workstations,  65
printing from,  71
using a hot folder,  78
using the fontdownloader,  98
working from client workstations,  

65
Margin,  235
Margins,  235
Marks & bleed,  235
Menu bar,  9
Merging jobs,  50
Message Viewer,  203
Message Viewer Log

setup,  197
Messages,  196

system disks threshold,  202
Misregistration,  223
Monitoring jobs,  74
Moving

pages within a job,  49

waiting jobs to storage,  35

N
Navigation buttons,  45
Network printer

setting for Mac OS X,  68
Network Setup,  174
Network tab,  12
Number of copies,  216

O
Online help,  25
Open Prepress Interface,  85

file formats,  87
preparing to print,  87
printing with,  88

Operator user,  181
OPI. See Open Prepress Interface
Optimize for Fast Web View,  91
Orientation,  234
Override PPD parameters,  55

P
Page exceptions

dynamic,  94
Exceptions tab,  249
inserts,  94
setting for imposed jobs,  94
workflows,  93,  250

Pantone colors,  142
Paper Set Name,  219
Paper sets

adding,  57
deleting,  59
modifying,  58
name list,  219

Paper Size,  219
Paper Stock tab,  12,  219
Paper tint,  227
Paper type,  220
Passwords,  181

changing,  182
PC,  5
PDF,  4

workflow,  89
PDF/PS optimization,  244
PDF2Go
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exporting,  91
PDL,  62
PDL files,  53
Perceptual (photographic),  263
Perfect bound,  233
Personal Print Markup Language 

(PPML),  4,  157,  160
Portrait,  234

jobs,  216
PostScript,  157
PPD file

copying for Mac OS X,  66
setting job parameters,  214,  252

PPML. See Personal Print Markup 
Language (PPML)

Preferences,  170
Preflight Check,  105
Preflight Report

about,  107
viewing,  107

Pre-RIP
Preview,  189

Preserve Pure Colors,  227
Preview

buttons,  45,  152
job,  45

Print
grays using only black toner,  226
quality tab,  88

Print Method,  216
Print Order,  217
Print Quality tab,  221
Print Queue,  13,  31

status indicators,  15
Print Queue Manager,  192
Print range,  216
Print Settings tab,  214
Printer

defining on Macintosh client 
workstations,  65

defining on Windows client 
workstations,  62

Printer Driver,  64
Printer icon,  11
Printer Monitor,  12
Printer tab,  75
Printer’s default,  65,  252
Printing

accounting log,  209

book-style hard copies,  216
jobs,  31
using a hot folder (Mac OS X),  78
using a hot folder (Windows),  77

Process Queue,  13,  31
status indicators,  15

Processing,  31
ProcessPrint,  53,  241
ProcessStore,  53,  241
Product overview,  2
Profile Manager,  137
Protect CMYK,  147,  228
Protect Gray,  146,  228
Protect RGB,  144,  228
PS (PostScript)

distilling files,  89
files,  161
Image Exporter,  87
overprint,  224

PS Preview,  190

Q
QuarkXPress,  143
Queues

changing order,  33
managing,  13
resuming,  34
suspending,  34
window,  13

Queues tab,  75
Queues window,  10

R
Rasterized Brisque jobs,  103
Realistic images,  263
Rear,  217
Red corners,  235
Relative colorimetric,  265
Remote Admin,  178
Remote Admin Client,  179
Remote connection,  178
Remote Tools Setup,  178
Rendering intent,  265

absolute colorimetric,  257
for CMYK,  227
for RGB,  226
perceptual (photographic),  263

relative colorimetric,  265
saturated (presentation),  266

Reordering columns,  205
Repeated elements,  244
Resource Center,  22
Restoring configuration,  186
Resume button,  33
Retrieving

a job,  40
VI elements,  166

Re-usable elements,  158
Reverse print order,  217
RGB

workflow,  226
RIP,  2
Rotate 180,  218
RTP,  2

editing RTP jobs,  49
jobs,  148

Rush job,  37
Russian localization,  188

S
Saddle stitch,  232
Saturated (presentation),  266
Screening method,  194,  228
Security,  181
SEF,  219
Separation,  150

calibration,  130
viewing,  131

Server icon,  11
Server Name

changing,  171
Server Setup,  171
Settings

Administration,  170
Color,  193
Configuration Backup,  184
Date and Time,  173
General Defaults,  190
JDF Outputs,  198
Localization,  187
Messages,  196
Network Setup,  174
Preferences,  170
Pre-RIP Preview,  189
Print Queue Manager,  192
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Remote Tools Setup,  178
Security,  181
Server Name,  171
Server Setup,  171
System Disks,  183

Settings window,  21,  170
Administration,  170

Signature colors,  257
Simplex,  216
Sizes,  233
Slip Sheet,  246
Software components,  4
Source ICC profiles

importing,  138
Spire Job info,  243
Spire Web Center,  73,  180

connecting from a client,  73
Downloads,  75
Links,  75
Web Viewer,  74

Split to booklets,  244
SpoolStore,  53,  241
Spot color

create new,  143
deleting,  144

Spot Color Editor,  142
Spot Colors Report,  109
Spot workflow,  227
Staple options,  248
Status

of imported jobs,  30
Status indicators

Queues window,  15
Status information,  17
Status panel,  9
Step & Repeat,  232
Storage management,  200
Storage tab,  75
Storage window,  10,  18,  35,  38

status indicators,  18
Submitting

an RTP job,  31
jobs,  38

Suspend button,  33
Synapse,  111
System Disks,  183

T
Target Calibration,  120
TCP/IP Setup,  176
Template,  234
Text/Line quality,  221
Thumbnail window,  10
Thumbnails tab,  47
Time changing,  173
Tips,  96
Toner tab,  12
Toolbar,  9
Total creep in,  237
Transparency,  220
Trapping,  223
Tray,  221
Trim size,  233

conflicting settings,  235
Turning off

Spire Color Server,  26
Turning on

Spire Color Server,  8
Type,  220

U
UNIX,  5
Use Spire spot color dictionary,  228
User defined imposition templates

deleting,  83
importing,  82
renaming,  83

User Passwords,  181
Using

overprint information,  224
Utilities folder,  75

V
Variable data Intelligent Postscript 

Printware (VIPP),  4,  157,  159
Variable Information (VI)

archiving VI elements,  166
booklets,  158
deleting VI elements,  165
document formats,  157
gallop,  162
imposing VI jobs,  163
inline elements,  158
jobs,  156

managing VI elements,  164
printing VI jobs,  161
retrieting VI elements,  166
sub-job,  158
workflow,  156

Variable Print Specification (VPS),  4,  
157

VI Job Preview,  190
View

Queues,  11
refresh,  11
Spire classic,  10
Spire classic plus,  11

View Configuration,  199
Viewing

the imposed job,  48
VIPP jobs

printing,  160
VIPP. See  Variable data Intelligent 

Postscript Printware (VIPP)
Virtual printer,  53

adding,  53
editing,  56
existing,  56
ProcessPrint,  53
ProcessStore,  53
SpoolStore,  53

Virtual Printers tab,  12
VPS. See Variable Print Specification 

(VPS)

W
Web Connect,  180
Web Connect Setup,  180
Web connections

enabling,  180
Web Viewer,  74,  180

Alerts tab,  75
API,  75
Printer tab,  75
Queues tab,  75
Storage tab,  75

Weight,  220
Windows

copying the PPD file,  64
defining a printer on a client 

workstation,  62
printing from,  64
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printing using a hot folder,  77
working from client workstations,  

62
Windows XP

defining a printer,  63
Workflow,  5
Workgroup

changing,  173
Workspace

alerts,  10
cutomizing,  10
menu bar,  9
opening,  23
overview,  9
queues,  10
status panel,  9
storage,  10
thumbnail,  10
toolbar,  9

X
X-Rite DTP34 QuickCal densitometer

calibrating,  118
configuring,  117
connecting,  117
full calibration,  119
quick calibration,  119

Y
Yellow corners,  235
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